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IMPORTANT: PLEASE READ THIS SOFTWARE 
LICENSE AGREEMENTBEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE, YOU ARE TO 
BE BOUND BY THE TERMS AND CONDITIONS 
STATED. IF YOU DO NOT AGREE WITH THE TERMS OF 
THIS LICENSE,RETURN THE UNUSED SOFTWARE TO 
THE POINT OF PURCHASEYOUR MONEY WILL BE 
REFUNDED.

1. License. (a)If your license is for Eudora Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Planner Software 
a nonexclusive, nontransferable license to use the Eudora 
software and other software and fonts contained in this 
package (collectively the “Software”) and its 
documentation for use in accordance with this License. 
QUALCOMM or QUALCOMM's Licensors retain title to the 
Software and related documentation although the 
Licensee owns the media on which the Software and 
documentation are recorded, if any. 

This License allows use of the Software and 
documentation only by the number of Users and on the 
platform specified on the UPC label on the diskette(s) or, 
for electronic transactions, the number of Users licensed. 
“User(s)” means Licensee, if Licensee is an individual 
purchasing the Software for use at office or home, or, if 
Licensee is a corporation or similar business or 
commercial entity or government agency, its current 
employees. For qualifying educational institutions, “Users” 
also means faculty and staff teaching for or employed by 
Licensee and registered students enrolled at a single 
campus operated by Licensee. Subject to the limitations of 
this License, each authorized User may only use the 
Software on (i) any central processing unit (“CPU”), 
workstation or portable which is owned or controlled by 
Licensee, and (ii) any User-owned CPU, workstation or 
portable. 

(b)If your license is for Eudora Group Planner. 
QUALCOMM Incorporated (“QUALCOMM”) grants to the 
Licensee purchasing this copy of Eudora Group Planner a 
nonexclusive, nontransferable license to use one copy of 
the Eudora Group Planner software and other software 
contained in this package (collectively the “Software”) and 
its documentation in accordance with this License. 
QUALCOMM or QUALCOMM’s Licensors retain title to the 
Software and related documentation and all copies thereof 
although the Licensee owns the media on which the 
Software and documentation are recorded, if any. This 
License allows use of the Software and documentation for 
up to the number of accounts licensed for Licensee's 
internal business purposes. Licensee may only use the 
Software on one computer system at a time which shall be 
owned or controlled by Licensee.     

For Trial Version Customers of either Eudora Planner or 
Eudora Group Planner. This License allows use of the 
Software for a period of up thirty (30) days after initial 
download for demonstration and evaluation purposes only 
on the platform licensed for Licensee’s internal business 
purposes. Licensee may only use the Software on one 
central processing unit at a time which shall be owned or 
controlled by Licensee. This Software is not for resale. 

2. Restrictions. This License sets forth the terms and 
conditions governing the use of the Software and 
documentation. Licensee may not rent, lease or otherwise 
transfer the Software or its documentation. Licensee may 
make a limited number of copies of the Software based on 
the number of licensed Users and a reasonable number of 
back-up copies. The Software contains copyrighted 



iii
material, trade secrets and other proprietary material. 
Licensee must reproduce on all such copies of the 
Software the copyright notices and any other proprietary 
legends that were on the original copy of the Software. 
Licensee shall not, without the prior written permission of 
QUALCOMM, nor permit anyone else to, decompile, 
reverse engineer, disassemble or otherwise reduce the 
Software to a human perceivable form, or to modify, 
network, rent, lease, loan, distribute, or create derivative 
works based upon the Software or the documentation in 
whole or in part. Notwithstanding, 

if the Software is lawfully acquired outside of the United 
States within a jurisdiction which is a member of European 
Economic Community (EEC) subject to the EEC Council 
Directive of May 14, 1991, Licensee agrees that within that 
jurisdiction it shall not, and shall not allow any party on 
Licensee’s behalf, to attempt to reverse engineer or 
decompile the Software into another computer language, 
except as expressly and specifically provided in the EEC 
Council Directive of May 14, 1991. Any and all information 
obtained during such lawful reverse engineering and/or 
decompiling activities, including but not limited to, the 
organization, logic, algorithms and processes of the 
Software, shall be deemed to be the confidential and 
proprietary information of QUALCOMM or its Licensors. 
Licensee shall not make copies of the copyrighted 
Software documentation without the prior written 
permission of QUALCOMM provided that for electronic 
transactions, Licensee may make one (1) hard copy of 
such documentation for each User.

3. Technical Support. Licensee must register in order to be 
eligible for technical support via telephone or electronic 
mail. For a period of ninety(90) days, commencing with the 
date of Licensee’s first telephone call requesting support, 
Licensee will have access to technical support for the 
Software for the technical contact designated on the 
product registration card included with this package or 
specified via electronic mail registration, subject to 
Licensee’s compliance with QUALCOMM’s instructions for 
accessing such support and standard verification 
procedures.   Upon the expiration of the above-described 
ninety (90) day period, Licensee may extend technical 
support on a per-incident or annual fee basis in 
accordance with QUALCOMM’s then current pricing and 
terms. Upgrades to the Software and its documentation, if 
any, are not included and may be sold separately.

4. Termination. This License is effective until terminated. 
Licensee may terminate this License at any time by 
destroying all copies of the Software and its 
documentation. This License will terminate immediately 
without notice from QUALCOMM if Licensee fails to 
comply with any provision of this License. Upon 
termination, Licensee must destroy all copies of the 
Software and its documentation.

5. Export Law Assurances. Licensee agrees and certifies 
that neither the Software nor any other technical data 
received from QUALCOMM, nor the direct product thereof, 
will be exported outside the United States except as 
authorized and as permitted by the laws and regulations of 
the United States. If the Software has been rightfully 
obtained by Licensee outside of the United States, 
Licensee agrees that Licensee will not re-export the 
Software nor any other technical data received from 
QUALCOMM, nor the direct product thereof, except as 
permitted by the laws and regulations of the United States 
and the laws and regulations of the jurisdiction in which 
Licensee obtained the Software. The Software may not be 
exported to any of the following countries: Cuba, Iran, Iraq, 
Libya, North Korea, Sudan or Syria.

6. Government End Users. If Licensee is acquiring the 
Software on behalf of any unit or agency of the United 
States Government, the following provisions apply. The 
Government agrees: (i) if the Software is supplied to the 
Department of Defense (“DOD”), the Software is classified 
as “Commercial Computer Software” and the Government 
is acquiring only “restricted rights” in the Software and its 
documentation as that term is defined in Clause 252.227-
7013(c)(1) of the DFARS; and (ii) if the Software is 
supplied to any unit or agency of the United States 
Government other than DOD, the Government's rights in 
the Software and its documentation will be as defined in 
Clause 52.227-19(c)(2) of the FAR or, in the case of 
NASA, in Clause 18-52.227-86(d) of the NASA 
Supplement to the FAR or the successor clauses to any of 
these clauses.

7. Limited Warranty on Diskettes. (Not applicable to 
Software purchased electronically.) QUALCOMM warrants 
the diskettes on which the Software is recorded to be free 
from defects in materials and workmanship under normal 
use for a period of ninety (90) days from the date of 
purchase. QUALCOMM's entire liability and Licensee's 
exclusive remedy will be replacement of the diskettes not 
meeting QUALCOMM's limited warranty and which are 
returned to the place of purchase within such warranty 
period. QUALCOMM will have no responsibility to replace 
a diskette damaged by accident, abuse or misapplication. 
ANY IMPLIEDWARRANTIES ON THE DISKETTES 
INCLUDING THE IMPLIED WARRANTIES 
OFMERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE LIMITED INDURATION 
TO NINETY (90) DAYS FROM THE DATE OF 
PURCHASE.

8. Disclaimer of Warranty. Licensee expressly 
acknowledges and agrees that the use of the Software and 
its documentation is at Licensee's sole risk. The Software, 
documentation, and technical support are provided “AS 
IS” and without warranty of any kind. Information regarding 
any third party services included in this package, if any, is 
provided as a convenience only, without warranty by 
QUALCOMM, and will be governed solely by the terms 
agreed upon between Licensee and the third party 
providing such services.TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS,QUALCOMM 
AND QUALCOMM'S LICENSOR(S) (FOR THE 
PURPOSES OF PROVISIONS 8 AND 9, QUALCOMM 
AND QUALCOMM'S LICENSOR(S)SHALL BE 
COLLECTIVELY REFERRED TO AS QUALCOMM) 
EXPRESSLY DISCLAIM ALL WARRANTIES, EXPRESS 
OR IMPLIED, INCLUDING, BUTNOT LIMITED TO THE 
IMPLIED WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE, AND 
NONINFRINGEMENT. QUALCOMM DOES NOT 
WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
SOFTWARE WILL MEET LICENSEE'S 
REQUIREMENTS, OR THAT THEOPERATION OF THE 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-
FREE,OR THAT DEFECTS IN THE SOFTWARE WILL BE 
CORRECTED. FURTHERMORE, QUALCOMM DOES 
NOT WARRANT OR MAKE ANY REPRESENTATIONS 
REGARDING THE USE OR THE RESULTS OF THE USE 
OF THE SOFTWARE OR ITS DOCUMENTATION IN 
TERMS OF THEIRCORRECTNESS, ACCURACY, 
RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN 
INFORMATION OR ADVICE GIVEN BY QUALCOMM OR 
ITSAUTHORIZED REPRESENTATIVE SHALL CREATE A 



WARRANTY OR IN ANY 

WAY INCREASE THE SCOPE OF THIS WARRANTY. 
SOME JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OF IMPLIED WARRANTIES, SO 
THEABOVE EXCLUSION MAY NOT APPLY.

9. Limitation of Liability. TO THE MAXIMUM EXTENT 
PERMITTED UNDER APPLICABLE LAWS, UNDER NO 
CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL 
QUALCOMM, ITS AFFILIATES OR THEIR DIRECTORS, 
OFFICERS, EMPLOYEES OR AGENTS BE LIABLE FOR 
ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL 
DAMAGES (INCLUDING DAMAGES FOR LOSS OF 
BUSINESS PROFITS, BUSINESS INTERRUPTION, 
LOSS OF BUSINESS INFORMATION AND THE LIKE) 
ARISING OUT OF THE USE OR INABILITY TOUSE THE 
SOFTWARE OR ITS DOCUMENTATION, EVEN IF 
QUALCOMM OR ITS AUTHORIZED REPRESENTATIVE 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OR EXCLUSION OF LIABILITY FOR 
INCIDENTAL OR CONSEQUENTIAL DAMAGES SO THE 
ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.In 
no event shall QUALCOMM’s total liability to Licensee for 
all damages, losses, and causes of action (whether in 
contract, tort, including negligence, or otherwise) exceed 
the amount paid by Licensee for the Software and its 
documentation.

10. No Waiver or Assignment. No delay or failure to take 
action under this License will constitute a waiver unless 
expressly waived in writing, signed by a duly authorized 
representative of QUALCOMM, and no single waiver will 
constitute a continuing or subsequent waiver. This License 
may not be assigned, sublicensed or otherwise transferred 
by Licensee, by operation of law or otherwise, without 
QUALCOMM’s prior written consent, provided that 
Licensee may assign this License upon written notice to 
QUALCOMM in instances in which such assignment is to 
an entity which acquires all or substantially all of the 
business of Licensee, whether by merger, consolidation, 
or acquisition of assets.
11. Controlling Law and Severability. This License shall be 
governed by and construed in accordance with the laws of 
the United States and the State of California, as applied to 
agreements entered into and to be performed entirely 
within California between California residents. If for any 
reason a court of competent jurisdiction finds any 
provision of this License, or portion thereof, to be 
unenforceable, that provision of the License shall be 
enforced to the maximum extent permissible so as to 
effect the intent of the parties, and the remainder of this 
License shall continue in full force and effect.

12. Entire Agreement. This License constitutes the entire 
agreement between the parties with respect to the use of 
the Software and its documentation, and supersedes all 
prior or contemporaneous understandings or agreements, 
written or oral, regarding such subject matter. There shall 
be no contract for purchase or sale of the Software except 
upon the terms and conditions specified herein. Any 
additional or different terms or conditions proposed by 
Licensee or contained in any purchase order are hereby 
rejected and shall be of no force and effect unless 
expressly agreed to in writing by QUALCOMM. No 
amendment to or modification of this License will be 
binding unless in writing and signed by a duly authorized 
representative of QUALCOMM.
iv
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Introduction

What Is Eudora Planner?
Eudora Planner is a schedule and contact management tool for Macintosh that 
provides flexible portability and simple data sharing in a package that is easy to 
learn and use. Based on the award-winning Now Up-to-Date and Contact, Eudora 
Planner is designed to offer a fully integrated calendar and address book, cross-
platform capability, and an open application architecture.

Flexible Portability
Eudora Planner's portability features were designed for today’s increasingly mobile 
manner of working, which includes paper and electronic organizers, laptops and 
digital phones. It balances the need for simple sharing in the office with the need for 
immediate access to contact and meeting information while away. 

Eudora Planner gives you many options for “going mobile:”

• Flexible printing with customizable templates for printing to popular paper-based 
organizers

• Automatic laptop synchronization that lets you disconnect from the network and 
take your Eudora Planner data with you, then automatically synchronizes your 
offline changes when you return

• TCP/IP Internet access for sharing calendars and address books and 
scheduling group events from the road or offices in other cities

High-Speed Access to Your Data—Anytime, Anywhere
Eudora Planner’s exclusive QuickAccess tools put calendar and address book data 
at your fingertips at all times—even when Eudora Planner’s not running. You can 
quickly look up a contact record while writing an e-mail, view today's agenda while 
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surfing the Internet, or receive reminders of upcoming meetings—all without 
launching Eudora Planner. 

Eudora Planner’s customizable tabs make it easy to filter and retrieve groups of 
contacts or events. You can also create a special look, or style, for each category of 
events and contacts you use, making it easier still to quickly get information from 
Eudora Planner.

Eudora Planner’s integration with the Internet lets you find a street map or ZIP+4 
code with a single click from any contact record. In your address book or calendar, 
automatic hyperlinks for e-mail addresses and Web sites provide the same one-click 
access to your Internet-enabled contacts and events.

Share Schedules and Contacts on the Network
If you’re part of a workgroup that uses Eudora Group Planner, you can selectively 
share calendars, contacts, and to-do lists with others over your TCP/IP network. 
Group scheduling makes it easy to schedule people, rooms and resources while 
avoiding the scheduling conflicts that can so often occur. With support for required 
or optional attendance, Eudora Group Planner automatically displays a list of 
available meeting times and indicates potential schedule conflicts. It also 
automatically notifies invitees of new meetings and indicates which users have 
accepted or declined.

You can connect to Eudora Group Planner using a TCP/IP connection. Whether 
you’re connecting from within the office or remotely, there is no difference in 
functionality.

Conventions Used in the Book
This book calls attention to certain kinds of information with the following symbols:

Used as a note to provide additional information or to ensure that you avoid 
problems.

Used as a tip to describe a noteworthy feature.

Used to indicate that you can find more details on a topic in online Help.

Used to indicate that you can control-click an item to see a contextual menu that 
contains commands you can use on the item.

Used to indicate complimentary features in QuickAccess.
xii Introduction
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Chapter 1

Getting Started
This chapter describes the key elements and concepts of Eudora Planner. It 
includes a general description of Eudora Planner’s features and components, a list 
of system requirements, and a procedure for installation.

Eudora Planner Features
The following sections describe Eudora Planner’s major features, concepts, and 
components.

The Calendar
Eudora Planner’s Calendar lets you record and track the items that make up your 
schedule. These items—called Events in Eudora Planner—can be meetings with 
groups or individuals, to-dos or calls you need to complete, special dates, or long-
term activities that span days or weeks, such as conventions or vacations. You can 
attach e-mail addresses, Web site URLs, and graphics to Events, as well as create 
links to Contacts in your Address Book. Eudora Planner’s Calendar view also 
contains a distinct to-do list in which you can easily view, modify, and organize your 
tasks and calls.

The Address Book
The Eudora Planner Address Book helps you manage information about the 
individuals and companies you interact with. The records in your Address Book are 
called Contacts in Eudora Planner. Contacts can hold personal information such as 
names, company names, home and business addresses, telephone numbers, and 
e-mail addresses. They can also contain notes, links to associated Web sites, and 
attached documents created in other applications. The Address Book is fully 
integrated with the Eudora Planner Calendar, so that Events related to particular 
Contact can be physically linked to that Contact.
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Categories
Eudora Planner lets you organize your Calendar and Address Book information 
through the use of categories. When you assign a category to an Event or Contact, 
you give it a label that shows its relationship to like Events and Contacts. For 
example, you might assign a Calendar category called Vacation to all company 
holidays and vacation days in your schedule. You could likewise assign an Address 
Book category called Personal to any Contacts for friends and acquaintances. In 
both cases, you could quickly identify 

Eudora Planner comes installed with a number of commonly used Calendar and 
Address Book categories, which you can use or delete according to your needs. You 
can also create categories specific to your own needs. If you then apply different 
text styles and colors to your categories, you can tell at a glance which category an 
Event or Contact belongs to.

You can assign one or more categories to individual Events and Contacts. For 
example, you could assign only one category called Family to the Contact for a 
relative, whereas you might assign two categories, Business and Personal, to the 
Contact for a business associate who is also a friend.

If you use Eudora Planner in a workgroup environment, you can use and create both 
private and public categories. Private categories reside only on your Macintosh and 
are not available to other users; public categories, however, reside on a workgroup 
server and can be shared with other Eudora Planner users connected to that server. 
Once you’ve connected to a workgroup server, you can assign the public categories 
on that server to your own Events and Contacts, thereby making those items 
available to other Eudora Planner users. For more details about using Eudora 
Planner in a workgroup environment, see Chapter 8, “Using Eudora Group Planner,” 
on page 133.

Tabs
Just as related Events and Contacts can be grouped by categories, so too can 
related categories be grouped together in tabs. A tab is a feature of the Eudora 
Planner window tabs provide a visual way to demonstrate the relationship between 
categories that contain the same kind of information. For example, you can create a 
Vacation tab that shows Events in your private Vacation category and also those in 
the public Holiday category on your company’s server. Then, when you select the 
Vacation tab, you see all vacation Events that apply to you.

A tab can contain multiple categories, but one of those categories must be 
designated the default for that tab. The default category is automatically assigned to 
any Event or Contact you create when viewing that tab. Each tab has its own default 
category.

You can also create unique visual styles for each of your tabs, so you can quickly 
recognize which tab you are viewing.
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QuickAccess
The QuickAccess tools give you access to your Eudora Planner data even when 
Eudora Planner isn’t running. The two QuickMenus, which reside in your 
Macintosh’s menu bar, let you see important Event and Contact data no matter what 
application you’re working in. The QuickDay mini-application lets you view your 
schedule and add new Events to your Calendar without having to open Eudora 
Planner. Similarly, QuickContact lets you search for names, phone numbers, and 
other information, and create new Contacts on the fly. For more information about 
QuickAccess, see Chapter 7, “QuickAccess,” on page 123.

Group Scheduling
The same features that make Eudora Planner an effective personal organizer also 
make it ideal for a workgroup environment. You can use Eudora Planner to share 
scheduling and Contact information with other Eudora Planner users on a network, 
as well as coordinate meetings and the use of rooms and equipment with those 
users. For more details on how to use Eudora Planner in a workgroup environment, 
see Chapter 8, “Using Eudora Group Planner,” on page 133.

Installing Eudora Planner
The following sections describe the resources and procedures required to install, 
register, run, and uninstall Eudora Planner.

System Requirements
• A Power Macintosh or equivalent
• Mac® OS System 7.6.1 or later
• Open Transport 1.0
• 25 MB of RAM
• Virtual Memory should be turned on
• For the dialing function, a Macintosh-compatible modem

Installation
To install Eudora Planner, double-click the Eudora Planner installer icon, then follow 
the directions provided by the installer.

Registering Eudora Planner
On the registration dialog box, enter your personal or company information in the 
appropriate fields. Once you’ve finished entering the required information, the Next 
button becomes available. When you click the Next button, the Survey dialog box 
appears, and presents you with the opportunity to provide optional information about 
yourself, your business, and your computing environment. Once the survey dialog 
box appears, you can send your registrations information to QUALCOMM in one of 
the following ways:
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• Click the Print button to print the registration information, so that you can then 
mail or fax it to QUALCOMM. The mailing address and fax number information 
you will need is listed on the printout. Your activation code will be sent to you in 
the same manner as you submitted your registration information: by mail or fax.

• Click the Register button to upload the registration information to QUALCOMM 
via TCP/IP to the Eudora Web site. If you upload your registration information in 
this way, the activation code will be sent to you in an e-mail message.

Starting Eudora Planner
To start Eudora Planner, open the Eudora Planner Folder, then double-click the 
Eudora Planner application file icon. Eudora Planner is launched and creates a 
document whose title contains the first name of your Macintosh’s owner (which is 
entered in the Sharing Setup control panel). This document is not an actual data file, 
but a viewer document that controls the window where you view and enter your 
Eudora Planner data. The actual data files are stored in a folder called Eudora 
Planner Data, which is created in the Eudora Planner Folder the first time you 
launch Eudora Planner.

The Eudora Planner Window
The first time you start Eudora Planner, it displays the Calendar view.

The Eudora Planner plugins, button bar and shortcuts bar are all components of the 

Button bar

Navigation 
buttons

Click these 
buttons to 
switch 
Calendar 
Views

Shortcuts 
bar

Drag this bar 
to access 
calendar 
thumbnails and 
To-Do List
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Eudora Planner application window. 

Eudora Planner’s button bar is located at the top of the Eudora Planner window and 
lets you perform the same operations as some of the most frequently-used menu 
commands. The button bar puts tasks like printing, finding, copying, pasting, and 
creating new Events and Contacts within easy reach.

Navigating in Eudora Planner
Both the Calendar and Address Book provide multiple views in which you can see 
and enter your Event and Contact information. Each view has a distinct layout and 
shows a different range of information and level of detail.

Calendar Views
Eudora Planner displays your Event information in seven different Calendar Views. 
Each view—Year, Day, Month, Week, Multi-Day, List, and Contiguous Day—shows a 
different range of dates and level of detail. The following sections describe the 
Calendar views and their features. 
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Year View
The Year View displays simple thumbnail calendars for each month of a selected 
year. Use the navigation buttons to move backward and forward through the 
Calendar a year at a time. To open a specific Month View, double-click the month 
heading for that month. You can likewise double-click a specific date to see its Day 
View.
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Month View 
The Month View shows Events scheduled for an entire month. To create an Event, 
click anywhere in a day’s cell to select that day, then select an Event type from the 
Insert menu. When you select a day cell, all the To-Dos and Calls scheduled for that 
day appear in the To-Do List. Within the day cell, you can scroll down through a 
day’s Events to see Meetings and Special Events scheduled for that day. Clicking 
the left and right arrows moves you backward and forward through the Calendar one 
month at a time.
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Week View
The Week View lists the Events scheduled for each day of a particular week. A day 
cell in the Week View shows holidays, special all-day Events, meetings, and calls for 
which you’ve set a specific time. Meetings and calls appear with their times next to 
them. Click the left and right arrows to move backward and forward one week at a 
time through the Calendar.
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Multi-Day View 
The Multi-Day View shows a daily timeline of Events scheduled for a seven-day 
period. The cells in the Multi-Day grid can represent time increments from five 
minutes to one-half hour, depending on your preferences. 

Meeting Events and Calls with a specific time appear on the grid, whereas holidays 
and special all-day Events like birthdays and anniversaries appear above the grid. 
Dated To-Dos and Calls appear in the boxes below the grid, underneath the date for 
which they are scheduled. Click the left and right arrows to move backward and 
forward one week at a time through the Calendar.
Getting Started 23



Day View
The Day View displays a timeline of Events scheduled for a specific day. Events 
appear on a grid divided into specific time increments—five minutes to a half-hour, 
depending on your preferences. 

Use the left and right navigation arrows to move backward and forward through the 
Calendar a day at a time. The light-shaded area indicates the range of time in which 
you’re available for meetings (such as your workday); the dark-shaded area 
indicates when you’re unavailable.
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List View
The List View displays your Events in a list format. You can determine the date 
range that appears in the list and sort the Events by name, start date, and start time. 
The List View also contains a feature that lets you group and sort items by field.
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To-Do List
The To-Do List appears to the right of the Calendar in all views and displays the 
status, priority, title, category, and completion date of your To-Dos and Calls, as well 
as the start and due dates, if applicable. Click a column header to sort the list by the 
information contained in that column. You can choose which To-Dos and Calls 
display in the To-Do List by control-clicking anywhere in the list, then selecting a 
filtering option from the pop-up menu that appears. Use the To-Do List to view and 
organize your Calls and To-Dos and to check them off as you complete them.
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Event Detail
Double-click an Event to open its Event Details dialog box, where you can set and 
change the Event’s properties.
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Address Book Views
Eudora Planner lets you see and manipulate your Contact information in two 
different Address Book views—the List View and Detail View. Both views are 
discussed in the following sections.

List View
This view shows multiple Contacts in an organized list that you can sort and 
compare according to your preferences. You can choose which fields display in the 
List View columns by clicking the field picker. To reposition a column in the List View, 
click its heading and drag it to the desired position. You can type directly into the List 
View by clicking the cell where you want to enter information.
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Detail View
The Detail View shows a single Contact with all associated information and 
attachments. 

The arrow buttons in the Detail View’s button bar let you scroll through your Contacts 
one-by-one in the order in which they’re currently sorted in the List View. The box 
next to the arrow buttons indicates the number of Contacts appearing in the list and 
the numerical position of the opened Contact in that list.

The General Information, Custom Fields, Notes, and History sections expand and 
collapse, so you can conceal from view those sections you’re not using.

Setting Eudora Planner’s General Preferences
The General preferences control Eudora Planner’s login behavior and determine 
which Web browser and e-mail application Eudora Planner uses for its internet-
related features.

To open the General preferences, from the Define menu, select Preferences. Then, 
click the General button.

Login
Select Always log in as the owner of this Macintosh to have Eudora Planner, 
upon launch, automatically log in to your personal database using the Macintosh 
owner name; or, select Prompt me to log in each time Eudora Planner starts to 
have Eudora Planner prompt you for a login name each time you launch it.

Internet Setup
Select your preferred World Wide Web browser from the Browser menu. The 
browser you choose here is launched when you click a Web site address icon 
displayed in the Detail View of an Event or Contact.

From the Mailer pop-up menu, select your preferred e-mail application. The 
application you choose here is automatically launched when you click an e-mail icon 
displayed in a Contact’s Detail View.

Internet Config is a Macintosh utility that acts as an intermediary between Internet-
enabled applications, such as Eudora Planner, and Internet-based applications, 
such as an e-mail program or browser. If you choose the Internet Config option in 
either the Browser or E-mail menu, click Open Internet Config to set Internet 
Config’s preferences. For more information about using Internet Config, see “Setting 
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Preferences for Internet Config” on page 92.

Uninstalling Eudora Planner
To remove Eudora Planner from your system, drag Eudora Planner items to the 
system trash.

To uninstall by dragging Eudora Planner items to the trash:
1. On your system, locate the folder called Eudora Planner Folder.

2. Drag Eudora Planner Folder to the system trash can. 

This contains your Eudora Planner data files. If you want to preserve 
these files, remove the subfolder called Eudora Planner Data from the 
Eudora Planner Folder before you drag the latter folder to the trash.

3. Open the Macintosh’s System Folder, then locate and open the Extensions 
folder.

4. Locate the extension called Planner Quick Menu and drag it to the trash. 
Then, close the Extensions folder.

5. In the System Folder, locate and open the Preferences folder.

6. Locate the folder called Eudora Planner Preferences and drag it to the trash. 
Then, close all open folders.

7. From the Special menu, select Empty Trash.

Eudora Planner is removed from your system.
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Chapter 2

Using the Calendar
The individual items you schedule in your Calendar are called Events in Eudora 
Planner. The seven distinct types of Events give you the flexibility to record any kind 
of commitment—whether it requires minutes or days of your time, whether it’s 
crucial, optional, or can wait until later.

In this chapter, you’ll learn how to create Events and add related information to 
them. Then, you’ll learn how to use your Calendar and To-Do List to manage your 
schedule.

Types of Events
Events are the building blocks of your Calendar. The seven types of Events in 
Eudora Planner let you track all the activities and information that fill your week: 
meetings and appointments, telephone calls, checklist items, special days or blocks 
of days, notes, and reminders.

By appropriately using the available Event types, you can maintain a schedule that 
is effective for you and understandable to others. The following table describes the 
different Events you can add to your Calendar.

Event Type Use for...

Meeting A meeting or appointment, with specific start and end times on the 
same day, that can involve Contacts from your Address Book or, in a 
workgroup setting, other Eudora Planner users.

To-Do A task you need to remember to do, and to which you can possibly 
assign a priority. 

Call A phone call you need to make. Calls are like To-Do Events in that 
you can assign a priority to them and track them on the To-Do List.
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Each of these Events can be viewed and modified in its own specific Details dialog 
box. Double-clicking a Holiday Event, for example, produces a Holiday Details dialog 
box in which you can view, modify or add information about the Event. These dialog 
boxes are generally referred to in this book as Event Details dialog boxes.

Adding Events to the Calendar
Eudora Planner provides many ways to add Events to your Calendar. For example, 
you can

• Select an Event type from the Insert menu, then fill in the date, time, and any 
other information in the resulting Event Details dialog box. 

• Click an icon in Eudora Planner’s toolbar to create a new Meeting, Call, To-Do, 
Banner, or Sticky Note.

• Click an empty area of any day in the Multi-Day or Day View. Eudora Planner 
creates a new, untitled Meeting Event with a blinking cursor in it to prompt you to 
type a title. After typing the title, you can double-click this new Event to modify it 
further.

There are several other ways to create Events. In any Calendar view, you can click 
an Event icon on the toolbar and drag it onto a date in the Calendar. An Event 
Details dialog box appears for the Event type you’ve chosen, where you can add 
any necessary information. You can also control-click anywhere on the Calendar, 
then select an Event type from the resulting contextual menu. The Event appears in 
the day block or time slot where you clicked.

In the Day or Multi-Day View, you can drag the pointer from the Event’s starting time 
to its ending time. A new Meeting Event appears on the Calendar and the Meeting 
Details dialog box appears. 

For an activity that recurs irregularly throughout your schedule, you can create an 
Event based on a template you’ve configured to contain certain, minimum 
information, such as a title, start time, or a list of invitees. For information on Event 
templates, see “Using Event Templates” on page 59.

To create an Event in the To-Do List, click in the first empty cell below your list of To-

Special An Event that spans an entire day, rather than a range of time on 
that day. You can use Special Events for birthdays, anniversaries, 
journal entries, or other Events on specific days.

Holiday A holiday such as New Year’s Day.

Sticky 
Note

A way to post attention-getting messages or reminders on the 
calendar.

Banner An Event that takes place over one or more days, like a vacation or 
convention.

Event Type Use for...
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Dos and Calls. A cursor appears in the cell, allowing you to type in the title of a new 
To-Do, which you can double-click to open and modify further.

You can also create an Event from within a Contact by selecting an Event type from 
the button bar. The Event you create is both saved to the Calendar and attached to 
the opened Contact. For details, see “Attaching New Events to a Contact” on page 
73.

Use any QuickAccess component to create an Event without having to open Eudora 
Planner. The Events you create with QuickAccess are immediately saved to the 
Calendar. For more information on creating Events with QuickAccess, see “Creating 
Events with QuickDay” on page 126 and “Creating Events with QuickContact” on 
page 131.

The information needed to create an Event varies according to the Event’s type. The 
following sections describe in detail how to create each type of Event. These 
sections discuss the different types of Events in three groups:

• Meetings
• Calls and To-Dos
• Other Events

Additionally, you can organize your Events by assigning them to Event Categories. 
To learn more about organizing Events with Categories, see “Assigning Categories 
to Events and Contacts” on page 101.

Using Meeting Events
Meeting Events are the default Event type in Eudora Planner—the type created 
whenever you click or drag in the Calendar to add a new Event.

You can view, add, and modify information about Meeting Events in the Meeting 
Details dialog box, which organizes information on its Meeting, Group Scheduling, 
and Attachments tabs. 

The following sections describe how to create and modify a Meeting by adding 
information to the Meeting, Group Scheduling, and Attachments tabs.

Tab Meeting Details

Meeting Shows title of the Meeting, date and time, duration, reminder 
settings, and comments. If you’re setting up Meetings outside 
your Eudora Planner workgroup or making appointments for 
yourself, this is the only information you’ll need to enter.

Group Scheduling Shows schedule information for people and resources needed at 
the Meeting. Use this tab to schedule a Meeting that fits in best 
with others’ schedules.

Attachments Shows attached files, email addresses, URLs, etc. Use this tab to 
make Event-related information available to yourself and your 
invitees.
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Scheduling a Meeting
In any Calendar view, you can create new Meetings by entering information into the 
Meeting Details dialog box.

To schedule a Meeting:
1. Open the Meeting Details dialog box. You can do this in a variety of ways, 

depending on the Calendar View you’re using:

• From the Insert menu, select New Meeting.

• In the Day or Multi-Day View, drag the pointer to indicate a range of time for 
the Meeting. 

• In QuickDay or QuickContact, click the New Meeting button.

The Meeting Details dialog box appears. The Event Type box indicates a 
Meeting Event.

You can create a Meeting by control-clicking the Calendar, then selecting 
New Meeting from the contextual menu that appears.

2. In the Title box, type the title of the Meeting.

3. If necessary, change the date and the start time for the Meeting in the Start 
Date and Start Time boxes. You can do this by typing a date and time directly 
into each box or by clicking the Date and Time Picker button and selecting a 
date and time in the dialog box that appears.

4. To set the length of the Meeting, enter a value in the Duration field, then click 
the adjacent pop-up menu to select a unit of time.

5. If necessary, click the Categories button to use the Assign Categories dialog 
box to assign additional categories to the Meeting.

This pop-up menu indicates the 
Event typeThe title of the Meeting goes 

here

Type directly into this field 
to enter a start date

Type here to enter the time of 
the Meeting

Meeting blocks time in your 
schedule when this is selected

You can type notes about the 
Meeting in this area

Click to assign categories

These options let you set 
the length of the Meeting

Indicates the last time this 
Event was modified and the 
name of the modifier
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In order for invitees to see your Meeting on their Calendars, you must 
assign it to a public category that both you and the invitees subscribe to. 
If you’re creating the Meeting on a tab for which the default category is 
private, you can assign a public category to this Meeting by selecting the 
Shared option before clicking the Categories button. Invitees can also 
see Meetings to which they’ve been invited by creating a Calendar tab 
that shows Events that occupy their time. For details, see “Creating 
Calendar Tabs” on page 105.

6. If you want to be reminded of this Meeting, set a reminder. See “Using 
Reminders” on page 47 for more information on reminders. If this is a recurring 
Meeting, you may want to set it up as a repeating Event . See “Setting Up 
Repeating Events” on page 46 for more information . If you are using Eudora 
Planner in a workgroup setting, select the Show Time as Busy option to have 
the Meeting block time in your schedule. See “Showing Your Time as Busy” on 
page 144 for more information.

If you’ve turned on the Remind me for all time commitments option in 
the Calendar preferences, then you will automatically receive a reminder 
for this Event if you’ve selected Show Time as Busy. For information on 
Calendar preferences, see “Setting Calendar Preferences” on page 64.

7. Click OK.

The Meeting appears in your Calendar as you specified.

If you are using Eudora Planner for group scheduling and want to invite other users 
to this Meeting, see “Using Group Scheduling” on page 142 for more information.
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Setting Defaults for New Meetings
Eudora Planner lets you set preferences to have certain information and settings 
automatically entered into new Meetings when you create them. 

To set defaults for new Meetings:
1. From the Define menu, select Preferences to open the Preferences dialog box. 

Then, click the Calendar button. 

The Calendar preferences appear, with the Events tab displayed in the 
foreground.

2. Click the Start at nearest pop-up menu to determine the default time for 
Meetings that you create.

This default is always relative to the current time—the time at which you actually 
create the Meeting. For example, if you select the Current Time setting, and 
then create a Meeting at 4:11 p.m., then that Meeting will be automatically 
scheduled for 4:11 p.m. on the date you’ve selected in the Calendar. If you had 
selected the 30 Minutes setting, that same Meeting would have been 
automatically scheduled for 4:30 p.m., the half-hour nearest the current time.

3. Select any or all of the following options, if desired:

• To have Eudora Planner alert you when you accidentally schedule a Meeting 
for a time that you’re unavailable, select Alert if unavailable. 

• Select Auto-attend to have your attendance automatically set for any 
Meetings that you create.

• To have the Invite dialog box automatically opened when you create a new 
Meeting, select Auto-open invitations for new Meetings.

4. In the Duration box, enter a default length for your Meetings.

5. From the Auto-schedule Interval pop-up menu, select a time value.

This setting governs the auto-schedule function, which you activate by clicking 
the Find Available button on the Group Scheduling tab in the Meeting Details 
dialog box. The auto-schedule function automatically finds a block of time in 

These options determine the defaults for new Meetings
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which all your Meeting invitees are available.The time interval you select here is 
the increment by which the auto-schedule function advances to find an available 
time. 

6. Click OK.

Eudora Planner is set to automatically enter these defaults into new Meetings. 

Another way to set defaults for new Meetings—or any other type of Event—is by 
using Event templates. For more information, see “Using Event Templates” on page 
59.

Using To-Dos and Calls
To-Dos and Calls are similar Event types that indicate specific tasks you need to 
complete. You might create a To-Do to show that you need to prepare a budget 
report or pick up a package, or schedule a Call for when you need to telephone a 
business client or a friend. You can mark both To-Dos and Calls as complete or 
incomplete to indicate their status. And you can also prioritize them, so you can see 
their order of importance.

To-Dos and Calls can be either undated or dated, depending on the nature and 
urgency of the activity you’re scheduling. An undated To-Do Event does not have 
specific start and due dates. You might create an undated To-Do for a household 
project that doesn’t need to be started or completed by a particular date. Similarly, 
an undated Call Event has neither a specified time or date. You might create an 
undated Call to show that you need to telephone an old friend with whom you 
periodically keep in touch.

Dated To-Dos and Calls have specific start dates, and, in the case of Calls, may 
even have specific times. To-Dos related to projects at work would likely be dated, as 
would Calls scheduled for potential customers or clients.

Undated To-Dos and Calls stay on the Calendar until you mark them as Complete. 
Dated To-Dos and Calls remain on the Calendar only between their start and due 
dates. These dated Events do not forward beyond their due date, but can be viewed 
as overdue Events in the To-Do List. For information on how to view overdue Events 

Auto-schedule function is 
invoked by clicking here

If the auto-schedule interval is set to 
60 minutes, and this 11:00 Meeting 
conflicts with the schedule of one of 
the invitees, then the auto-schedule 
function would advance the Meeting to 
here, 60 minutes after the orignal time
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in the To-Do List, see “Viewing To-Dos and Calls” on page 40.

Scheduling To-Dos
Schedule a To-Do Event for a task you must complete, whether it’s an important 
project for your department or a routine chore like taking your bottles and cans to 
the recycler.

To schedule a To-Do:
1. From the Insert menu, select New To-Do.

The To-Do Details dialog box appears. The Event Type box indicates a To-Do.

You can create a To-Do by control-clicking anywhere on the To-Do List, 
then selecting New To-Do from the contextual menu that appears.

2. In the Title box, type a name for the To-Do. 

3. If you want this to be a dated To-Do, select the Due option, then enter a due 
date and start date.

You can do this by typing a date directly into each box or by clicking the Date 
Picker button and selecting a date in the dialog box that appears.

4. To set the To-Do’s priority, select from the Priority pop-up menu. 

5. Click the Categories button to assign categories to the To-Do.

6. Click OK.

The To-Do appears in the To-Do List.

Scheduling Calls
Schedule Call Events for telephone calls that you must make, such as those to a 

Enter a title here
Click to use the Date Picker to 
select a date

You can set a To-Do to have a 
due date, then enter start and 
due dates

Set the priority by clicking this 
pop-up menu

Click to assign categories

This pop-up menu shows the 
completion status

Indicates the last time this 
Event was modified and the 
name of the modifier

Use this area to type notes 
about the To-Do
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client or potential sales prospect. You can link Call Events to Contacts in your 
Address Book, so that each time you telephone a Contact, Eudora Planner records 
a Call in that Contact’s history, giving you a running log of your communications with 
that person or organization.

To create a Call:
1. From the Insert menu, select New Call.

The Call Details dialog box appears. The Event Type box indicates a Call.

You can create a Call by control-clicking anywhere on the To-Do List, then 
selecting New Call from the contextual menu that appears.

2. If you want to attach a Contact to the Call, type a name into the Name box or 
click Find Contact to search your Address Book for a particular Contact. If not, 
go to step 3.

Once you begin to type a name into the Name box, Eudora Planner will search 
the Address Book and automatically fill the Name box with the Contact’s name. 
The Contact’s primary phone number will appear in the Phone box.

3. In the Title box, type a name for the Call.

If you’ve attached a Contact to this Call, then Eudora Planner automatically 
gives it a title that includes the Contact’s name and primary phone number.

4. To assign priority and status to the Call, select from the Priority and Status 
pop-up menus. To assign Categories to the Call, click the Categories button.

5. Click the Schedule tab. If you want to change the date, time, or duration, or add 
a reminder for this Call, select the Schedule at option. The Date, Time, 
Duration, and Reminder boxes become available.

• To change the date and time of the Call, type directly into the Date and Time 

When you enter a name, 
Eudora Planner searches your 
Address Book for a matching 
Contact, then automatically 
inserts the Contact’s primary 
phone number

You can click to find a Contact 
to attach to this Call

Clicking here lets you view the 
Details for an attached Contact

Enter a title here

This pop-up menu lets you set 
the priority

This pop-up menu indicates the 
completion status

Type notes about the Call in this 
area

Click here to assign categories
Indicates the last time the Call 
was modified and the name of 
the modifier
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boxes or click the Date and Time Picker button and select a date and time in 
the dialog box that appears.

• Use the Duration options to change the length of the call.

6. If you want to be reminded to make this Call, set a reminder. See “Using 
Reminders” on page 47 for more information on reminders. If you are using 
Eudora Planner in a workgroup environment and you want this Call to block 
your scheduled time, then select Show time as busy. 

7. Click Save.

The Call appears in the To-Do List. If you’ve linked the Call to a Contact in your 
Address Book, then the Call will also appear in that Contact’s History. 

Tracking To-Dos and Calls
The To-Do List appears in every Calendar view and gives you a convenient way to 
log and track your To-Dos and Calls. Use the To-Do List to view, prioritize, and note 
the completion of To-Dos and Calls. 

Viewing To-Dos and Calls
To determine which Events appear in the To-Do List, control-click anywhere within 
the list, then select from the options in the resulting contextual menu. 

To choose which dated To-Dos and Calls appear in the To-Do List, select one of the 
following options from the contextual menu:

• Select Today’s  To-Dos and Calls to show just those To-Dos and Calls 
assigned to today; likewise, select Next 7 Day’s To-Dos and Calls to display 
only items assigned to dates in the following week. 

• Select Selected Day’s To-Dos and Calls to see only those To-Dos and Calls 
for a selected date in the Calendar.

• Select All Dated To-Dos and Calls to display all your dated To-Dos and Calls, 
regardless of assigned due date, completion status, or overdue status. 

In addition to the selection you make above, you can choose one or more of the 
following options:

• Select Include Undated Items to display your undated To-Dos and Calls.

Attached Call appears in 
the Contact’s history list, 
where you can double-
click to view its details
40 Chapter 2



• Select Include Overdue Items to display dated To-Dos and Calls that haven’t 
been completed by their due dates and still remain incomplete.

• Select Include Completed Items to display all the To-Dos and Calls that you’ve 
already completed, no matter how long ago their completion dates.

• Select Include To-Dos to have To-Dos included in the selection you made 
above. If you deselect this option, no To-Dos appear in the To-Do List.

• Select Include Calls to have Calls included in the selection you made above. If 
you deselect this option, no Calls appear in the To-Do List.

Dated To-Dos and Calls also appear in the Multi-Day View’s To-Do area, underneath 
the date for which they are scheduled.

Tracking Priority and Completion of To-Dos and Calls
You can track the relative importance of your To-Dos and Calls by assigning priority 
labels to them. These labels enable you to sort the To-Do List by priority, so you can 
easily see which items are the most urgent. Eudora Planner supplies three default 
priority labels, but you can change the names of these and create up to ten of your 
own.

To create a Priority Label:
1. From the Define menu, select Preferences.

The Preferences dialog box appears.

2. To display preferences for the Calendar, click the Calendar button, if necessary.

3. Select the Priorities tab.

The Priorities preferences are displayed.

4. Type label names in the fields, then click the Default option to assign a default 
priority label.

When you create a new Event, it is assigned the default label.

The order in which 
priority labels 
appear here 
determines how 
they are sorted

Denotes that this priority is the default 
for all To-Dos and Calls you create
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5. Click OK.

The labels you’ve created are now available for assigning priority to your 
Events.

To assign priority to a To-Do or Call:
1. Double-click the Event to which you want to assign a priority label.

The Event Details dialog box appears.

You can open a To-Do or Call by control-clicking it, then selecting Details 
from the contextual menu that appears.

2. On the To-Do or Call tab, click the Priority field to select a priority label.

3. Click OK.

The Priority level appears in the Priority column of the To-Do List. If you sort the 
To-Do List by priority, the priority you assign here determines the Event’s 
position on the To-Do List.

When you create a To-Do or Call, it is labeled incomplete by default. Incomplete To-
Dos and Calls automatically forward daily in your Calendar. Once you’ve finished a 
To-Do or Call, you can mark it as complete. 

To mark a To-Do or Call as complete:
1. Double-click the Event that you want to mark as complete.

The Event Details dialog box appears.

2. On the To-Do or Call tab, click the Status field, then select Complete.

In the To-Do List, you can mark a To-Do or Call as complete by clicking 
once in the check box appearing in the left-hand column of the list.

3. Click OK.

A check mark appears next to the Event in the To-Do List, indicating that it is 
complete. The Event will not appear on the To-Do List on subsequent days, 
unless you’ve set the To-Do List to display completed items.

Organizing the To-Do List
You can determine which Event fields appear in the To-Do List and the order in 
which they are displayed.

To add and reorder columns in the To-Do List:
1. Click anywhere within the To-Do List to select it. Then, from the Define menu, 

select List Columns.
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The To-Do List Titles dialog box appears.

2. In the All Columns area, select the title of the To-Do field that you want to 
display as a column, then click Add.

The selected field title moves from the All Columns area to the Ungrouped list in 
Current Columns area. A corresponding column appears in the To-Do List.

3. To add more columns to the To-Do List, repeat step 2 as many times as 
needed.

4. To reorder the To-Do List columns, drag the items appearing in the Ungrouped 
list to different positions within the list.

The order of the To-Do List columns changes to reflect that of the Ungrouped 
fields.

5. Click OK.

Using Other Event Types
This section explains how to add Holidays, Special Events, Banners, and Sticky 
Notes to your Calendar.

Scheduling Holidays and Special Events
Schedule Holidays to indicate national, local, religious, or company holidays. Use 
Special Events for important occasions that span a whole day and don’t have a 
specific time associated with them, such as birthdays, anniversaries, conferences, 
or vacation days.

To schedule a Holiday or Special Event:
1. From the Insert menu, select New Holiday or New Special Event.

The Holiday or Special Details dialog box appears. The Event Type box 

This area shows the 
fields currently 
displayed as columns 
in the To-Do List

This area shows all fields that can 
be displayed as columns in the To-
Do List
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indicates a Holiday or Special Event.

To add a new Holiday or Special Event to your Calendar, control-click in 
any View, then select New Banner from the contextual menu that 
appears.

2. In the Title box, type a name for the Event.

3. If necessary, change the date in the Start Date box.

To change the date, type a start date into the box. You can also click the Date 
Picker button to select a date. If you need to select a different month, select 
one from the list or click the arrow buttons at the top of the month-view 
Calendar. Click the arrows above the list of month names to select a different 
year.

4. If necessary, change the duration in the Days box.

5. If you want to be reminded of this Event, set a reminder. See “Using 
Reminders” on page 47 for more information on reminders.

6. Click OK.

The Event is saved and appears in your Calendar.

Adding Banners
For Events that span multiple days, such as conventions or vacations, you can add a 
Banner to your Calendar. Banners appear in each Calendar view, including the Day 
View.

To add a Banner:
1. From the Insert menu, select New Banner.

Enter a title here

Click to use the Date 
Picker to select a date

Click these arrows to select the 
Event’s duration

Select to have this Event block time 
in your schedule

Click to assign categories Indicates the last modification time 
and the name of the last modifier
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The Banner Details dialog box appears. The Event Type box indicates a 
Banner.

You can add a Banner by control-clicking in any Calendar View, then 
selecting Banner from the contextual menu that appears.

2. In the Title box, type a name for the Banner.

3. If necessary, change the start date of the Banner in the Start Date box.

You can do this by typing a date and time directly into each box or by clicking 
the Date and Time Picker button and selecting a date and time in the dialog 
box that appears.

4. If necessary, change the duration of the Banner in the Days box.

5. If you want to be reminded of this Event, set a reminder. See “Using Reminders” 
on page 47 for more information on reminders.

6. Click OK.

The Banner is added to your Calendar.

Using Sticky Notes
Just as you might tape notes on your computer monitor to remind you of important 
tasks or events, you can use Sticky Notes to post attention-getting messages on 
your Calendar. A Sticky Note can be resized, minimized, or collapsed to better fit 
your Calendar view, and can be dragged from day to day until you no longer need to 
see the message it contains.

To add a Sticky Note:
1. From the Insert menu, select New Sticky Note.

Enter the Banner’s title here

Click to use the date picker 
to select a start date

Click to assign categories

Click the up/down arrows to 
set the Event’s duration

To have this Event block time in 
your schedule, select this option

Indicates the last modification 
time and the name of the last 
modifier
Using the Calendar 45



The Sticky Note Details dialog box appears. The Event Type box indicates a 
Sticky Note.

You can create a new Sticky Note by control-clicking in any Calendar 
View, then selecting New Sticky Note from the contextual menu that 
appears.

2. In the Title box, type a name for the Sticky Note.

3. Type your comments into the field below the Title box. 

4. Click OK.

The Sticky Note is saved and appears in your Calendar with the title you’ve 
given it.

5. In the Week or Month View, move or resize the Sticky Note as desired.

To move the Sticky Note, drag it. To resize it, drag the bottom right corner until 
you reach the desired size.

Setting Up Repeating Events
Your schedule might include Events that repeat on a regular basis, such as weekly 
staff meetings or regular appointments with an important client. With Eudora 
Planner, you can create an Event once and have it repeat on a regular basis for as 
long as is necessary, which is a good way to set up your regular, recurring meetings.

To schedule a repeating Event:
1. Double-click the Event to open the Event Details dialog box.

2. Click the Repeating Event Options button.

Enter a title here

Click to assign categories

Type a descriptive note here

Indicates the last modification 
time and the name of the 
modifier
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The Repeat Info dialog box appears.

3. Select a setting in Repeat Options section:

• To have the Event repeat at a standard interval, choose one of the pre-defined 
settings in the top area of the section.

• To have the Event repeat at an interval of your making, select one of the 
Repeat every options. Select the first option to have the Event repeat at a 
specified interval. Select the second option to pick specific days of the week 
on which the Event repeats.

4. Choose an option in the Repeat Count area:

• Select the first option to have the Event repeat a specified number of times. 
Enter the number of repeats into the box.

• Select the second option to have the Event repeat until a specific date. Enter 
the date into the box in mm/dd/yy format.

5. Click OK.

The Event now appears throughout the Calendar at the repeat interval you’ve 
specified.

Using Reminders
Eudora Planner can remind you of an upcoming Event—minutes, hours, or days 
before it occurs—by flashing the title of the Event in the menu bar, displaying a 
dialog box, playing a sound, or launching another application. Eudora Planner’s 
reminders appear even when Eudora Planner isn’t running. The following sections 
describe how to set up and respond to reminders.

Setting Up Reminders

Standard repeat options are 
available here

Select this option to set the Event 
to repeat at a specific interval

Use this option to set the Event to 
repeat on specified days

Lets you repeat the Event for a 
specific number of times

Lets you repeat the Event until a 
specific date
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You can specify when and how a Eudora Planner reminder should alert you to an 
impending Event.

To set up a reminder:
1. Double-click the Event to open the Event Details dialog box.

If the Event is a Call, select the Schedule tab. Otherwise, select the tab with the 
same name as the Event. For example, if the Event is a Meeting, select the 
Meeting tab. 

2. Select Reminder.

The Reminder Info dialog box appears.

You must assign a date to a To-Do or Call Event before you can 
designate a reminder.

3. In the When area, select Prior to Event. Then, enter a time value into the box, 
and select a time increment from the adjacent pop-up menu. These settings 
determine when the reminder will be activated.

4. Determine the type of reminder by selecting from among the following options:

• To have a sound to accompany the reminder, select Play Sound, then select 
a sound from the popup menu.

• To have Eudora Planner remind you by flashing the Event title in the menu 
bar, select Flash icon in menu bar. 

• To have Eudora Planner remind you by showing an alert dialog box, select 
Display dialog.

• To have Eudora Planner remind you by launching another application, select 
Open document or launch application. For example, if the Event you are 
setting the reminder for requires that you type an e-mail message, you may 
want Eudora Planner to launch your e-mail application. To select a document 
or application, click the Select button. The Open dialog box appears, where 
you can navigate to find the document or application. 

Once you’ve made your selections, click OK to return to the Event Details 

Use these settings to determine 
how far in advance of the Event 
you are to be reminded

Select any or all of these 
options to determine how you 
are to be reminded
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dialog box. The Reminder box indicates the setting you’ve chosen.

5. Click Save to close the Event Details dialog box.

The Event is set to remind you at the time you’ve chosen, in the manner you’ve 
specified.

Responding to Reminders
To respond to a Reminder dialog box, click the Dismiss button to acknowledge the 
reminder and not be reminded again. Or, select a Snooze option to have the 
Reminder appear again after a specified time interval.

If you set a reminder for a repeating Event, the reminder occurs each time the 
repeating Event appears on your Calendar. When you dismiss the reminder for one 
occurrence of the repeating Event, you dismiss only the Reminder for that particular 
day.

Setting Reminder Preferences
You can opt to have Eudora Planner automatically remind you of all your time 
commitments, saving you the trouble of setting a reminder for each Event that shows 
as busy time in your schedule.

When activated, this feature does not override any reminders you’ve specifically set 
for individual Events, so those Events still remind you at the times you’ve specified.

To set automatic reminders for all Events that block time in your Calendar:
1. From the Define menu, select Preferences.

The Preferences dialog box appears.

Reminder setting appears here

Click one of these buttons to either dismiss or snooze the reminder

View the Event’s details by clicking this button
You can select the length of the snooze period before clicking the 
'Snooze' button
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2. Select the Calendar button, then make sure that the Events tab is active.

3. In the Reminders area, select the Remind me check box. Enter a time value 
into the adjacent box, then select a unit of time from the pop-up menu.

4. To determine how Eudora Planner reminds you, select from among the Flash 
icon in menu, Display dialog, Play sound, and Launch application check 
boxes. You can select any or all of these options.

Eudora Planner now automatically reminds you of all Events that show as busy 
time, even if you haven’t set reminders for each of those Events.

Attaching Items to Events
You can add useful information to Events by linking them to related objects, such as 
Contacts in your Address Book, documents created in other applications, or 
document aliases. You can also create links to relevant e-mail addresses and 
Internet URLs.

Attaching Contacts
When you schedule an Event that is in some way related to one of your Contacts, 
you can physically link that Contact to the Event. So, for example, if you schedule a 
conference call with three Contacts in your Address Book, you can attach all three 
Contact records to the Call. Those Contact names appear in the Call’s Attachments 
area, where you can double-click them to see the Details dialog box for each. 
Likewise, the Call is recorded in the History section of each Contact’s Details dialog 
box, where you can double-click its title to view its details.

To attach a Contact to an Event:
1. Double-click the Event to open the Event Details dialog box, then click the 

Attachments tab.

2. Click the Contacts button.
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The Attach Contacts dialog box appears.

3. In the Find box, start typing the name of the Contact you want to attach to this 
Event.

As you type, Eudora Planner searches your Address Book for names matching 
the text you’re typing. Matching names appear in the Matching Contacts area.

4. In the Matching Contacts area, select the checkbox next to the name you want 
to attach to the Event, then click Done.

The selected Contact appears in the Event’s Attachments area.

5. Click Save.

The Contact is attached to the Event and is stored in the Event’s Attachments 
area. Also, the Event is added to the History area in the Contact’s Details dialog 
box.

Attaching Files
There are two ways to attach a file to an Event: either by attaching the whole file or 

Attach a Contact by selecting 
its check box

Shows the names of your Contacts and other Eudora Planner 
users on the network

Your choice here determines 
which Contacts are displayed If you choose the ‘Found Contacts’ option in the ‘Show’ 

menu, enter the name of the Contact you want to find here

Attached Contacts appear 
here

Select a Contact in the list, then click 
here to view its details
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by attaching just an alias of the file. When you attach a file to an Event, the file is 
actually copied into your Eudora Planner database, where it is stored until you 
delete either the inserted file or the Event to which it is attached. When you attach a 
file alias, only a pointer to the file is stored in your database, minimizing the size of 
the database and saving space on your hard drive.

Both attached files and aliases appear in the Event’s Attachments list, from which 
you can open the file in the application that created it.

Copying files into your database will increase its size. If you need to keep your 
database small, you should create aliases to the files instead of inserting them. 
However, if you move your database file to another computer and open it with 
Eudora Planner, the files inserted into the Event remain available, whereas aliases 
to files will no longer work, as the files themselves are no longer available.

To attach a file or file alias to an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Add File or Add Alias, depending on what you want to attach.

An Open dialog box appears.

3. Locate and select the file you want to attach to the Event, then click Open.

The file or file alas is copied into your database, and the file name appears in 
the Attachments list. The Type field indicates that it is either a file or an alias. 
You can open the file by selecting it in the list, then clicking Launch.

4. Click Save to close the Event.

To remove an attached file or file alias from an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Select the file or alias in the Attachments list box.

The name becomes highlighted and the Remove button becomes available.

3. Click Remove.

The file or alias is removed from the Event.

When you remove an inserted file from an Event, the file is deleted only from the 
Eudora Planner database. Any other copies of the file residing on your system are 
not affected. Removing a alias deletes only the reference to the original file, and 
does not change that file in any way.

Attaching Web Sites and E-mail Addresses
You can attach related e-mail addresses and Web sites to Events. When you click 
the attached URL, your preferred Web browser launches, searches for the Web site, 
and then loads the Web page in the browser window. When you click an attached e-
mail address, your preferred e-mail program launches and creates a pre-addressed 
message.
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To attach a Web site to an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Add URL.

The Attach URL dialog box appears.

3. Enter a name for the Web site into the upper box. Enter the URL of the Web site 
into the lower box.

4. Click OK.

The web site is added to the Attachments list. You can open the Web site with 
your browser by selecting its entry in the list, then clicking Launch.

5. Click Save.

To attach an e-mail address to an Event:
1. In the Event Details dialog box, click the Attachments tab.

2. Click Add E-mail.

The Attach E-mail Address dialog box appears.

3. In the upper box, type the name of the person or company you want to 
associate with the email address. In the lower box, type the actual e-mail 

Attached web site 
address appears here
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address.

4. Click OK.

The name associated with the e-mail address appears in the Attachments list. 
To use to send a message to this address, select its entry in the list, then click 
Launch. Eudora Planner opens your e-mail program, which automatically 
creates a new message addressed to the intended recipient.

5. Click Save.

Getting More Out of the Calendar
The following sections describe some advanced features of the Eudora Planner 
Calendar, including:

• Copying, pasting, and dragging Events

• Using Eudora Planner’s search feature to find specific Events

• Changing the appearance of Events so that you can better organize your 
Calendar visually

• Using Event templates to save time when creating new Events

Editing Events in Any Calendar View
You can modify the time and date of an Event, without opening its Event Details, by 
dragging or pasting it to a new position on the Calendar.

Cutting, Copying, and Pasting Events
To cut and copy an Event, select it in any Calendar view, then select Cut or Copy 
from the Edit menu. To paste an Event, click to set the insertion point on the 
Calendar, then select Paste. All information in the Event remains the same except 
for its date and, possibly, time, if you’re dragging in the Multi-Day or Day View.

In any Calendar View, you can cut, copy, and paste an Event by control-clicking it, 
then selecting Cut, Copy, or Paste from the contextual menu that appears. 

Moving Events
You don’t need to open the Event Details dialog box to reschedule an Event. 
Instead, simply drag it from one date and time to another. Use the appropriate 
view—Day, Week, or Month—depending on how far you want to move the Event.

Searching the Calendar
The Calendar has a variety of search features which let you perform searches If you 
need to find a specific Event in your Calendar, you can search for it by title. 
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Using the Find Feature
The Find feature is most useful for locating a particular Event that appears in the 
active Calendar tab. To search by this method, enter a keyword to search for, then 
initiate the search operation. Eudora Planner looks for the keyword in the Title and 
Descriptions fields of each Event in the active tab. When a matching Event is found, 
Eudora Planner advances to the date of the Event and highlights it in the Calendar 
view. You can perform this type of search in any Calendar view.

To find an Event using the Find feature:
1. From the Edit menu, select Find. 

The Find Event dialog box appears.

2. In the Find box, type text from the Title or Description field of the Event you’re 
searching for. 

3. Click Find.

The Calendar advances to the first occurrence of the Event and highlights in the 
Calendar view. You can double-click the Event to view it. To find subsequent 
occurrences of the Event’s matching the search criteria, select Find Next from 
the Edit menu.

Using the Find All Feature
The Find All feature lets you find multiple Events through a search based on 
information contained in one or more of the various Event fields. To use this feature, 
enter the Event information you want to search for, select the specific Event fields 
and Calendar tabs to be included in the search for that information, then generate a 
list containing all Events that match your search criteria. 

To use the Find All feature to search for Events:
1. From the Edit menu, select Find All.
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The Find Events dialog box appears.

2. In the Find box, enter the Event information you want to search for.

3. In the Search area, select either Current Tab to search only the active tab or 
All Tabs to search every tab in the Calendar.

4. Click the triangle to expand the dialog box for more search options.

5. In the Fields to Search area, select the Event fields you want to include in the 
search. Choose fields that might contain the information you entered in step 2.

6. Choose a Comparison option:

• Select Contains to find Events that have the information you entered in the 
Find box included somewhere within the text or number string of the fields you 
selected in step 5. For example, if you use this comparison method to search 
for Events containing the word “budget” in the Title field, you would find 
Events entitled “Send Quarterly Budget to Tammy” or “Budgeting in the 
Nineties,” as well as those just called “Budget.”

• Select Equals to find only those Events containing a field that matches 
exactly what you entered into the Find box. If you use this comparison 
method, a search for the word “budget” will turn up only those Events called 
“Budget.” If you wanted to find all Events entitled “Send Quarterly Budget to 
Tammy,” you would have to type that exact title into the Find box.

• Select Starts with to find Events containing a field that starts with the text or 
number string you’ve entered into the Find box. For example, a search for the 
words “meeting with” would turn up any Events entitled “Meeting with Tammy” 
or “Meeting with Ken,” but would not turn up an Event called “Status Meeting 
with Tammy and Ken.”

7. Click Find.

A Find Results tab appears, displaying a List View that contains all Events 
matching your search criteria. To view the details for a found Event, double-click 
it in the list. You can save these search results as a new tab, as described in 

Enter the Event data you 
are searching for

Search either just the 
current tab or all tabs in 
your Calendar

 Eudora Planner searches 
the fields you select here

You can perform three 
types of searches
56 Chapter 2



“Saving Your Find Results” on page 57.

Finding Events by Category
Use the Find Categories feature to perform a Calendar search based on Category.

To find Events by Category:
1. From the Edit menu, select Quick Find.

The Find Events with Categories dialog box appears.

2. In the Categories area, select the Categories you want to include in the search. 
To choose all Categories on a particular server, just select that server’s name.

3. Click Find.

A Find Results Tab appears, displaying a a list of Events containing the 
Categories you selected.

Saving Your Find Results
To keep the results of a search for future reference, save the Find Results tab as a 
new tab.

To save the Find Results tab as a new tab:
1. Click the icon next to the tab’s name.

The Save Results as a Tab dialog box appears.

Eudora Planner searches for 
Events assigned any of the 
categories you select here

Enter a name for the 
tab here You can click here to create a new category just for these 

Events

The category you select from this pop-up menu is the 
default for any new Events you create on this tab

Check mark indicates 
a category that 
you’ve assigned to 
the found Events

Dash indicates that 
this category appears 
in one of the found 
Events
Using the Calendar 57



2. In the Name box, enter a name for the tab.

3. Click New Category to use the Category dialog box to create a new category 
(for details about creating a category, see “Creating Categories” on page 100). 
Once you’ve created the category, click Done to return to the Save Results as a 
Tab dialog box. 

The category you create here will be assigned to all the Events 
appearing in the Find Results tab. You should give this category a name 
that indicates why you searched for these Events.

4. Select the check box for the category you created in step 3 in order to assign it 
to the Events appearing in this tab. You can assign other categories by 
selecting their check boxes as well.

Because tabs are based on groupings of categories, you must assign at 
least one common category to the Events in your search results in order 
for those Events to appear together in a tab.

5. Click the Assign category to any new Events created in this tab pop-up 
menu to select the default primary category for Events that you create in this 
tab. Then, click the Tab Color pop-up menu to select a background color for 
this tab.

6. Click OK. 

The new tab appears in your Calendar, showing any items associated with the 
Categories you selected in step 4. You can modify this tab as you would any 
other Calendar tab.

Enhancing the Appearance of Events
You can make important Events stand out in your Calendar by changing their text 
styles and colors or by attaching graphics to them.

Changing the Style and Color of Event Text
Events by default obtain their text style and color settings from their primary 
Categories; but if you want to make an important Event stand out on your Calendar, 
you can individually change its text settings. The style and color changes you make 
using the following procedure override the settings assigned by the Category.

To change the style of an Event:
1. In any view, click the Event to select it.

2. To change the Event’s font characteristics, from the Define menu, select Font, 
Size, or Style, then select a font, font size, or font style from the resulting 
submenu.

Your font preferences are immediately applied to the Event.

3. To change the color of Event’s title text, from the Define menu, select 
Foreground Color, then choose a color from the chart that appears. To change 
the Event’s background color, from the Define menu, select Background 
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Color, then choose a color from the chart.

The background color you select applies to Banners and Sticky Notes in any 
Calendar view, and to other Event types in the Multi-Day and Day views.

Adding Graphics to Events
You can make an important Event stand out by attaching a graphic to it. The 
attached graphic appears next to the Event’s title.

To add a graphic to an Event:
1. Open either a Month or Week View containing the Event.

2. From the Window menu, select Show Graphics Palette.

The Graphics Palette window appears.

3. In the Graphics Palette, click on a graphic, then drag it on top of the Event. 
When the Event’s title becomes outlined, release the mouse button.

The graphic is copied into the Calendar and appears next to the Event’s title.

Using Event Templates
You may find that you often create Events that contain the same information or 
attachments as existing Events in your Calendar, such as irregularly recurring 
Meetings that always include the same invitees, location, and categories. You can 
simplify the creation of such Events by using Event templates. When you create an 
Event based on a template, the Event already contains the information you specified 
for the template. The template is available from the Insert menu anytime you need to 
create a new Event containing that information.

Creating Event Templates
You create an Event template using the same basic steps required for creating a 
new Event. After you create the template, it appears in the Event from Template 
submenu of the Insert menu.

To create a new Event template:
1. From the Insert menu, select Event from Template, then select Edit 

Templates from the resulting sub-menu.
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The Templates dialog box appears.

You can create a new Event template by control-clicking on any Calendar 
View, selecting New from the shortcut menu, then selecting Event from 
Template. From the submenu that appears, select Define Event 
Templates.

2. If necessary, select Event Templates from the pop-up menu at the top of the 
dialog box.

3. Click New.

The New Template dialog box appears.

4. Enter a name for the template. Then, click OK.

The Event details dialog box appears with a heading that indicates that it is a 
template.

5. Type information and select options for the template as you would to create a 
new Event.

See “Adding Events to the Calendar” on page 32 for more information. You can 
also add Contacts, attachments, email addresses and links to web sites. To 
learn more about these options, see “Scheduling Users, Rooms, and 
Resources for Meetings” on page 142. 

6. Click OK.

The template is saved and becomes available from the Insert menu. 

Creating Events from Templates
You can use your Event templates to create new Events that contain similar 
information and attachments. Once you’ve created Event from a template, you can 
add to or modify the Event as needed.

To create an Events from a template:
1. From the Insert menu, select Event from Template, then select the name of 

the template from the resulting submenu.

The Event Details dialog box appears. All information and attachments that 
you’ve added to this template appear in the new Event.

Create a new template 
by clicking here

Click to duplicate an 
existing template

Click here to delete a 
template

Pop-up menu indicates that these templates are for creating Events

Edit an existing template by clicking here
Click here to view security details about a template
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You can open an Event Template by control-clicking anywhere in any 
Calendar View, selecting New from the shortcuts menu, then selecting 
Event from Template. From the submenu that appears, select the 
template you want to use for this Event.

2. Select options, as appropriate, for the Event.

You can add or modify any information in the Event.

3. Click Save.

The new Event appears in your Calendar.

Organizing the List View and To-Do List
This section explains how you can organize the List View and To-Do List to display 
the content and layout you prefer.

Adding, Removing, and Reordering Columns
The List View and the To-Do List display Event information in columns, with each 
column representing an Event field. You can select which Event fields appear as 
columns and change the order in which they are displayed.

To add, remove, and reorder List View and To-Do List columns:
1. Click in either the List View or To-Do List to select that area of the Calendar. 

Then, from the Define menu, select List Columns.

The Event List Titles dialog box appears.

2. To add a column, select an Event field title in the All Columns area, then click 
Add.

The selected field title moves from the All Columns area to the Current Columns 
area. The field immediately appears as a column in the List View or To-Do List.

3. To remove a column, select an Event field title in the Current Columns list, 
then click Remove.

The selected field title moves from the Current Columns area to the All Columns 

This area shows the 
fields currently 
displayed as columns 
in the List View This area shows all fields that can 

be displayed as columns in the List 
View
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area. The column immediately disappears from the List View or To-Do List.

4. To reorder the List View columns, drag the items appearing in the Ungrouped 
list to different positions within the list.

The order of the List View columns changes to reflect that of the Ungrouped 
fields.

5. Click OK.

Grouping Events
In the List View and To-Do List, you can group Events so that they appear in clusters 
according to a field, allowing you to quickly identify Events with a common value in 
that field. For example, if you want to see what Events you have scheduled on each 
Friday for the next three months, you can group by day of the week, so that Events 
appear in the List View or To-Do List clustered under the name of the day on which 
they occur. The Friday cluster would show all Events occurring on that day for the 
next three months, regardless of Event type, Category, or other variables.

To group Events in the List View and To-Do List:
1. Click in either the List View or To-Do List to select that area of the Calendar. 

Then, from the Define menu, select List Columns.

The Event List Titles dialog box appears. The Current Columns area shows the 
titles of Event fields that currently appear as columns in the List View. The All 
Columns area shows the titles of all available Event fields.

2. To group Events in the List View by a field, in the Current Columns area, drag 
a field title from the Ungrouped list to the Grouped list. 

In the List View, the title of the selected field moves from the List View column 
to a position within the list itself. The Events in the List View become grouped 
according to that field.

3. Drag more fields to the Grouped list as desired. You can reorder these as you 
see fit. The top field in the Grouped list determines the primary grouping; all 
other fields are secondary—subgroups within the primary group.

4. Click OK.

The List View reflects the changes you made in the Event List Titles dialog box. 

Handling Meeting Invitations
If you are using the Eudora Planner in a workgroup environment and another user 
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invites you to a Meeting, Eudora Planner sends you a Meeting notification, and then 
automatically opens the Meeting Invitations dialog box so you can read details about 
the Meeting. You can then accept or decline the invitation.

Responding to Meeting Invitations
Once you’ve received a Meeting notification, you can open the Meeting Notices 
dialog box, which shows the title, date, and time of the Meeting, the name of the 
Meeting’s creator, and whether your attendance is required or optional. It is there 
that you accept or decline the Meeting invitation.

To respond to Meeting invitations:
1. From the View menu, select Meeting Invitations. 

The Meeting Invitations dialog box appears, containing a list of invitations to 
Meetings.

2. To respond to an invitation in the list, click to select it, then click the Attend or 
Decline button.

If you choose Attend, the meeting blocks time in your schedule. If you choose 
Decline, the meeting does not block time.

3. Once you’ve responded to all invitations, click OK. 

Your responses appear in each Meeting’s Details dialog box. The user who 
created a Meeting can open the Meeting Details dialog box to see whether 
you’ve accepted or declined the invitation.

Setting Your Availability for Meetings
Eudora Planner lets you define the times during the day that you’re available for 
other users’ meetings. A user who invites you to a meeting outside those times will 
find that you’re unavailable.

To set your availability for Meetings:
1. From the Define menu, select Meeting Availability.
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The Meeting Availability dialog box appears, displaying your name.

2. Select the check boxes for the days of the week that you are available.

As you select each day, default times appear in the From and To boxes for that 
day.

3. For each day of the week you’ve selected, enter into the From and To boxes 
the range of time that you’re available for that day. You can advance through 
these boxes by clicking the Tab key.

4. Select the Unavailable During Lunch box, if appropriate, and enter in your 
regular lunch time if different from the default of 12-1 PM.

5. Click OK.

Your availability settings are immediately saved by the public server. Other 
users who schedule you for meetings can see the times you are available.

If you change your availability while you are not connected to the Public Server, your 
changes won’t be visible to other users until the next time you connect.

Setting Calendar Preferences
The Calendar contains a number of preferences that let you change the appearance 
of your Calendar to accommodate your normal work schedule, set defaults for the 
creation of Events, and create custom priority labels to assign to To-Dos and Calls. 
To set your Calendar preferences, from the Tools menu, select Preferences. In the 

Check marks indicate 
days that you’re 
available

For each day of the week, you can enter the time range when 
you’re available

Use this option to 
designate a lunch hour
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Preferences dialog box, click Calendar to view the options for the Calendar.

Events Tab
The Events tab contains preferences related to the creation of new Events and for 
the general reminder feature.

New Meetings
For details about these preferences, see “Setting Defaults for New Meetings” on 
page 36.

Reminders
For details about these preferences, see “Setting Reminder Preferences” on page 
49.

Block Time by Default
Select the check boxes for the types of Event you want automatically set to block 
your time when you create them.

Miscellaneous
To have Eudora Planner open the Event Details dialog box each time you create an 
Event, select Show details for new Events. If this option is not selected, Eudora 
Planner show the new Event in the Calendar, but does not open the Details dialog 
box.

To receive a warning dialog box each time you delete an Event, select Alert when 
deleting Events; otherwise, Eudora Planner does not prompt you to confirm 
deletion of an Event.

Select Spring forward and fall back if you observer Daylight Savings Time.
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Priorities Tab
For details about the preferences on this tab, see “Tracking Priority and Completion 
of To-Dos and Calls” on page 41.

QuickDay Tab
For details about these preferences, see “Setting Preferences for QuickDay” on 
page 127.
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 3

Chapter 3

Using the Address Book
Eudora Planner’s Address Book lets you manage important information about the 
people and companies you interact with throughout the day. The individual records 
of people and organizations in the Address Book are called Contacts in Eudora 
Planner. Your Contacts store basic data such as names and addresses, and also 
provide a way to organize and access more dynamic information, including links to 
external documents and the Internet. You can track your interactions with these 
people and companies through links to the Eudora Planner Calendar.

In this chapter, you will learn how to add Contacts to your Address Book, as well as 
how to locate specific Contact information, track your telephone calls and e-mail, 
and find additional Contact information on the Internet.

Creating Contacts
Contacts are the people and organizations in your Address Book. A Contact’s 
information can include a name, company name, home and work addresses and 
telephone numbers, as well as a history of meetings, telephone calls, letters, and 
notes associated with the Contact.

To create a Contact:
1. From the Insert menu, select New Contact.
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The Contact Details dialog box appears.

2. Enter personal and company information into the Name, Company, 
Department, and Title fields. 

Press Tab to move to the next field or Shift+Tab to return to the previous field.

3. If you want the Contact to appear in the QuickContact menu, click the 
QuickContact checkbox.

4. Enter a home address, work address, or both. Select the type of address you 
want to enter by selecting either Work Address or Home Address from the 
pop-up menu above the address boxes.

5. To add telephone numbers, e-mail addresses, and URLs, select an item from 
one of the five connection field pop-up menus. In the box next to the field you’ve 
chosen, type a telephone number, URL, or e-mail address—whichever is 
appropriate.

If you need to store more than five telephone numbers or Internet addresses, 
you can create custom fields. See “Using Custom Fields” on page 30 for more 
information.

6. Click Save.

The Contact is recorded in the Address Book and appears in the List View. 

You might find that you often create Contacts that contain much of the same 
information as other Contacts in your Address Book, such as those you create for 
people who work for the same company. For Contacts like these, you can create 
templates that already contain common information, saving you from unnecessarily 
re-entering data. For details about creating Contacts based on custom templates, 
see “Using Contact Templates” on page 35.

These fields contain 
standard Contact 
information

Select to make this a 
Quick Contact

Indicates the last 
time this Contact 
was modified, and 
who by
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Adding Information to Contacts
Eudora Planner’s Address Book gives you the ability to track more information about 
your Contacts than just names, addresses, and phone numbers.

You can create custom fields to store important data that can’t be placed in standard 
fields such as Name, Company, and Address.

You can attach Calendar Events, other Contacts, and free-form notes to each 
Contact’s History list. The History list can also store aliases to other files or 
applications, as well as links to related documents, whether they reside on your 
computer, on your network, or on the Internet.

Using Custom Fields
You can create custom fields to hold information not included in the general Contact 
information fields.

When you create a custom field, you give it a unique name, then specify the type of 
data it can contain, such as a number, a date, or text. 

For example, you could create a custom field named Birthday to keep track of the 
birthdays of your friends and business associates. You would assign such a field a 
type of date, so it can contain only dates. You might also make a Birthday Card field, 
with a type of Yes/No, to indicate whether or not a particular Contact should receive 
a birthday card. 

Because a custom field is defined to contain a certain type of data, the information in 
that field is in a consistent format throughout your Address Book, assuring accuracy 
when you do searches and sorts based on that information. 

Creating Custom Fields
When you create a custom field, you can specify the type of information you want 
the field to contain. You can choose from ten field types:

Field Type Contains ...

Yes/No A simple yes or no option

Date and Time The date and time (timestamp)

Date and Time Range Starting and ending dates and times

Date Only A single date

E-mail An e-mail address

Number Any positive or negative number

Phone A telephone number

Text Plain text information

Time Only A single time

Web Page A URL
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Once you’ve assigned a field type, the custom field is formatted to contain only that 
kind of information.

To create a custom field:
1. From the Define menu, select Custom Fields.

The Custom Fields dialog box appears.

2. From the Server pop-up menu, select the server where you want the custom 
field to reside.

A default server is already selected for you. If you’re using Eudora Planner in a 
workgroup setting, you can select a workgroup server, thereby making the 
custom field available to other users connected to that server.

3. Click New.

The Custom Field dialog box appears.

4. Type a name for the field in the Name box. 

5. Select a field type. Your options are described in the table preceding this 
section.

6. Click OK to close the Custom Field dialog box. Then, click Done in the Custom 
Fields dialog box.

The custom field appears in the Detail View of any Contact residing on the 
server you selected. You can enter data into this field as you would into any 
standard field. If you saved the custom field on a workgroup server, it becomes 
available to other users connected to the server.

Changing Custom Field Names
Once you’ve created a custom field, you can change its name at any time. This in no 
way affects the data contained in that field.

Click this pop-up menu 
to select a server

Available custom fields 
are listed here

Create a new custom field by clicking here

Click to modify a selected custom field
Click to delete a selected custom field

Custom field name appears here

Pop-up menu indicates custom field type
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To change the name of a custom field:
1. From the Define menu, select Custom Fields.

The Custom Fields dialog box appears.

2. In the list of custom fields, click the name of the field you want to change.

The custom field name becomes highlighted.

3. Click Edit.

The Custom Field dialog box appears.

4. Type the new name into the Name box.

5. Click OK to close the Custom Field dialog box, then click Done to close the 
Custom Fields dialog box. 

The custom field name is changed for all associated Contacts in your Address 
Book.

You can change the name of a custom field, but not its field type. 

Deleting Custom Fields
You can reduce the size of your database or eliminate redundant data by deleting 
custom fields that you no longer need. 

To delete a custom field:
1. From the Define menu, select Custom Fields.

2. In the list of Custom Fields, select the name of the field you want to delete.

3. Click Delete.

4. When you are prompted to confirm deletion of the custom field, click OK.

The custom field is removed from the Custom Fields area of any Contacts in 
your Address Book. All data in that field is deleted as well.

Using the General Comments Area
The General Comments area provides a place to type notes or comments about a 
Contact. Once you’ve typed information into this area, you can let it remain here, 
delete it, or save it as a titled, dated note that becomes part of the Contact’s History. 
For information about notes, see “Attaching Notes to Contacts” on page 73.

To enter notes into the General Comments area:
1. Double-click the Contact for which you want to enter the note.

The Contact Details dialog box appears.
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2. Click the triangle to open the General Comments section, if necessary.

3. Type your comments.

The comments remain in the General Comments area until you delete them or 
save them as a note, as described in the following section. 

To save a comment as a note:
1. In the Contact Details dialog box, open the General Comments section by 

clicking the triangle, if necessary.

2. Click Save as Note. 

The Note Details dialog box appears, displaying the information you typed into 
the General Comments section.

3. In the Title box, type a title for the note.

4. Click Save.

The note containing your comments appears in the Contact’s History. You can 
double-click the note to read, add to, or edit the comments.

To clear the General Comments area:
1. In the Contact Details dialog box, open the General Comments section by 

clicking the triangle, if necessary.

The General Comments area appears.

2. Click the Clear Comments button.

A warning dialog box appears stating that the action cannot be undone.

3. Click Yes.

The comments are deleted from the General Comments area.

Title for the note goes here

Text from the General Comments area appears 
here
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Using the Contact History to Track Events and Notes
In addition to containing personal and business information, your Contacts can also 
contain links to attached Calendar Events and notes. These attachments appear in 
the Contact’s History, where you can view them by double-clicking them.

Use the Contact History to keep a log of all Events and notes related to a particular 
Contact. The History shows the title of an attached Event or note and, where 
applicable, the priority, start date, start time, and completion status. To show or hide 
a particular type of item in the History, select or clear the appropriate Display check 
box.

Attaching New Events to a Contact
When you schedule an Event related to a Contact, you can attach the two items to 
each other to show their relationship. The Events that you attach to a Contact 
appear in that Contact’s History, where you can open Events by double-clicking 
them.

Existing Events must be attached to Contacts from within the Event itself. For 
information, see “Adding Contacts to Events” on page 24.

To attach a new Event to a Contact:
1. If the Contact is not already opened, double-click it in the Address Book.

The Contact Details dialog box appears.

2. Click either the Attach New Meeting, Attach New Call, or Attach New To-Do 
button in the Contact Details dialog box.

The Event Details dialog box for the Event type you selected appears. 

3. Enter information for the Event. For details about entering information into the 
Event Details dialog box, see “Adding Events to the Calendar” on page 16.

4. Click OK.

The Event is saved to the Calendar and its name appears in the Contact’s 
History.

Attaching Notes to Contacts
Eudora Planner lets you attach notes to your Contacts. A note might contain any 
information that you cannot fit into the standard or custom fields, such as personal 
memo about a Contact or a record of a meeting with that Contact. Attached notes 
appear in a Contact’s History, where you can double-click them to review, modify, or 
copy their contents.

To attach a note to a Contact:
1. Double-click the Contact to which you want to add the note.

The Contact Details dialog box appears.
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2. Click the Attach New Note button in the button bar.

The Note Detail dialog box appears.

3. In the Title box, type a title for the note.

4. Type your comments into the note.

5. Click Save.

The title of the note appears in the Contact’s History, displaying the date and 
time you created it. To view or edit the note, double-click it in the History list.

Deleting Items from the Contact History
To reduce clutter and decrease the size of your Eudora Planner database, you can 
delete items that you no longer need from the Contact History.

To delete an Event or note from a Contact’s History:
1. Double-click the Contact to open its Details dialog box.

2. Open the History section.

3. Select the item you want to delete, then press the Delete key.

The item is removed from the Contact’s History list. If you’ve selected an Event, 
it is deleted from the History, but not from the Calendar.

You can remove an Event or note from a Contact by control-clicking it in the History 
list, then selecting Delete from the contextual menu that appears.

Attaching Files to a Contact
You can keep a running log of letters, memos, and reports related to a Contact by 
attaching files to it. The attached files appear in the Contact’s Attachments area, 
where you can double-click them to open them in their creator applications.

You can attach either the actual file or an alias to the file. Both methods have 
advantages and disadvantages, so you should select one according to your usage 
patterns and preferences.

When you attach a file to a Contact, the actual file is copied into your Eudora 
Planner database. This serves to increase the size of the database, but guarantees 
that the document will always be available to you. When you attach a file alias, only 
the small alias is copied into your database. This holds the databases’s size to a 
minimum; however, should you ever delete the original document or move your 
Eudora Planner database to another machine, the document will be unavailable 
from within the Contact.

To attach a file or file alias to a Contact:
1. Double-click the Contact to which you want to attach the document.

The Contact Details dialog box appears.

2. From the Tools menu, select Attach. Then, from the submenu that appears, 
select either File or Alias.
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The Open dialog box appears, which you can use to find the document you wish 
to attach.

3. Click OK.

The file or an alias to the file is attached to the Contact. The document’s name 
appears in the Contact’s Attachments area (the Type column indicates whether 
its is a file or alias). You can open the file in its creator application by double-
clicking it.

Attaching Another Contact to a Contact
You can attach Contacts to each other to show a relationship more specific than that 
demonstrated by category affiliation, such as the relationship between a manager 
and an assistant, or that between business partners. 

To attach a another Contact to a Contact:
1. Double-click the Contact to which you want to attach another Contact.

The Contact Details dialog box appears.

2. Click the Attach Contacts button in the button bar.

The Attach Contacts dialog box appears.

3. From the pop-up menu, select Found Contacts, All Contacts, or Quick 
Contacts. 

• The Found Contacts option lets you search your Address Book for a specific 
Contact.

• The All Contacts option displays every Contact in your Address Book.

• The Quick Contacts option displays only those Contacts you’ve designated 
as Quick Contacts.

Attach a Contact by selecting 
its check box

Displays the names of your Contacts and other Eudora 
Planner users on the network

Your selection determines 
which Contacts are displayed 
in the list below

If you choose the ‘Found Contacts’ option in the ‘Show’ 
menu, enter the name of the Contact you want to find
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4. If you selected either the All Contacts or Quick Contacts options, go to step 5. If 
you selected Found Contacts, type a Contact’s name into the Find box. 

As you type, Eudora Planner searches your Address Book for Contact names 
that match the text you’re entering. Matching names appear in the Matching 
Contacts area.

5. In the Matching Contacts area, select the check boxes of any Contacts that you 
want to attach, then click Done.

The selected Contacts appear in the opened Contact’s Attachments area.

6. Click Save.

The Contacts you selected are attached to the opened Contact and appear in 
the opened Contact’s Attachments area. To view details for an attached 
Contact, double-click it.

Deleting Items from the Attachments Area
You can delete any files, file aliases, and Contacts that you no longer need to 
appear in a Contact’s Attachments area.

To delete an item from the Attachments area:
1. Double-click the Contact containing the attached document, document alias, or 

Contact you want to delete.

The Contact Details dialog box appears.

2. Click the triangle to open the Attachments area, if necessary. 

3. Select the item you want to delete, then press the Delete key.

The selected item is deleted from the Attachment list, but the original item is not 
affected.

You can delete an attached document by control-clicking that document in the 
History list, then selecting Delete from the contextual menu that appears.

Selecting Primary Fields
Your Address Book probably contains Contact records for a wide variety of people 
you interact with, such as your co-workers, friends, and relatives. For some of these 
people, like your business associates, the most vital Contact information is that 
which is work-related, such as company addresses and work phone numbers. For 
your friends and relatives, however, personal data, such as home address and 
phone number, is more important. Because the most important information varies 
for different types of Contacts, Eudora Planner lets you select primary fields for each 
individual Contact.

For each specific Contact, you can select a primary listing (either Name or 
Company), a primary phone number (Work, Home, Fax, or Mobile), and a primary 
address (Work or Home). When you’ve selected a field as primary, you can display, 
print, and sort based on the information contained in that field. For example, you can 
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configure a List View that displays the primary address for each Contact, whether it 
be the Work or Home address.

Primary fields function in the following areas:

• The listing and phone fields you select as primary determine what information 
appears in the name and number listing at the top of the Contact Details dialog 
box.

• The address you select as primary determines which address appears when 
you open the Details for a particular Contact.

• Three columns that can be displayed in the List View are affected by your 
primary field settings. The information that appears in the Listing Header 
depends on whether you select Name or Company as primary; the Primary 
Address field displays the address you select; and the Primary Phone field 
displays the telephone number you select.

• The phone field you select as the primary determines which phone number 
appears for a Contact displayed in QuickContact menu.

You can select primary fields by clicking field names in the Contact Details dialog 
box. The names of the primary fields appear underlined.

To select primary listing and address fields:
1. Double-click the Contact for which you want to select primary fields.

The Contact Details dialog box appears.

2. Click the title of the Listing field you want to select (either Name or Company).

The field you select is underlined, indicating that it is now the primary one. Also, 
the heading near the top of the Contact Details dialog box changes to reflect 
your selection.

3. In the Address area, select either Work or Home, depending on which address 
field you intend to make primary.

4. Click Street.

The field name becomes underlined, indicating it is the primary field.

5. Click Save.

Primary 
Listing 
appears here

Underline 
indicates 
that this is 
the primary 
field
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The fields you’ve selected become the primary fields for this particular Contact.

To select a primary connection field:
1. Double-click the Contact for which you want to select the primary connection 

field.

The Contact Details dialog box appears.

2. Click the pop-up menu next to the uppermost connection field.

A list containing each type of connection field appears.

3. From the pop-up menu, select the connection field you want to designate as 
primary.

4. Click Save.

The phone number you’ve selected to appear in the uppermost connection field 
appears in the Contact heading, indicating that it is the primary field.

If the uppermost connection field is empty, then the highest connection field 
containing data becomes the primary.

Assigning Categories to Contacts
You can organize and show relationships between Contacts by assigning them to 
Categories. To learn more about organizing Contacts with Categories, see 
“Assigning Categories to Events and Contacts” on page 101.

Using Contact Templates
You may find that you often create Contacts that contain much of the same 
information and attachments as existing Contacts in your Address Book, such as 
those for different people who work for the same company. You can avoid having to 
re-enter and attach the same information every time you add a new Contact by 
creating Contacts based on Contact templates. 

A Contact template is simply a Contact Details dialog box that you configure to 
contain certain information, which then becomes the basis for new Contacts. A 
template can contain any field information, categories, and attached documents, 
notes and Events that you specify. Each time you create a Contact based on that 

Uppermost 
connection field is 
the primary field

Primary connection 
appears is the 
Contact heading
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template, Eudora Planner automatically inserts all the specified information into the 
new Contact, which you can then modify as needed.

Creating a Contact Template
You can create a variety of Contact templates to suit your needs. After you create a 
Contact template, Eudora Planner makes it accessible from the Insert menu.

To create a Contact template: 
1. From the Insert menu, select Contact from Template, then select Edit 

Templates from the submenu that appears.

The Templates dialog box appears, displaying the Contact Templates option in 
the pop-up menu.

2. Click New.

The New Template dialog box appears.

3. Enter a name for the template, then click OK.

The Contact Template Details dialog box appears.

4. Enter information into the template, just as you would into a Contact. You can 
also add notes and attach documents and Events.

For more information how to enter information into a Contact, see “Creating 
Contacts” on page 29.

5. Click Save.

The template is saved and appears in a submenu whenever you select the 
Contact from Template command from the Insert menu.

Creating a Contact from a Template
When you create a Contact based on a template, the Contactcontains all the field 
and attachment information you’ve specified for that template, including primary field 
settings. You can then add or modify information as needed.

To create a Contact based on a template:
1. From the Insert menu, select Contact from Template, then select a template 
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name from the submenu that appears.

The Contact Details dialog box appears. The new Contact contains all the 
information and attachments that you entered into the template.

2. Add new information to the Contact or modify the information from the template, 
if necessary.

3. Click Save.

The new Contact appears in your Address Book.

Finding Contacts
Eudora Planner’s find features let you use a variety of criteria to search for Contact 
information in your Address Book.

The QuickFind feature searches your Address Book for field data that you specify, 
then generates a list of Contacts containing that data. You can search all fields in 
your Address Book at once—including all custom fields—or narrow the search by 
having Eudora Planner search only selected fields.

The Find Categories feature generates a list of Contacts assigned a specific 
Category or group of Categories. The QuickFind button lets you do a one-click 
search for the Contacts associated with a single Category.

The following sections describe Eudora Planner’s search features.

Using the Find Feature
The Find feature is most useful when you want to locate a single Contact that 
appears somewhere in the active tab of the Address Book. To search using this 
method, enter the keyword you want to search for, then initiate the search operation. 
Eudora Planner looks for the keyword in the fields that appear as columns in the 
current tab, then advances you to the first Contact containing the word.

The Find feature searches only those fields displayed as columns in the current 
Address Book tab. You can widen the search parameters by adding columns to the 
tab.

To use the Find feature to find a Contact:
1. From the Edit menu, select Find.

The Find Item dialog box appears.

2. In the Find box, enter a keyword to search for. 

This keyword can be a partial word. Eudora Planner will search for an instance 
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of the keyword in any Address Book field displayed in the active tab.

3. Click Find.

4. Eudora Planner advances to the first Contact in the foremost tab that contains 
the keyword, then highlights the field column where the keyword appears.

5. To find another Contact containing the keyword, from the Edit menu, select 
Find Next.

Using the Find All Feature
The Find All feature lets you set the search criteria before you initiate a search. You 
can type a name or keyword, select whether to search all Address Book tabs or just 
the active tab, then select exactly which Contact fields to look in. This search 
method is best for finding multiple Contacts, since Eudora Planner returns a list of all 
Contacts that match your criteria.

To use the Find All feature to find Contacts:
1. From the Edit menu, select Find All.

The Find Contacts dialog box appears.

2. In the Find box, enter a keyword to search for.

3. Select a Search option.

Select Current Tab to search only the active tab. Select All Tabs to search 
every tab in your Address Book. 

To start the search, go to step 7. To change the search criteria before starting 
the search, go to step 4.

4. Click the triangle at the bottom left corner of the dialog box. 

Enter a search keyword

You can choose to search 
just the current tab or all 
Address Book tabs
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The Find Contacts dialog box expands to show more options.

5. In the Fields to Search area, select the fields to be included in the search.

6. Select one of the following Comparison options:

• Select Contains to search for Contacts with fields that contain the data you’ve 
entered into the Find box. For example, if you do a search for all Contacts 
containing the name “Rob,” Eudora Planner will turn up records with the 
names “Robert” and “Robin,” as well as those containing “Rob.”

• Select Equals to search for Contacts with fields having contents exactly 
matching the data you’ve entered into the Find box. So, if you do a search for 
Contacts with the name “Rob,” Eudora Planner will only find those with exactly 
that name.

• Select Starts with to search for Contacts that have fields with a data string 
that starts with the text or number string you’ve entered into the Find box.

7. Click Find.

The Find Results tab appears, listing all Contacts matching your search criteria. 
See “Saving Your Find Results” on page 83 for information on how to save the 
search results.

Finding Contacts by Category
The QuickFind feature lets you perform a search based on category. You can use 
this feature to find all the Contacts associated with one or more Address Book 
categories.

To find Contacts by category:
1. From the Edit menu, select Quick Find.

Clicking here expands 
the dialog box to show 
more options

You can select which 
Contact fields to search

Choose from among 
these search methods
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The Find Contacts with Categories dialog box appears.

Clicking the Quick Find button on the toolbar returns search results for 
just one category. To search for multiple categories, you must initiate the 
search from the Edit menu.

2. In the Categories list, select the check box next to each category that you want 
to find.

When you search with this method, Eudora Planner looks for Contacts 
assigned any one of the categories you select here. A Contact need not 
be assigned each selected category to be found during this search.

3. Click Find.

The Find Results tab appears, containing Contacts in the categories you chose 
to search. See “Saving Your Find Results” for information on how to save your 
search results.

You can use QuickFind to search for any Contacts that you’ve added to 
QuickContact, which enables you to quickly scan your Quick Contacts to remove 
obsolete names and organizations.

Saving Your Find Results
To keep the results of a search for future reference, save the Find Results tab as a 
new tab.

To save the Find Results tab as a new tab:
1. Click the icon next to the tab’s name.

Select a category to find 
Contacts assigned that 
category
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The Save Results as a Tab dialog box appears.

2. Enter a name for the tab in the Name box.

3. Click New Category to use the Category dialog box to create a new category 
(for details about creating a category, see “Creating Categories” on page 100). 
Once you’ve created the category, click Done to return to the Save Results as a 
Tab dialog box. 

The category you create here is the one to be assigned to all the Events 
appearing in the Find Results tab. You should give this category a name 
that indicates why you searched for these Events.

4. Select the check boxes of the categories you want to assign to the Contacts in 
this tab.

Because tabs are based on groupings of categories, you must assign at 
least one common category to the Events in your search results in order 
for those Events to appear together in a tab.

5. Click the Assign category to any new Contacts created in this tab pop-up 
menu to select the default primary category for Events you create in this tab.

6. Click the Tab Color pop-up menu to select a background color for this tab.

7. Click OK. 

The new tab appears in your Address Book, showing any items associated with 
the categories you selected in step 4. You can modify this tab as you would any 
other Address Book tab.

Finding, Viewing, and Deleting Duplicate Contacts
You can eliminate redundant entries in your Address Book and reduce the size of 
your Eudora Planner database by finding and deleting duplicate Contacts. 

To find, view, and delete duplicate Contacts:
1. From the Define menu, select Show Duplicates.

Enter a name for the 
tab here You can click here to create a new category to be 

assigned to these Contacts
Check mark indicates 
a category you’ve 
assigned to the found 
Contacts

Dash indicates that 
the category appears 
in at least one found 
Contact

The category you select here becomes the default 
primary category for any Contacts you create on this tab
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The Find Duplicate Contacts dialog box appears.

2. Select a Search option.

Select Current Tab to search only the active tab. Select All Tabs to search 
every tab in your Address Book.

3. In the Fields to Match area, select the fields to be searched for duplicate 
information. 

For Contacts to be considered duplicates of each other, there must be matching 
information in each of the selected fields.

4. Click Find.

A tab entitled Find Results appears, displaying all the Contacts meeting your 
duplicate criteria. You can double-click a Contact to view its details.

5. To delete a duplicate Contact, select it, then press the Delete key.

The Contact is deleted from your Address Book.

Dialing Contacts
Eudora Planner’s dialing function streamlines communication with your Contacts by 
allowing you to telephone them directly from your computer. When you use the 
dialing function to call a Contact, a Call Event is automatically logged into the 
Contact’s History and saved in your Calendar. 

You can choose between two dialing methods: modem and speaker. To use modem 
dialing, your computer must be connected to a telephone through a modem. When 
you initiate a call, Eudora Planner addresses the modem, which in turn dials the 
phone number. When the other party answers, you can pick up the handset of your 
phone and begin speaking.

To use speaker dialing, hold the mouthpiece of your telephone as close as possible 
to your Macintosh’s speaker when you initiate dialing. In some cases, you may have 
to raise your system’s sound to make the phone respond. As long as your outgoing 
line supports touch-tone dialing, your call will go through. Once dialing is complete, 
you can wait for the party to answer.

Eudora Planner will search 
for Contacts that contain the 
same information in the 
fields you select here

Click the triangle to expand 
the dialog box, if necessary
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Setting the Dialing Preferences
Your dialing needs may vary according to your location or that of the person you are 
calling. For example, at work you may need to dial “9” to get an outside dial tone. 
When making long distance calls, you might need to enter a calling card number or 
disable call waiting before dialing the phone number. The dialing preferences let you 
set up multiple configurations to accommodate all the situations you encounter 
when dialing.

To set up the dialing preferences:
1. From the Define menu, select Preferences.

The Preferences dialog box appears.

2. Click the Address button to display the Address Book preferences, then select 
the Dialing tab to display the dialing preferences.

3. From the Dial via pop-up menu, select a dialing method.

You may have to set additional preferences specific to either modem or 
speaker dialing. For more details, see “Configuring Modem Dialing” on 
page 87.

4. In the Local area code box, enter your area code. Select the Omit local area 
code option to have Eudora Planner omit the area code when dialing local 
phone numbers.

5. Select the appropriate options from the Dial Tone, Prefix, and Suffix pop-up 
menus.

6. In the When dialing field, enter the word or abbreviation you use to indicate a 
phone extension in a Contact’s Phone field (for example, you might use ext., as 
in “(503) 555-1234 ext. 567”). Then, in the replace with field, enter how many 
commas the word or abbreviation should represent to your dialing device (for 
modems a comma indicates an interval of time—usually one second). By 
making these settings, you allow your dialing device sufficient time to pause 
before dialing an extension.

7. Click OK.

Pop-up menu indicates 
the dialing method

Click to set preferences specific 
to modem or speaker dialing

Area code is omitted 
from local calls when 
selected

These settings determine the 
dialing sequences executed 
during each call

These options let you 
create dialing sequences
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The dialing feature is configured to dial in the way you’ve specified.

Configuring Modem Dialing
Eudora Planner’s dialing function supports any Macintosh-compatible modem that 
responds to industry standard modem commands. Because of variations between 
different makes and models, you may need to adjust Eudora Planner’s modem 
dialing preferences to accommodate your modem. You can do this by selecting 
Modem from the Dial via pop-up menu on the Dialing preferences tab, then clicking 
Expert Setup, which opens the Modem Dialing Setup dialog box.

The settings in this dialog box determine how Eudora Planner interacts with your 
modem. The following table describes the options available here.

Consult your modem’s user’s manual for specific for details about your modem and 
modem commands before changing any settings in the Modem Dialing Setup dialog 
box.

Use this setting... To...

Port Indicate which Macintosh serial port your modem is connected to.

Baud Rate Indicate the speed of your modem.

Data bits Eudora Planner’s default settings should suffice for most 
modems. Consult you modem’s user’s manual before changing 
this setting.

Stop bits Eudora Planner’s default settings should suffice for most 
modems. Consult you modem’s user’s manual before changing 
this setting.

Parity Eudora Planner’s default settings should suffice for most 
modems. Consult you modem’s user’s manual before changing 
this setting.

Initialization Determine how Eudora Planner addresses your modem for 
dialing

Hangup string Determine how your modem releases the telephone line when 
you cancel a dialing operation.

Dial prefix Determine how Eudora Planner prepares the telephone for 
dialing; a “T” at the end of the prefix indicates touch-tone dialing, 
while a “P” indicates pulse dialing.
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Configuring Speaker Dialing
The speaker dialing function lets you dial a telephone using your Macintosh’s 
speaker. To use this feature, you may need to change some settings specific to 
speaker dialing. You can access these settings by selecting Speaker from the Dial 
via pop-up menu on the Dialing preferences tab, then click Expert Setup. This 
opens the Speaker Dialing Setup dialog box.

The following chart describes the options available in the Speaker Dialing Setup 
dialog box.

Dialing a Contact
Once you’ve configured the dialing preferences, you are ready to dial to Contacts 
using your selected dialing device. 

To dial a Contact by modem:
1. In the Contact Details dialog box or in the Address Book List View, click the 

phone icon next to the phone number you want to dial.

The Call Details dialog box appears, containing the name and phone number of 
the Contact you are calling.

Dial suffix Determines how your modem behaves during a call. A semicolon 
suffix keeps the modem in command mode, so that it can release 
the telephone line if the call doesn’t go through.

Use this option... To...

Tone Duration Determine the length of the dialing tones played through your 
Macintosh speaker, in 60ths of a second. If you have problems 
connecting when dialing through your speaker, try increasing this 
setting.

Pause between 
tones

Determine the length of silence between each dialing tone, in 
60ths of a second. If you have problems connecting when dialing 
through your speaker, try increasing this setting.

Comma duration Set the length of silence each comma represents when you use 
commas in dialing strings.

Volume Change the speaker volume of your dialing tones.

Use this setting... To...
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2. Click the Dial Phone button.

Eudora Planner dials the phone number.

3. When the other party answers, pick up your phone’s handset.

4. If necessary, you can change the title of the Call in the Title field, and type 
notes in the Description area. 

5. Click Save to close the Call.

The Call is saved by Eudora Planner, and appears in both in the Calendar and 
the Contact’s History.

To dial a Contact by speaker:
1. In the Contact Details dialog box or in the Address Book List View, click the 

phone icon next to the phone number you want to dial.

The Call Details dialog box appears, containing the name and phone number of 
the Contact you are calling.

2. Pick up the phone’s handset and hold phone as close as possible to your 
Macintosh’s speaker.

3. Click the Dial Phone button.

Eudora Planner dials the phone number.

4. If necessary, you can change the title of the Call in the Title field, and type 
notes in the Description area. 

5. Click Save to close the Call.

The Call is saved by Eudora Planner, and appears in both in the Calendar and 
the Contact’s History.

Using the Internet Features
Eudora Planner integrates with your e-mail and browser applications to give you 
greater access to the people and organizations in your Address Book.

Selecting Your Preferred E-mailer and Browser
Before you can use Eudora Planner’s Internet features, you must specify your 
preferred e-mail and browser applications in Eudora Planner’s General preferences. 
Eudora Planner directly supports many popular e-mailers and browsers, and 
indirectly supports any application compatible with Internet Config, a Macintosh 
utility described in “Setting Preferences for Internet Config” on page 92.

To choose your preferred e-mail and browser applications:
1. From the Define menu, select Preferences.

The Preferences dialog box appears.
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2. Click General to display Eudora Planner’s general preferences.

3. In the Internet Setup area, click the Mailer pop-up menu, then select an e-mail 
application from the list. Likewise, click the Browser pop-up menu to select a 
browser.

If you selected Internet Config for either of these, see “Setting Preferences for 
Internet Config” on page 92.

4. To have a note automatically logged into a Contact’s History each time you 
send an e-mail, select Log email note to Contacts. If you are connected to a 
server, then select either Public or Private to determine whether these notes 
are shared with other users connected to that server.

5. Click OK.

Eudora Planner is set to open the selected e-mail application when you click an 
e-mail button.

Sending E-mail to Contacts
Eudora Planner’s e-mail function lets you use your preferred e-mail application to 
send pre-addressed messages to your Contacts. To use this function, you need to 
set Eudora Planner to recognize your e-mailer. When you click an e-mail button in a 
Contact’s record, Eudora Planner launches your e-mailer, which in turn opens a new 
message that already contains the Contact’s name and e-mail address in the 
message header. You can then type the body of the message and send it to the 
intended recipient. A note indicating the date and time of the message is logged in 
the Contact’s History section.

To send an e-mail message to a Contact:
1. Double-click the Contact to whom you want to send the e-mail message.

The Contact Details dialog box appears.

2. Locate the appropriate e-mail address in either a connection field or custom 
field, then click the envelope button next to that address.

Your e-mail application opens, displaying a new message already addressed to 
the Contact.
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3. Type the body of your message, then send it as you would any other message.

If you’ve selected the Log e-mail note to Contacts option in the General 
preferences, a note containing the date and time of the message is logged into 
the Contact’s History section. The full message is also logged into your e-mail 
program’s “outbox” or “sent mail” list, if the program contains such a feature.

Opening Web Sites from within Contacts
A Contact’s URL field is formatted to provide you a live link to the Web address 
contained in that field. When you click in the field, your preferred browser 
automatically launches and opens the Web page.

To open a Web site from within a Contact:
1. Double-click the Contact for which you want to view the attached Web site.

The Contact Details dialog box appears.

2. Locate the Web site address in either a connection field or a custom field, then 
click the globe icon located next to the field.

Eudora Planner launches your preferred Web browser, which searches for, then 
loads, the Web page.

Using QuickNet
Eudora Planner’s QuickNet feature uses the search capabilities of the World Wide 
Web to help you locate information about your Contacts. QuickNet can help you find 
a Contact’s 9-digit Zip Code, e-mail address, and white pages listing—even a map to 
his or her street address. When you select a QuickNet option, Eudora Planner 
launches your Web browser and initiates a search based on existing data in a 
Contact’s record.

To use QuickNet:
1. Select a Contact in the Address Book List View.

2. From the Tools menu, select QuickNet. Then, from the resulting submenu, 
choose one of the following options to find information about the selected 
Contact:

• Select Find E-mail to find an e-mail address for the Contact.

• Select Find Phone Number to find a phone number for the Contact.

• Select Find Zip+4 to find a nine digit zip code for the Contact.

• Select Get Street Map to get a map to the Contact’s primary address.

Eudora Planner launches your Web browser, which loads an Infoseek Web 
page displaying the information you searched for.

3. If necessary, enter the found information into the Contact record.
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Setting Preferences for Internet Config
Internet Config is a Macintosh utility that allows Internet-enabled applications, such 
as Eudora Planner, to integrate with Internet-based applications, such as an e-
mailer or browser. This section explains how to set Internet Config’s preferences so 
that Eudora Planner recognizes your preferred e-mail or browser application.

1. From the Define menu, select Preferences to open the Preferences dialog box. 
Then, select General.

2. To use Internet Config to point to a Web browser or e-mail program, click either 
the Browser or Mailer pop-up menu, then select Internet Config from the 
resulting list.

3. Click Open Internet Config to open the Internet Preferences dialog box. Then, 
click Helpers.

The Helpers dialog box appears.

4. To choose your preferred Web browser, select the http option. To choose your 
preferred e-mail program, select the mailto option. Once you’ve made your 
selection, click Change.

The Add Helper dialog box appears.

5. Click Choose Helper. In the resulting Open dialog box, navigate to find the 
browser or e-mailer, select it, then click Open.

The name of the selected browser or e-mailer appears in the Helper area of the 
Add Helper dialog box.

6. Click OK to close the Add Helper dialog box. Then, click Add to close the 
Helpers dialog box.

7. From the File menu, select Quit.

Eudora Planner is configured to recognize your Internet Config selection as the 
preferred browser or e-mailer.

Using Mail Merge
Eudora Planner’s Mail Merge feature lets you merge Address Book data with 
existing merge templates or document files created in Microsoft Word or 
WordPerfect. You can merge your Contact data into a new word processing 
document or a printout. The data can also be merged into a document automatically 
attached to an e-mail messagein your preferred e-mail program. Eudora Planner 
automates most of the merge process, so once you’ve created and saved a merge 
document, you need only to select the Contacts you want to merge and choose a 
merge destination. 

Mail Merge supports Word versions 5.x and 6 and WordPerfect version 3.5.x. The 
mail merge command and toolbar buttons are available only if you have one of these 
applications installed.
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Before you can use the Mail Merge feature, you must create a template document 
with which to merge, as described in the next section. To use the Mail Merge feature 
with the document you’ve created, see “Merging Contact Data with a Merge 
Template” on page 95.

Creating a Merge Template
To use the mail merge feature, you must create a template document that accepts 
merge data from your Address Book. How you do this depends on the word 
processor you are using.

To create a Word 6 merge template for use with Eudora Planner:
1. In Word, create or open the document you want to use as a merge template. If 

you’re creating a new document, type in its entire text and save it before 
proceeding to step 2.

2. Select Mail Merge from Word’s Tools menu and, in the Mail Merge Helper 
dialog box that appears, click the Create button and select the type of 
document you want to create.

Word displays another dialog box.

3. Click the Active Window button to specify that the open document will be used 
to make your template. 

4. Click the Get Data button on the Mail Merge Helper dialog box, then select 
Open Data Source from the list that appears.

A directory dialog box appears.

5. In the directory dialog box, select All Files from the List Files of Type drop-
down menu. Navigate to Eudora Planner Folder:EP Support:QuickMerge 
Templates:Word 6, then select and open the Field Names document.

6. Click the Edit button under Main Document in the Mail Merge Helper dialog 
box.

The Mail Merge Helper dialog box disappears, allowing you to edit the merge 
template document.

7. Insert merge fields into the template by placing the cursor where you want a 
field to be, clicking the Insert Merge Field button on the Mail Merge toolbar, 
and dragging in the drop-down list that appears to select a merge field. When 
you’ve inserted all the merge fields you need, save the document. 

Your document is ready to be used as a mail merge template with Eudora 
Planner, as described in “Merging Contact Data with a Merge Template” on 
page 95.

To create a Word 5.x merge template for use with Eudora Planner:
1. Create or open the Word document you want to use as a mail merge template. 

If you’re creating a new document, type in its entire text and then save it before 
proceeding to step 2.
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2. From Word’s View menu, select Print Merge Helper.

Word displays a directory dialog box.

3. In the directory dialog box, navigate to Eudora Planner Folder:EP 
Support:QuickMerge Templates:Word 5. Then, select and open the Field 
Names document.

Word adds a data field to the top of the open document, and the Print Merge 
toolbar appears in the document window.

4. Delete the data field that Word added to the top of the document.

5. Insert merge fields into your document by placing the cursor where you want a 
field to be, clicking the Insert Field Name pop-up menu on the Print Merge 
toolbar, and dragging in the drop-down list it displays to select the Contact field 
you want to appear in that location. When you’ve inserted all the merge fields 
you need, save the document.

Your document is ready to be used as a merge template with Eudora Planner, 
as described in “Merging Contact Data with a Merge Template” on page 95.

To create a WordPerfect 3.5.x merge template for use with Eudora Planner:
1. Create or open the WordPerfect document you want to use as a mail merge 

template. If you’re creating a new document, type in its entire text, then save it 
before proceeding to step 2.

2. Click the Merge button at the top of the document window to display the Merge 
bar.

3. Click the Field button on the Merge bar.

WordPerfect displays the Merge Field Number dialog box.

4. Select the Field Name option, then click Get Field Names.

The Open Data directory dialog box appears.

5. Navigate to Eudora Planner Folder:EP Support:QuickMerge 
Templates:WordPerfect. Select and open the Field Names document, then click 
Names.

The Merge Field Number dialog box reappears with the first field name, 
FirstName, in the box next to the Field Name option. You can click the button 
next to this box and drag to change the field name selected.

6. Click OK.

7. Insert merge fields in your document by placing the cursor where you want a 
field to be, click the Field button on the Merge bar, and in the resulting Merge 
Field Number dialog box, selecting a merge field from the list next to the Field 
Name option, then clicking OK. When you’ve inserted all the merge fields you 
need, save the document.

Your document is ready to be used as a mail merge template with Eudora 
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Planner, as described in the following section.

Merging Contact Data with a Merge Template
Once you’ve created a merge template, you can use it to merge your Address Book 
data to a selected destination.

To merge Contact data with a merge template:
1. In the List View, select the Contacts you want to merge with the merge 

template. If you intend to merge all those appearing in the List View, you don’t 
need to select any Contacts.

2. From the Tools menu, select Mail Merge.

A directory dialog box appears.

3. From the Merge Using pop-up menu, select the type of word processor your 
are using.

4. Select the merge template you want to use for the merge, then click Open.

Another directory dialog box appears.

5. Click Save to save the data source document. This document contains the 
Contact data to be merged with your merge template document.

Eudora Planner launches the word processor program and merges the 
template and data source documents. Your word processor displays the results 
in a document window.

If you are using Microsoft Word version 5, Eudora Planner launches Word 
5 with the merge template document opened. You must perform a few 
additional steps to specify how Word should complete the merge. 
Continue with step 6.

6. From Word’s View menu, select Print Merge Helper.

7. Select the data source document you saved in step 5, then click Open.

Word 5 displays the data source document and merge template document in 
separate windows.

8. Click the Merge into New Document icon on the Print Merge toolbar.

Word displays the results of the merge in a new document window.

Editing Contacts in the List View
You can modify or add to Contact information when it is displayed in the List View. 
Click to select the Contact field you want to modify, then directly type new 
information in the field. Eudora Planner saves your changes to the database when 
you click outside the field.

Duplicating Contacts
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If you need to create a new Contact for someone whose personal information is 
nearly identical to that of an existing Contact in your Address Book, you can 
duplicate the existing Contact, then make the necessary changes to the duplicate. 

To duplicate a Contact, select it in the List View, and then choose Duplicate 
Contact from the Edit menu. The duplicate Contact appears in the List View directly 
beneath the original.

Deleting Contacts
To delete a Contact, select it in the List View, then select Delete Contact from the 
Edit menu. If you’re using Eudora Planner in a workgroup setting, you cannot delete 
public Contacts for which you don’t have delete permission.

Sorting Contacts in the List View
Each column in the List View represents a Contact field. You can sort the list by one 
or more columns.

To sort Contacts:
1. Click any column heading to select a column.

The sort icon appears in the top right corner of the column with a Roman 
numeral I appearing directly beneath it to indicate that it is the first sort field. 
The Address Book sorts by this first column in descending order.

2. To sort in ascending order, click the sort icon.

The column sort reverses, and the sort icon changes.

3. To define additional sort columns, hold down the Shift key and click the column 
headings.

Sort icons and Roman numerals appear in their column headings, indicating 
their level in the sort. After each click, the columns are resorted.

Setting Preferences for the Address Book
The Address Book preferences let you activate Eudora Planner’s various data entry 
aids, choose your preferred software for faxing, e-mailing, Web browsing, and mail 
merging, and configure the contents of the Full Name field in the List View. You can 
change your Address Book settings by choosing Preferences from the Define 
menu, then clicking Address in the Preferences dialog box. Changes you make in 
this dialog box take effect after you click OK.

The Address Book Preferences dialog box contains tabs for Data Entry, Copy 
Contact, Dialing, and Miscellaneous preferences, each of which are described in the 
following sections.

Data Entry Preferences
Data entry preferences determine the way Eudora Planner responds when you 
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enter Contact data into either the List View or Details dialog box. 

Select Data Entry Aids to activate the automatic data entry features.

In the Phone Formats area, the North America and International Phone Format 
pop-up menus let you choose whether and how domestic and international phone 
numbers will be automatically formatted when you enter them. If you need to create 
a custom format to suit your needs, select Define from the pop-up menu.

Immediately after you enter the company name for a new Contact, Eudora Planner’s 
automatic address entry feature searches your Address Book for an existing Contact 
with that company name, and then fills in the new Contact’s Work Address field with 
the contents of the existing Contact’s Work Address field. Select the Automatic 
address entry check box to enable this feature.

Copy Contact Preferences
The Copy Contact feature lets you instantly copy a group of selected fields from a 
Contact to your Macintosh’s clipboard. The Contact information can then be pasted 
into any kind of document.

Select a Copy Information option to determine which format will be used when you 
copy Contact data. Each format contains specific kinds of fields containing related 
information. For example, if you select Business Info, the data will be copied from 
work-related fields, such as Work Address and Work Phone; if you select Home Info, 

Activates any preferences 
you set on this tab

Click here to create, edit, or delete a 
phone format

Domestic phone numbers use this auto-
format

International phone numbers use this 
auto-format

Activates data-entry aids 
for specific fields

Activates the automatic 
address entry feature
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Copy Contact copies fields that hold only personal information. The default setting is 
the Key Data format, which contains primary field information. The format you select 
appears in the Preview area.

Dialing Preferences
For information about setting the dialing preferences, see “Dialing Contacts” on 
page 85.

Miscellaneous Preferences
The Miscellaneous preferences control various defaults settings within the Address 
Book.

The options in the Formats area in the Miscellaneous tab determine how certain 
information is formatted Address Book’s List and Detail views. The Date stamp 
option determines the contents and format of date stamps you add to Contacts. 

Select options from the Full Name and Listing pop-up menus to determine which 
Contact information appears in the Full Name and Primary Listing fields, 
respectively.

The preferences in the New Contacts area determine the default settings for the 
Contacts that you create. From the Primary Address, Primary Connection, and 
Primary Listing pop-up menus, select the default primary Address, Phone, and 
Listing fields, respectively. 
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Organizing Eudora Planner
Eudora Planner adds flexibility and structure to your Calendar and Address Book by 
letting you associate related Events and Contacts using categories and tabs.

About Categories and Tabs
By assigning a group of related Events or Contacts to the same category, you can 
create a relationship between them and give them a common visual style, so that 
you can view and manage them as a distinct group. A single Event or Contact can 
belong to as many categories as you need.

For example, a single Event could belong to a general Business category, a more 
specialized Client category, and an even more specific Project category, allowing 
you to view it in either a broader or more narrow context. Similarly, a single Contact 
could belong to a Business category, a Client category, a category for a specific 
Project team, and one for Golf Partners, so that you can list it with other Contacts 
that fit the same category.

As categories help you view and manage related Events and Contacts, tabs provide 
a similar way to handle related categories. You can control which categories are 
displayed together by creating tabs for certain, individual categories or groups of 
categories.

For example, to view only your work-related Events and Contacts, you could create 
a tab called “Work” that displays categories such as: 

• A “Business” category, containing work-related Meetings, To-Dos and Contacts 
within your company

• A “Travel” category, containing your travel schedule and itinerary and Contacts 
like travel agents, hotels and airlines

• A “Financial” category, containing paydays, billing deadlines, and Contacts like 
banks, accountants, and creditors
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By default, Eudora Planner contains a number of categories and tabs in both the 
Calendar and Address Book. If you have no need to divide or compartmentalize 
your Events and Contacts, you may find a single category and tab to be sufficient. 
Using categories and tabs is completely optional. As you find yourself using Eudora 
Planner to manage increasing amounts of Events and Contacts, however, you will 
find these organizational tools to be very helpful.

The following sections describe these concepts in more detail. The section 
immediately below describes how to use categories. Tabs are discussed further in 
“Using Tabs” on page 104.

Using Categories
Over time, as the amount of Eudora Planner data grows, you may find it easier to 
manage your information by grouping your Events and Contacts into common 
categories. You can choose from the categories that were installed with Eudora 
Planner, create your own categories, or, if you’re using Eudora Group Planner in a 
workgroup setting, select categories on a workgroup server.

When you create a new Contact or Event, it already belongs to a default category, 
its primary category. Although an Event or Contact can belong to any number of 
categories, it can have only one primary category, which determines how it appears 
in your Calendar and Address Book—the colors and fonts used to display it.

The following sections describe how to create categories, assign Events and 
Contacts to them, determine the primary category for Events and Contacts, and 
how to modify and delete categories.

Creating Categories
You can create your own categories for Events and Contacts if those installed with 
Eudora Planner or available on public servers aren’t suitable for your purposes. 

To create a category:
1. From the Define menu, select Categories.

The Edit Categories dialog box appears.

2. Click the Server arrow to select the server to which you want to add the 

Existing categories are 
listed here

Use these buttons to create, edit, and 
delete categories
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category.

3. Click New.

The Category dialog box appears.

4. In the Name box, type a name for the category. 

5. To give the category a distinctive appearance, click the Font field to select a 
font. Specify the font size, style, and color, then select a Justify option. The 
settings you select here will only affect Events having this category as their 
primary category (see “Changing the Primary Category” on page 103 for 
information about primary categories).

6. Click OK.

Eudora Planner adds the category to the Categories list. The category is 
available for you to assign to Events or Contacts, or to display on Calendar and 
Address Book tabs.

Assigning Categories to Events and Contacts
You can organize and demonstrate relationships between Events and Contacts by 
assigning categories to them. 

Most often, you will assign or remove categories to and from individual Events and 
Contacts. However, Eudora Planner’s Address Book lets you add or remove 
categories to and from multiple Contacts simultaneously.

The following procedures describe the various methods involved.

To assign categories to Events and Contacts:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

Enter a name for the 
category

These settings determine the 
font characteristics for 
Events or Contacts that have 
this category as their 
primary category

Determines the background 
color for Events or Contacts 
that have this category as 
their primary category
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The Assign Categories dialog box appears.

If you are connected to a workgroup server, then the server’s name will appear 
in parentheses next to categories stored on that server.

3. In the Available Categories list, click the categories you want to assign.

A check appears next to each category you click. The first category you select 
becomes the primary category for the Event or Contact. You can change the 
primary category by clicking the Primary Category field and selecting a 
different category from the pop-up list.

4. Click OK.

The categories you select appear in the Categories box of the Event or Contact.

To remove a category from an Event or Contact:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

The Assign Categories dialog box appears. The categories assigned to the 
Event or Contact are checked.

3. In the Available Categories list, click the categories you want to remove.

The categories become unchecked.

4. Click OK.

The category is removed from the Event or Contact and no longer appears in 
the Categories box.

To assign or remove a category to or from multiple Contacts:
1. In the List View, select the Contacts to which you want to assign the category.

• To select all Contacts on the current tab, from the Edit menu, choose Select 
All.

• To select a list of contiguous Contacts, click to the left of the name at the 
beginning of the selection, hold down the Shift key, then click to the left of the 
name at the end of the selection.

Check marks indicate that 
category is assigned to the 
Event or Contact
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• To select a group of non-contiguous Contacts, hold down the Command key 
and click to the left of each name.

2. From the Edit menu, select Change Categories. 

The Change Categories dialog box appears.

3. To add a category, select its check box. To remove a category, clear its check 
box.

4. Click OK.

The category is assigned to the Contacts you selected and appears in each 
Contact’s Details dialog box.

Changing the Primary Category
Although you can assign multiple categories to an Event or Contact, only one of 
those categories can be the primary category for that item. The primary category 
determines the font and background color of an Event or Contact. When you create 
an item, the default category of the tab on which it was created automatically 
becomes its primary category. You can then change the primary category by doing 
the following.

To change a primary category:
1. Double-click the Event or Contact.

The Event Details or Contact Details dialog box appears.

2. Click Categories.

The Assign Categories dialog box appears.

3. Scroll through Primary Category list until you find the category you want to 
use.

4. Click OK.

The category appears in the Categories box of the Event or Contact. The 
appearance of the Event or Contact changes to reflect the new primary 
category.
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Editing and Deleting Categories
You can modify or delete the categories in your Calendar and Address Book—both 
those installed with Eudora Planner and the ones you’ve created. When you rename 
a category, all references to that category will reflect your change.

To edit categories:
1. From the Define menu, select Categories. 

The Edit Categories dialog box appears. 

2. Click a category in the list, then click Edit.

The Modify Category dialog box appears, allowing you to modify the category 
as desired. If you want to change the font for this category, click the Font button 
and select new options in the Font dialog box. Click OK.

3. Click OK.

Events and Contacts in the category change to reflect your selections.

To delete categories:
1. From the Define menu, select Categories. 

The Edit Categories dialog box appears. 

2. Click a category in the list, then click Delete.

A warning dialog box appears.

3. Click Yes to delete the category.

The category is deleted and is no longer available.

You cannot delete a category if it is still assigned to any of your Events or Contacts. 

Using Tabs
Once you’ve added enough categories to accommodate the different kinds of 
Events and Contacts you create, you may find that you need to further organize your 
Calendar and Address Book by grouping together related or similar categories. 
Using tabs, you can visually group related categories for quick reference and to 
reduce clutter in your Calendar and Address Book views.

You can create tabs that display only those Events or Contacts contained in a single 
category or those contained in any combination of categories. For example, you 
could make one tab called Home to display your personal Events, which are all 
contained in a single category called Personal. Another tab called Work could show 
all your work-based Events, which are contained in three categories called 
Marketing, Sales, and Engineering. A third tab could display all Events in your 
Calendar.

Similarly, in your Address Book you might create a tab for only those categories 
containing personal Contacts, another for categories containing your business 
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associates, and yet another to show all Contacts.

This section discusses how to create tabs, how to modify their appearance, and how 
to assign categories to them.

You can give a distinctive appearance to a tab when you select a style for it. See 
“Creating Calendar Tab Styles” on page 107 for more information.

Creating Tabs
Create a tab whenever you want to visually group Events or Contacts in specific, 
related categories. 

Creating Calendar Tabs
As you fill your Calendar with Events, you may want to better organize your 
information by creating Calendar tabs that display selected groups of categories. 
You can also create a Calendar tab that shows only Events that occupy time in your 
schedule, so that you can quickly see those important activities to which you’re 
obligated.

To create a Calendar tab:
1. Display the Calendar. Then, from the Tabs menu, select New Tab.

The Calendar Tab Info dialog box appears.

You can create a new Calendar tab by control-clicking an existing tab, 
then selecting New Tab from the contextual menu that appears.

2. In the Name box, type a name for the tab. 

3. Click the Style field to select a style or, if desired, create and assign a new 
style.

For more information on creating styles for tabs, see “Creating Calendar Tab 
Styles” on page 107.

Enter a name for the tab

Selected categories appear 
on this tab

The category you select here 
becomes the default primary 
category for new Events 
you create on this tab

Use these buttons to automatically select 
or clear all categories

These buttons let you create new categories 
or modify and delete existing ones

You can apply a unique style 
to this tab
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4. In the Display events with these categories list, select the Event categories 
you want to appear on the tab. To have this tab display all categories, click Mark 
All.

5. Select an Event category from the Category for new events list.

Click the arrow to select from the categories appearing in the drop-down list. 
The category you select here determines the default category for all Events you 
create in this tab.

6. Click OK.

The new tab appears in the Calendar.

To create a Calendar tab that shows only your busy time:
1. In the Calendar, from the Tabs menu, select New Tab.

2. In the Name box, type a name for the tab.

3. From the Style Name list, select a style, or create and assign a new style, if 
desired.

For more information on creating styles for tabs, see “Creating Calendar Tab 
Styles” on page 107.

4. Check the Display events that block time box.

5. Click OK.

The new tab appears in the Calendar and contains only those Events which 
occupy your time.

Creating Address Book Tabs
You can organize your Contact information by creating Address Book tabs that show 
only selected groups of categories. When you configure an Address Book tab, you 
can also select which Contact fields appear in the List View.

To create an Address Book tab:
1. In the Address Book, from the Tabs Menu, select Add New Tab.
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The Address Book Tab Info dialog box appears.

You can create a new Address Book tab by control-clicking an existing 
tab, then selecting New Tab from the shortcut menu that appears.

2. In the Name box, type a name for the tab. 

3. In the Display contacts with these categories list, select the categories you 
want to appear on the tab.

4. In the Category for new contacts list, select a category.

The category you select here determines the initial default category for all new 
Contacts you create in this tab.

5. From the Style Name list, select a style, or create and assign a new style, if 
desired.

For more information on creating styles for tabs, see “Creating Calendar Tab 
Styles” on page 107.

6. Click OK.

The tab appears in your Address Book.

Creating Calendar Tab Styles
You can apply different styles to your Calendar tabs in order to give those tabs a 
distinctive appearance. The tab style determines attributes such as fonts, colors, 
and the locations of items appearing on the tab.

A Calendar tab style defines the appearance of each view on the tab—Day, Multi-
Day, Month, and Year—and also determines what types of Events appear on a 
Calendar tab and how they are displayed. 

To define a new Calendar tab style:
1. In the Calendar, from the Define Menu, select Tab Styles.

Tab name is entered here

Selected categories 
appear on the tab

This category is the 
default primary category 
for Contacts you create 
on this tab
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The Styles dialog box appears.

2. Click New. Then, in the New Style dialog box, type a name for the new style and 
click OK.

The Style Preferences dialog box appears.

3. Click a button to display the style options for a particular Calendar view.

The style settings you make for the Day View also determine the look of the 
Multi-Day View.

4. Select the element of the view for which you want to set preferences.

The options in the right-hand side of the dialog box change to reflect your 
choice.

5. Repeat steps 3 and 4 until you have specified all styles.

6. Click Close.

Your new Calendar tab style appears in the Style Name list on the Calendar 
Styles dialog box. You can assign the style to your tabs as suits your 
preferences.

Check mark indicates style 
applied to the currently 
active tab

Click to create a new tab 
style

To see the style 
options for a 
particular Calendar 
view, click its 
button

Lists the elements 
of the selected 
view for which you 
can set preferences

The options here 
vary according 
the element of 
the Calendar 
view you’ve 
selected
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For detailed information about specific style settings for each Calendar view, consult 
the online help.

Assigning Tab Styles
You can alter the appearance of a Calendar tab by applying a style to it.

To assign styles to tabs:
1. Click the label of the Calendar tab to bring it to the front.

2. From the Tabs menu, select Edit Tab.

The Calendar Tab Info dialog box appears.

3. From the Style Names list, select a new style.

4. Click OK.

The tab’s appearance changes to reflect the new style.
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Printing in Eudora Planner
Eudora Planner lets you print your Calendar and Address Book information to a 
variety of paper formats, such as those designed for organizers, mailing labels, and 
envelopes. Maintaining an appointment book or personal directory is as simple as 
printing pages from Eudora Planner.

This chapter describes how to print your Eudora Planner information and how to 
save time and ensure a consistent style and format by saving and reusing your print 
settings.

Selecting Print Settings
When you select the Print command from the File menu or toolbar, Eudora Planner 
displays a Print dialog box specific to either the Calendar or Address Book—
depending on whichever is currently active. You can use the settings in that dialog 
box to select the format to which you want to print.

After you select a set of printing settings, you save it as a printing template to use in 
the future. To learn how to save your printing settings, see “Creating Print 
Templates” on page 117.

Printing from the Eudora Planner Calendar
Whether you need to print pages for a personal appointment book or create a simple 
calendar to be posted on a bulletin board, Eudora Planner provides you with many 
ways to print your Calendar information. You can print any of the Calendar views, 
including the To-Do List, to either standard-sized paper or to paper designed to fit 
into a personal organizer.
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The following table describes the options available in the pop-up menus at the top of 
the Print dialog box for the Calendar:

The following table describes the general options available in the tabs in the Print 
dialog box: 

Other options are available depending on the calendar view you have chosen. 
To learn what each option does, consult the online Help.

To print a Calendar:
1. From the File menu, select Print to open the Print dialog box. Then, click either 

the Day, Week, or Month button, depending on the Calendar view you want to 
print. The selection you make here determines what options appear in the Style 
menu:

• Select Day to see options for printing a Day View Calendar or To-Do List.

• Select Week to see options for printing a Week or Multi-Day View Calendar.

• Select Month to see options for printing a Month or Year View Calendar.

2. Click the Style pop-up menu to select the format of the printout; your selection 
appears in the Form Preview area. Then, click the Paper pop-up menu to select 
the type of paper to which you want to print. 

Use this menu... To...

Template Select a print template, if you want to print using a set of 
preferences that you’ve configured previously.

Style Choose the Calendar layout you want to print. There are different 
layouts available for each Calendar view, including the To-Do 
List. The style you choose here is applied to the paper type you 
select in the Paper menu.

Paper Select the type of paper to which you want to print. You can 
choose to print to formatted paper designed to fit into an 
appointment book or personal organizer.

Use this tab... To...

Content Set the date range of Events to print. The Form Preview area lets 
you see the style you’ve selected in the Style menu. If you are 
printing multiple pages, select the Print Empty Forms option to 
print dates, weeks, or months for which you have no scheduled 
Events.

Style Options Select the font for Events in your printout. The options in this tab 
vary according to what you’ve selected in the Style menu.

Paper Options Determine the margins of your printout, as well as the number of 
organizer pages you want to print to one sheet of paper. You can 
also select the option for double-sided printing.

Miscellaneous Add a custom header and footer to your printout.
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Eudora Planner prints directly to the formatted pages designed for a number of 
popular personal organizers. Even if you are not printing to organizer paper, you 
can still create a printout that resembles the format of a particular organizer.

3. Select the Content tab to do the following:

• To print Events within a standard range of dates, such as this week or this 
month, select Standard, then click the adjacent pop-up menu to select a 
range of dates.

• To choose your own range of dates to print, select Custom, then enter a date 
range into the From and To boxes.

• To include empty calendar pages in your printout, such as for those dates on 
which no Events are scheduled, select the Print Empty Forms Also option.

4. On the Style Options tab, select options to change text styles, if necessary.

The options on this tab vary according to your selection in the Style pop-up 
menu.

5. Select the Paper Options tab to do the following:

• To adjust the margins, change the settings in the Margins area.

• To print a single calendar page across multiple sheets of paper, such as for a 
large calendar to be posted on a bulletin board, make adjustments in the Print 
Across Sheets area.

• To print on both sides of paper, select the Double-sided Printing option.

6. Select the Miscellaneous tab to add a header and footer to the calendar 
pages.

7. Click Print.

Your Event information is printed according to the settings you specified.

Printing from the Address Book
Eudora Planner’s Address Book printing functions let you update and maintain the 
names and addresses in your paper-based, personal organizer, and create 
envelopes and labels for correspondence with your Contacts. You can print your 
Contact information in styles that accommodate a variety of popular organizers, as 
well as in formats for commonly-used envelopes and mailing labels.

You can specify how Eudora Planner prints your Contact information by setting 
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preferences on the Print dialog box. 

After you select the type of printout you want—Address Book, Envelopes, or 
Labels—you can specify the following settings:

The following table explains which options appear on each tab of the Print dialog 
box when you print Contact information:

Use this menu To...

Template Select a print template if you want to print Contact information 
using a set of preferences that you’ve configured previously.

Style Choose the address book, envelope, or label layout you want to 
print. The selection you make here determines which Contact 
fields are printed and where those fields are positioned on the 
paper.

Paper Select the type of paper to which you want to print. This can be 
plain sheets or formatted paper designed to fit into an 
appointment book or personal organizer.

Use this tab To...

Content Determine the range of Contacts to print. The Form Preview area 
lets you see the format you selected in the Style menu. When you 
print a paper address book, this tab also contains options that let 
you leave room for holes on the paper and to print empty pages. 

Style Options Select the font for the Contacts in your printout. 

Paper Options Set the margins of your printout when you are printing an, as well 
as the number of pages you want to print to one sheet of paper. 
You can also select the option for double-sided printing.

Miscellaneous Add a custom header and footer to your address book pages.

Use these buttons 
to select a type of 
printout

Click to revert to 
Eudora Planner’s 
default settings

Shows a simple 
preview of the 
style you’ve 
selected
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Other options are available depending on whether you are printing listings, 
envelopes or labels from the Address Book. To learn what each option does, 
consult the online Help.

Printing for an Organizer
Eudora Planner prints directly to the formatted paper available for a number of 
popular personal organizers. And even if you are not printing to formatted organizer 
paper, you can still select an organizer option to create a paper-based address book 
that resembles the style of a particular organizer.

To print a paper address book:
1. From the File menu, select Print.

The Print dialog box appears.

2. Click the Style pop-up menu to select an address book format.

3. Click the Paper pop-up menu to select the type of paper to which you want to 
print.

4. Select the desired options in the Content, Style Options, Paper Options, and 
Miscellaneous tabs.

Consult the online Help for more information about specific print settings 
on these tabs.

5. If you want to save these settings as a template for future printouts, click Save 
Template As to give the template a name. For more information on printing 
templates, see “Using Print Templates” on page 117

6. Click Print.

Printing Envelopes
You can print your Contact information to various styles and sizes of envelopes.

To print an envelope:
1. From the File menu, select Print to open the Print dialog box. Then, click the 

Envelope button.

2. Click the Style pop-up menu to select an envelope format. The selection you 
make here determines how the Contact information is positioned on the 
envelope.

The format you select appears in the Form Preview area.

3. Click the Paper pop-up menu to select the type of envelope to which you want 
to print.

4. Select the Content tab, then choose one of the following options to determine 
the range of Contacts to print:

• To print a standard range of Contacts, such as all in the Address Book or 
those currently selected, select Standard, then click the adjacent pop-up 
menu to choose an option.
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To print only those Contacts whose primary listing begins with a non-
alphabetic character (such as a company name that begins with a 
number, rather than a letter), select the Other option.

• To print a range of your choosing, select Custom, then enter a range in the 
adjacent boxes.

5. Select the Style Options tab, then select settings to determine the font 
characteristics of the information printed on the envelope.

6. If you want to save these settings as a template for future printouts, click Save 
Template As to give the template a name. For more information on printing 
templates, see “Using Print Templates” on page 117

7. Click Print.

The envelopes are printed according to the settings you’ve selected.

Printing Mailing Labels
Eudora Planner lets you print your Contact information to a variety of label formats. 

To print mailing labels:
1. From the File menu, select Print to open the Print dialog box. Then, click the 

Labels button.

2. Click the Style pop-up menu to select a label format. This setting determines 
how the Contact information is positioned on the label.

The format you select appears in the Form Preview area.

3. Click the Paper pop-up menu to select the type of labels to print.

4. Select the Content tab. Then, in the Contacts to Print area, select one of the 
following to determine the range of Contacts to print:

• To print a standard range of Contacts, such as every one in the Address Book 
or those currently selected, select Standard, then click the adjacent pop-up 
menu to choose an option.

• To print a range of your choosing, select Custom, then enter a range in the 
adjacent boxes.

5. In the Copies of each label box, enter the number of label copies you want to 
print. Then, in the Start printing with label on boxes, enter the row and 
column where you want the first label to print.

6. Select the Style Options tab, then select settings to determine the font 
characteristics of information appearing on the labels.

7. If you want to save the settings you’ve made for future printouts, click Save 
Template As to create a printing template. For more information on printing 
templates, see “Using Print Templates” on page 117. Then, click Print.

The labels are printed according to the settings you’ve selected.



Previewing Your Printouts
Before you print from the Calendar or Address Book, you can use the print preview 
feature to inspect a printout for accuracy. If necessary, you can adjust the print 
settings, then preview again. Once you are satisfied with what appears in the 
preview, you can proceed to print.

To see a preview of a printout:
1. In the Print dialog box, select Preview.

The Print Preview dialog box appears, displaying an on-screen illustration of 
your printout.

2. If the printout has multiple pages, you can advance or backtrack through the 
pages by clicking the Next Page and Previous Page buttons.

3. To print the information displayed, select Print. To cancel the print operation, 
click Cancel. 

Using Print Templates
To give your Eudora Planner printouts a consistent appearance, or to save time 
when you print new copies of your Event and Contact information, you can create 
print templates by saving particular settings you choose in the Print dialog box.

When you choose a saved print template, Eudora Planner displays all of its style and 
formatting information on the Print dialog box.

Creating Print Templates
You can save a set of printing preferences f you want to reuse your printing settings, 
you can save them as a named template. After you save the template, you can have 
Eudora Planner reuse it when you want to print other Event and Contact information.

To save a print template:
1. Once you’ve specified your desired print options in the Print dialog box, click 

Save Template As.

A dialog box appears. 

2. Type a name for the template.

3. Click Save.

Eudora Planner saves the template and makes it available from the Template 
pop-up menu. For details on how to use a print template, see the next section.
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Printing from a Print Template
If you saved print settings, you can restore them to the Print dialog box by selecting 
them from the Template pop-up menu.

To print from a template:
1. From the File menu, choose Print.

The Print dialog box appears.

2. Click the Template pop-up menu to select a print template.

The Print dialog box changes to reflect the settings for that template.

3. Click Print.

Eudora Planner prints your Event or Contact information according to the 
settings of the print template.

Printing What Appears on the Screen
In either the Calendar or Address Book, you can bypass the Eudora Planner Print 
dialog box to print exactly what appears on your screen.

In the Address Book, to print the current List View, select Print Items from the File 
menu. The generic print dialog box for your printer driver appears, where you can 
either adjust settings or just immediately click Print. Eudora Planner prints the 
Contacts that appear in the current tab. To print the Contacts on a different Address 
Book tab, select that tab to bring it to the foreground.

In the Calendar, the File menu command for printing the screen varies according to 
what Calendar view is displayed, or whether you’ve selected the To-Do List. For 
example, to print the Month View, display the Month View, then select Print Month 
from the File menu. To print the To-Do List, click somewhere in the list to select it, 
then choose Print To-Dos from the File menu. 
118 Chapter 5



Chapter
 6

Chapter 6

Importing and Exporting
Eudora Planner lets you import information from other scheduling and contact 
management applications into your Calendar and Address Book. You can also 
import information from text files, as well as export your data to text files for use in 
other applications. This chapter explains how to get data in and out of Eudora 
Planner.

Importing from Now Up-to-Date and Contact
If you are using the current, shipping versions of Now Up-to-Date and Contact, you 
can directly transfer your Event and Contact data into Eudora Planner. Eudora 
Planner will only import the Private data contained in your personal Up-to-Date and 
Contact databases. However, you can directly import any public data from Public 
Event and Public Contact Server databases. 

To import from Up-to-Date and Contact:
1. From the File menu, select Import. Then, from the resulting submenu, select 

either Now Up-to-Date Database or Now Contact Database. 

A directory dialog box appears.

2. Navigate to find the Now Up-to-Date or Now Contact database you want to 
import, then select it.

3. Click Open.

A progress bar appears, indicating that Eudora Planner is importing data from 
the selected database. Once the import is complete, the data appears in 
Eudora Planner.

To import public data from Public Event and Public Contact Server databases:
1. From the File menu, select Import. Then, from the resulting submenu, select 

either Public Event Database or Public Contact Database. 
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A directory dialog box appears.

2. Navigate to find the Up-to-Date or Contact server database that you want to 
import, then select it.

3. Click Open.

Importing Events and Contacts from Text Files
Eudora Planner can import data from text files created by other applications. The 
import function lets you determine which fields to import and how those fields are 
mapped, and accommodates a variety of text delimiters.

To import Events or Contacts from text files:
1. From the File menu, select Import. Then, from the resulting submenu, select 

either Events from Text or Contacts from Text.

The Event Text Import or Contact Text Import dialog box appears, depending on 
the option you’ve selected.

2. In the File Preview area, select the check boxes for those fields in the text file 
that you want to import into Eudora Planner.

3. To map the fields in the text file to the appropriate fields in Eudora Planner, drag 
the field names in the Import Fields area to match them against the fields in 
the File Preview area. 

You can add more fields to the Import Fields area by selecting a field title in the 
Available Fields area, then clicking Add.

4. In both the Record and Field areas, click the Separator pop-up menu to select 
the types of delimiters used in the text file.

Field names from 
text file appear 
here

Lists all the fields 
available in Eudora 
Planner
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5. Select the Skip first record and Imported field values are quoted check 
boxes as desired.

• Select Skip first record to have Eudora Planner omit the first record in the 
text file when importing. You might choose this option if the first record 
contains unnecessary data, such as field titles from application that created 
the text file.

• Select Imported field values are quoted if each instance of field data in the 
text file is enclosed by quotation marks. Choosing this option will cause 
Eudora Planner to omit those quotation marks when importing.

6. Click Import. 

Eudora Planner imports the contents of the text file. Imported Events appear in 
your Calendar; imported Contacts appear in your Address Book.

Exporting from Eudora Planner
You can transfer your Eudora Planner data to another application by exporting your 
Events and Contacts to a text file. Eudora Planner lets you determine exactly which 
fields to export, the order in which the fields are exported, and the text delimiters 
between fields and records. This flexibility allows you to tailor the text export for just 
about any other application that can import text data.

To export your Events and Contacts as text:
1. From the File menu, select Export. Then, from the resulting submenu, select 

Events as Text to export Events or Contacts as Text to export Contacts.

The Event Text Export or Contact Text Export dialog box appears, depending on 
which option you’ve selected.
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2. Click the Export pop-up menu and select one of the following options:

• If you are exporting Events, select Local Events to export only those Events 
that are local to your database, or All Events to export all Events that appear 
in your Calendar, including workgroup Events.

• If you are exporting Contacts, select Local Contacts to export only those 
Contacts that are local to your database, or All Contacts to export all 
Contacts that appear in your Address Book, including workgroup Contacts.

3. To choose a field for export, select it in the Available Fields area, then click 
Add to move it to the Export Fields area. To change the export order, drag the 
fields in the Export Fields area to change their position in the order.

4. To determine how the text file is delimited (that is, how fields and records are 
separated from each other), in both the Record and Field areas, select an 
option from the Separator pop-up menu.

When importing, most applications expect text files to have records 
separated by carriage returns and the fields within them to be separated 
by tabs.

5. Select the Export field titles as first record and Quote Fields check boxes as 
desired.

• Select Export field titles as first record to have field names export as the 
record in the text file.

• Select Quote Fields to have quotation marks appear around each instance of 
field data in the text file.

6. Click Export.

A directory dialog box appears.

7. Enter a name for the text file, select its location, then click Save.

Your Eudora Planner data is exported to the text file, which is created in the 
location you selected. To inspect the contents of the text file, open it with a word 
processing application.
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QuickAccess
Eudora Planner’s QuickAccess features let you view, enter, and edit Calendar and 
Address Book information quickly and easily, without starting Eudora Planner. This 
chapter describes the QuickAccess features in detail, including how to:

• View and open Events and Contacts using the QuickMenus

• Check your day’s schedule and create or modify Events using QuickDay

• View, create, dial, and e-mail Contacts using QuickContact

Using the QuickMenus
Eudora Planner’s QuickMenus give you instant access to important Event and 
Contact information from your Macintosh’s menu bar, no matter what application 
you’re working in. There are two QuickMenus, each corresponding to a different 
portion of Eudora Planner: the QuickDay menu for Calendar information, and the 
QuickContact menu for information in your Address Book.

In order for the QuickMenus to appear in the Macintosh menu bar, the extension “EP 
QuickMenu” must be active. Also, to have the QuickMenus receive updated 
information from your Eudora Planner database, the application files “Eudora 
Planner Server” and “EP Menu and Reminder Support” (located in the Eudora 
Planner Folder) must be running. An alias to the latter file is placed in your Startup 
Items folder during installation, causing it and Eudora Planner Server to 
automatically launch each time you start your Macintosh.

The QuickDay Menu
To open the QuickDay menu, click the QuickDay calendar icon near the right-hand 
side of the menu bar. A pull-down menu appears, displaying Events scheduled for 
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the current day.

The QuickDay menu is divided into different sections that each contain a particular 
type of item. In the top section are commands that let you open Eudora Planner and 
the QuickDay mini-application. The rest of the sections contain specific types of 
Events, such as Meetings, To-Dos, or Calls (Banners, Holidays, and Special Events 
do not appear in the QuickDay menu).

You can open the details for an Event by selecting it in the menu. The Event Details 
dialog box appears, where you can modify the Event just like you would in Eudora 
Planner. The changes you make here are immediately saved by Eudora Planner.

The QuickDay menu displays Events according to the settings you choose in the 
QuickDay preferences. For information about these preferences, see “Setting 
Preferences for QuickDay” on page 127.

The QuickContact Menu
To open the QuickContact menu, click the QuickContact telephone icon in the 
Macintosh menu bar. A pull-down menu appears, displaying a list of your Quick 
Contacts.

At the top of the menu are commands that let you open Eudora Planner and the 
QuickContact mini-application. The rest of the menu displays the Contacts that 
you’ve designated as Quick Contacts and their work phone numbers (for information 
on how to designate a Quick Contact, see “Setting a Contact as a Quick Contact” on 
page 129). To see details about a Quick Contact, select it in the menu; a Contact 
Details dialog box appears, where you can view, add, or modify information as 
desired. Any changes you make to the Contact are immediately saved in your 
Eudora Planner database.

These commands let you open Eudora Planner and QuickDay from the menu bar

The current day’s Meetings appear in this part of the menu, with Meetings occurring in the a.m. 
separated from those occurring in the p.m.

Today’s To-Dos appear in this area

Today’s Calls appear here

These commands let you open Eudora Planner and QuickContact from the menu bar

Your QuickContacts are listed here with their primary connection listing
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Using QuickDay
QuickDay is a mini-application that lets you work with your Event information even 
when Eudora Planner isn’t running. To open QuickDay, select Open QuickDay from 
the QuickDay menu, or double-click the QuickDay application file located in the 
Eudora Planner Folder.

The QuickDay window contains a list view summarizing your schedule for a 
particular day. When you open QuickDay, it displays the Events scheduled for the 
current day by default. You can see what’s scheduled on other days by clicking the 
navigation buttons. Any changes or additions you make in QuickDay are saved in 
Eudora Planner.

Viewing Events with QuickDay
You can use QuickDay to view Events occurring on any day. When you first open 
QuickDay, it displays the schedule for the current date. QuickDay’s navigation 
buttons let you move to other dates.

To view Events with QuickDay:
1. Click the QuickDay calendar icon located in the menu bar, then select Open 

QuickDay from the resulting pull-down menu.

The QuickDay window appears, displaying Events scheduled for the current 
date.

2. To see details for an Event, double-click it in the window.

The Event Details dialog box for that Event appears.

3. Once you’ve viewed the Event’s details, click Done or Cancel to return to the 
QuickDay dialog box.

4. Use QuickDay’s right and left arrow buttons to move backward or forward 
through your Calendar one day at a time.

5. Click the Pick a date to view button to see Events scheduled for a particular 

Use these buttons to navigate 
through your schedule

Button bar lets you create new 
Events and delete existing ones

Selected day’s Events are listed 
here

Click here to reconfigure the 
QuickDay window
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date.

The Choose Day dialog box appears with options that let you select a date. If 
necessary, you can select a different year by clicking the arrow keys adjacent to 
the year field. You can select a month by clicking a month name in the month 
list or by clicking the arrow keys adjacent to the header on the month-view 
calendar. Finally, to select a specific date, click a date in the month-view 
calendar. Once you’ve made your selections, click OK.

6. To close the QuickDay window, click Done.

Creating Events with QuickDay
You can use QuickDay to create any kind of Event, which are immediately saved to 
Eudora Planner and appear in your Calendar the next time you open it.

To create an Event with QuickDay:
1. Click the QuickDay menu bar icon, then select Open QuickDay.

The QuickDay window appears.

2. Use the navigation buttons to select the date on which you want to schedule the 
Event, if necessary.

3. On the button bar at the top of the QuickDay window, click the button for the 
type of Event that you want to create.

An Event Details dialog box for the type of Event you’ve selected appears.

4. Enter details for this Event. For information on creating Events, see “Adding 
Events to the Calendar” on page 32.

5. Click Save to close the Event Details dialog box.

You are returned to the QuickDay window, where the newly created Event 
appears. The Event is immediately saved to your Eudora Planner database.

Modifying an Existing Event with QuickDay
QuickDay lets you make changes to existing Events in your database. Your changes 
are immediately saved by Eudora Planner.

To modify an existing Event with QuickDay:
1. In the QuickDay window, double-click the Event you want to modify.

The Event Details dialog box for that Event appears.

2. Make any necessary changes to the Event. For example, you may want to 
change the starting time of a Meeting, attach a document to a Call, or mark a 
To-Do as “Complete.”

3. Click OK.

You are returned to the QuickDay window. Eudora Planner saves the changes 
you’ve made, which are reflected both in the Calendar and QuickDay.
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Creating Contacts with QuickDay
In addition to creating Events, you can also use QuickDay to create Contacts for 
your Address Book.

To create a Contact in QuickDay:
1. In the QuickDay window, click the New Contact button.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, enter any information appropriate for the 
Contact.

For details on creating Contacts, see “Creating Contacts” on page 67.

3. Click OK.

You’re returned to the QuickDay window. The new Contact is immediately saved 
to your Eudora Planner database and appears in your Address Book the next 
time you open Eudora Planner.

Setting Preferences for QuickDay
The QuickDay preferences let you determine which Events appear in the QuickDay 
window. You can select Events according to a number of variables, including 
category, type, and completion status. The settings you make here also affect what 
appears in the QuickDay menu.

To set preferences for QuickDay:
1. In Eudora Planner, from the Define menu, select Preferences.

The Preferences dialog box appears.

2. Click the Calendar button to display the Calendar preferences. Then, click the 
QuickDay tab.

The QuickDay preferences are displayed.

3. In the Display Events with these Categories area, select the Event 
categories that you want to appear in QuickDay.

Events assigned the 
selected categories 
appear in QuickDay

When this is selected, 
QuickDay displays 
any Events that block 
your time

These options 
determine which To-
Dos are displayed in 
QuickDay, if any

These options determine which 
types of Calls appear in QuickDay, if 
any

The category you select here is the 
default for any Events you create 
with QuickDay
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4. To set the default category for Events that you create in QuickDay, click the 
Assign Category to any new Events pop-up menu, then select a category.

5. If you are using Eudora Planner for group scheduling, select the Display 
Events that block my time check box to have QuickDay automatically display 
any Events that block time in your schedule, no matter what categories those 
Events are assigned.

6. To determine which types of To-Dos and Calls appear in QuickDay, do the 
following:

• To have QuickDay display To-Dos, select the Display To-Dos check box. 
Then, select the check boxes for the types of To-Dos that you want to appear.

• To have QuickDay display Calls, select the Display Calls check box. Then, 
select the check boxes for the types of Calls that you want to appear.

7. Click OK.

QuickDay is configured to display the Categories and Event types that you’ve 
selected.

Using QuickContact
QuickContact lets you have complete access to the information in your Address 
Book without having to open Eudora Planner. You can see a list of all your Contacts, 
find and view those Contacts that are most important to you, initiate phone calls and 
e-mail messages, and create new Contacts—all without starting Eudora Planner. To 
open QuickContact, select Open QuickContact from the QuickContact menu, or 
double-click the QuickContact application file in the Eudora Planner Folder.

Options in this menu 
determine which Contacts 
are displayed in 
QuickContact

If you select the “Found 
Contacts” option in the 
Show menu, you can use 
these options to set your 
search criteria.

Contacts are displayed 
here

Click here to add, remove, 
or group fields in the 
window

Buttons bar for frequently 
performed operations
128 Chapter 7



Setting a Contact as a Quick Contact
You can give important Contacts special standing by selecting them to be Quick 
Contacts, a designation that makes those Contacts especially accessible to you 
when you’re not running Eudora Planner. The most important feature of Quick 
Contacts is that they appear in the QuickContact menu, from where you can readily 
view and change their details at any time, no matter what application you’re working 
in. Quick Contacts are also automatically assigned a Quick Contact category, so you 
can easily find them when you search or sort in your Address Book or in the 
QuickContact mini-application.

To designate a Contact as a Quick Contact:
1. In the Address Book or QuickContact window, double-click the Contact you 

want to set as a QuickContact.

The Contact Details dialog box appears.

2. Select the Quick Contact check box.

3. Click Save to close the Contact.

The Contact is designated as a Quick Contact and appears in the QuickContact 
menu. It is also automatically assigned the Quick Contact Address Book 
category.

Finding Contacts in QuickContact
QuickContact’s find function lets you search your entire Address Book for a 
particular Contact or group of Contacts. You enter the name to search on, select the 
search method, then have QuickContact return a list of Contacts matching your 
criteria. 

To find Contacts in QuickContact:
1. From the QuickContact menu, select Open QuickContact.

The QuickContact window appears.

2. From the Show pop-up menu, select Found Contacts.

3. In the Find field, enter the name you want to search on. You can also enter just 
a letter.

4. Choose a search method:

• Select the Starts with method to find a Contact whose name starts with the 
name or letters that you’ve entered in the Find field.

• Select the Contains method to find Contact that contains the name or letters 
you’ve entered in the Find field.

5. Click Find.

The QuickContact window displays a list of names matching your search 
criteria.
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Creating Contacts with QuickContact
You can use QuickContact to create new Contacts on the fly, without having to open 
your Address Book.

To create a Contact with QuickContact:
1. Click the Create a new contact button in the QuickContact window.

The Contact Details dialog box appears.

2. In the Contact Details dialog box, enter any information appropriate for the 
Contact. 

For information on creating Contacts, see “Creating Contacts” on page 67.

3. Click OK.

You’re returned to the QuickContact window. Your Contact is saved to the 
Address Book. 

Dialing Contacts in QuickContact
QuickContact’s dialing function lets you dial Contacts in your Address Book. The 
dialing function automatically creates Call Events that are logged in your Calendar 
and the Contact History.

To dial a Contact from QuickContact:
1. In the QuickContact window, select the Contact you want to call.

You can initiate a phone call to a Contact in QuickContact by control-
clicking that Contact, then selecting Dial Phone from the contextual 
menu that appears.

2. Click the Dial button in QuickContact’s button bar.

A Call Details dialog box appears, which contains the name and primary phone 
number of the of the Contact you are dialing.

3. Click Dial Phone.

QuickContact dials the phone number, and a call status dialog box appears.

4. Pick up your phone’s receiver, then click Talk to wait for the party you’ve dialed 
to answer.

If, before you pick up the receiver, you decide not to complete the call, click 
Hang Up. If you are dialing through a modem, this will terminate the call and 
clear your modem.

E-mailing Contacts in QuickContact
With QuickContact, you can send e-mail messages to any Contact without opening 
your Address Book.
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To email a Contact from QuickContact:
1. In the QuickContact window, select the Contact you want to email.

You can send an email to a Contact in QuickContact by control-clicking 
that Contact, then selecting Send E-mail from the shortcut menu that 
appears.

2. Click the Send e-mail to selected Contacts button.

Creating Events with QuickContact
QuickContact lets you create new Meetings, To-Dos, and Calls to be added to your 
Calendar. You can also create Events that are automatically attached to Contacts.

To create an Event with QuickContact:
1. In the button bar at the top of the QuickContact window, click the button for the 

Event type you want to create.

An Event Details dialog box appears.

2. Add the appropriate information to this Event. 

For details on creating Events, see “Adding Events to the Calendar” on page 
32.

3. Click OK.

You’re returned to the QuickContact window and the Event is saved to your 
Calendar.

To create an Event that attaches automatically to a Contact:
1. In the QuickContact window, select the Contact to which you want to attach the 

Event.

2. In the QuickContact button bar, click the button for the type of Event you want to 
attach.

3. An Event Details dialog box for the type of Event you’ve selected appears.

4. Enter the appropriate information for the Event. For details on how to create 
Events, see “Adding Events to the Calendar” on page 32. 

5. Once you’ve entered the information, click OK.

The Event is saved to your Calendar, and also appears in the Contact’s History 
area.
QuickAccess 131



132 Chapter 7



Chapter
 8

Chapter 8

Using Eudora Group Planner
Eudora Group Planner is a workgroup version of Eudora Planner that lets you share 
Calendar and Address Book information, coordinate meetings and office resources 
with co-workers, and view the schedules of other users. This chapter describes 
Eudora Group Planner, including how to

• Log in to a Eudora Group Planner workgroup server and select a server to track 
your available time for group scheduling

• View and create Events and Contacts that are shared among users in your 
workgroup

• Schedule meetings with your co-workers

• Understand your permissions for a workgroup server and protect your shared 
Events and Contacts using Eudora Planner’s security features

Using Eudora Planner in a Workgroup
Before you can begin to share Calendar and Address Book information and 
schedule meetings with other Eudora Planner users, you must first connect to a 
workgroup server. Your Eudora Planner administrator creates the workgroup server 
and determines the level of access granted both to you and to other users. There 
can be one or more workgroup servers available on your network, each containing 
such information as

• User names, passwords, and information about users’ access permissions

• Information necessary for scheduling meetings, such as conference rooms, 
meeting resources, and a running log of other users’ availability

• Public categories for use in sharing Events and Contacts

When you connect to a workgroup server, you can subscribe to categories of Events 
and Contacts that reside on that server. Categories residing on a workgroup server 
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are referred to in Eudora Planner as public categories. You can create new public 
categories on a workgroup server if you have been given permission to do so. Other 
users connected to the same server and granted the proper permissions can view 
and add information to the public categories you create.

The Eudora Group Planner Administrator
In your workgroup, there should be an individual who serves as the Eudora Planner 
administrator. This person should be familiar enough with your organization’s 
structure, computers, and network to effectively install and maintain the Eudora 
Planner servers, as well as to set up each Eudora Planner user, or group of users, 
with access permissions that are appropriate to their role in your organization.

The Eudora Planner administrator can more easily manage the access permissions 
of similar individual users by putting those users into security groups. As a Eudora 
Planner user, you should be aware of any groups to which you are assigned, 
because access permissions assigned to those groups affect your individual 
security profile. See “Knowing Your Security Permissions for a Workgroup Server” 
on page 146 for more information.

The steps involved in setting up a Eudora Group Planner installation are discussed 
in the Eudora Group Planner Administrator’s Guide, which is included with the 
Eudora Group Planner software package. This book also describes the issues 
related to administering a group of Eudora Group Planner users.

See your Eudora Group Planner administrator for information on which workgroup 
servers you can access and the permissions you will have for data on those servers.

Logging in to a Workgroup Server
The first step in sharing Events and Contacts with other Eudora Planner users is to 
log in to a workgroup server.

To log in to a workgroup server, you must know the server’s IP address. You must 
also know your own user name and password (if any) for that server. Contact your 
Eudora Planner administrator if you are unsure how to identify a workgroup server 
or if you don’t know your user information.

To log in to a workgroup server:
1. From the Define menu, select Servers.
134 Chapter 8



The Edit Servers dialog box appears.

2. In the Edit Servers dialog box, click Add Server.

The Internet Server Information dialog box appears.

3. Type the IP address of the server into the Internet (IP) Address field.

4. If necessary, change the value in the Update Interval field. 

5. Click OK.

A status dialog box appears, indicating that Eudora Planner is searching for, 
then connecting to the server. Once the connection is made, a login dialog box 
appears.

6. If necessary, click the button adjacent to the Name field to select your user 
name, then enter your server password. Click OK.

A dialog box appears, asking if you want to make this server your home server.

Server’s Internet address goes here
Determines the frequency with which you receive updates from the 
server

You can select your user name by clicking here

Enter your server password here
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7. Click Yes or No, depending on whether you want this to be your home server.

Eudora Planner logs you into the workgroup server. Depending on the 
permissions granted to you by the server administrator, you can now create 
Events, Contacts, categories and custom fields for this server. If you’ve chosen 
to make this your home server, it now tracks the times you’re available for group 
scheduling.

Selecting a Home Server
To use Eudora Planner for group scheduling, you must select a home server from 
the workgroup servers available on your network. The home server tracks your busy 
time—the time in your schedule already occupied by Events—and displays that 
information to other Eudora Planner users when they invite you to meetings. For 
more information about busy time, see “Showing Your Time as Busy” on page 144.

If there is only one Eudora Planner server on your network, you must designate it as 
your home server. If, however, there are multiple Eudora Planner servers available, 
you might want to consult your Eudora Planner administrator before selecting one 
as a home server.

The first time you log into a workgroup server, you are prompted to set it as the 
home server, which you should do if it is the appropriate server. You can always 
change your home server later.

To change your home server:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears, displaying a list of servers to which you 
are connected.

2. Select the server that you want to be your home server.

3. Click Home Server. 

The selected server appears in bold, indicating that it is your home server. 

4. Click Done.

Receiving Updates from the Server
Eudora Planner lets you specify how often your Macintosh receives updated 
information from a workgroup server. You can also force your database to receive an 
immediate update from a workgroup server at any time.

To set the server update interval:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears, listing all the servers to which you are 
connected.

2. Select the server for which you wish to change the update frequency, then click 
Change.
136 Chapter 8



The Internet Server Information dialog box appears.

3. In the Update Interval box, enter the desired interval, in minutes, between 
updates from the server.

4. Click OK.

Your Eudora Planner database will receive updates from the workgroup server 
at the interval you’ve specified.

To force an immediate update from the server:
1. From the Define menu, select Servers.

The Edit Servers dialog box appears, listing all the servers to which you are 
connected.

2. Select the server from which you want to receive 

3. Click Update Now.

The server immediately updates your Eudora Planner database with any 
changes or additions made by other users since your last update.

Sharing Eudora Planner Information with Others
Whether your workgroup consists of your whole company, one department, or just 
you and your assistant, the ability to distribute accurate scheduling and contact 
information may be vital to the efficiency of your organization. Eudora Group 
Planner lets you and your co-workers keep each other informed about events, 
personal and departmental calendars, and data concerning important customers 
and clients.

This section describes how to view other users’ shared Events and Contacts and 
how to share the items you create. It also explains how to create public categories 
and custom fields.

Viewing and Creating Shared Events and Contacts
To view the Events and Contacts that other users add to a Eudora Planner 
workgroup server, you must create a tab that displays public categories residing on 
that server. Also, if you configure the tab to have one of those public categories as 
its default category, then you can also use the tab to conveniently create your own 
shared Events and Contacts. Any Event or Contact created on such a tab 
automatically acquires that public category as its primary category, and is therefore 
shared with other users connected to the server containing that category.

To add Events and Contacts to a workgroup server, you must have Create 
permission for that server. Consult your Eudora Planner administrator to determine if 
you have this permission for Events and Contacts.

To create a tab on which you can view and create shared Events and Contacts:
1. In either the Calendar or Address Book, select New Tab from the Tabs menu.
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The Tab Info dialog box appears. Although the pictures in this section are 
specific to creating Calendar tabs, you can use this procedure to add public 
categories to an Address Book tab as well (for more details on configuring tabs, 
see “Creating Calendar Tabs” on page 105 and “Creating Address Book Tabs” 
on page 106). 

2. In the Name field, enter a name for the tab.

3. In the Display Events with these Categories area, select the public 
categories that you want to appear on this tab. 

4. Select a default category from the Category for new Events/Contacts pop-up 
menu.

5. If this is a Calendar tab, select Display Events that block my time to have this 
tab show any Events that show as busy time in your schedule, regardless of 
their categories.

6. Click OK.

The tab appears in your Calendar or Address Book view and displays items 

Public categories appear 
under the name of the 
server on which they reside

To select all the categories 
on a server, select that 
server’s check box
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assigned the public categories you selected. 

Any Event or Contact you create on this tab acquires the tab’s default category as its 
primary category. For information on how to change the primary category of an 
Event or Contact, see “Changing the Primary Category” on page 103.

Sharing Existing Events and Contacts
Even if an existing Event or Contact is presently residing on a tab that contains no 
public categories, you can still share it with your workgroup.

To share an existing Event or Contact:
1. Double-click the Event or Contact to open its Details dialog box.

2. Select the Shared check box.

3. Click the Categories button.

The Assign Categories dialog box appears. In this dialog box, public categories 
are listed under the name of the server on which they reside.

4. Select the public categories you want to assign to this Event or Contact. If 
necessary, select a primary category for the item.

5. Click Save.

The Event or Contact is assigned the public category and becomes available to 
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other users subscribing to that category.

Creating Categories for a Workgroup Server
A Eudora Group Planner server comes installed with a number of categories. Your 
Eudora Group Planner administrator and other users might additionally create more 
categories. If you find that none of these categories suit your needs, you can create 
your own public categories to reside on that server. These categories can be used 
by any Eudora Planner users with permissions to create Events and Contacts on 
that server.

To create a category for a workgroup server, you must have Create permission for 
that server. Consult your Eudora Group Planner administrator to determine if you 
have permission to create categories.

To create a category for a workgroup server:
1. From the Define menu, select Categories.

The Edit Categories dialog box appears.

2. Select a server in the Available Categories area.

3. Click the New button.

The Category dialog box appears.

4. Type a name for the category in the Name box.

Public categories are listed 
underneath the server on 
which they reside

Enter a name for the 
category here

The font settings you select 
here become the defaults for 
Events or Contacts that have 
this category as their 
primary category
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5. Select the font settings and background color for the category, if necessary.

6. Click OK.

You are returned to the Edit Categories dialog box. The category appears under 
the workgroup server’s name in the Available Categories area. It also appears 
in the Assign Categories dialog box, which is opened when you click the 
Categories button in the Event or Contact Details dialog box.

In order for public categories to appear in the Assign Categories dialog box, you 
must select the Shared option in the Event or Contact Details dialog box before you 
click the Categories button, as described in the previous section, “Sharing Existing 
Events and Contacts” on page 139.

Creating Custom Fields for a Workgroup Server
You can make a custom field available to other Eudora Planner users by placing it on 
a workgroup server. The custom field appears in any Contacts that have been 
assigned categories that reside on that server.

To create a custom field for a workgroup server:
1. From the Define menu, select Custom Fields.

The Custom Fields dialog box appears.

2. Click the Servers pop-up menu to select the workgroup server on which to 
store this custom field.

In order to create a custom field for a server, you must have Create 
permission for that server. Consult your server administrator to determine 
if you have this permission.

3. Click the New button.

The Custom Field dialog box appears.
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4. Type a name for the custom field in the Name box.

5. Click the Type pop-up menu to select a field type for the custom field. For more 
information about field types, see “Using Custom Fields” on page 69.

6. Click OK to close the Custom Field dialog box, then click OK to close the 
Custom Fields dialog box.

The custom field is saved to the workgroup server and appears in the Custom 
Fields area of any Contact stored on that server.

Using Group Scheduling
Most meetings require coordinating people’s schedules with the availability of 
meeting rooms and office equipment. Eudora Planner’s group scheduling feature 
can track this information for you, making it easy to determine the best time for your 
meeting. Then, when you invite other users to attend, Eudora Planner notifies them, 
allowing them to confirm or decline your invitation.

The first step in group scheduling is to create a Meeting Event. For details, see 
“Using Meeting Events” on page 33. Once you’ve created a Meeting, continue with 
the following section to add group scheduling information to that Event. 

Scheduling Users, Rooms, and Resources for Meetings
Eudora Planner’s group scheduling feature lets you use Meeting Events to 
determine the availability of users and resources, send a network invitation to 
meeting invitees, and reserve a conference room.

To schedule users, rooms, and resources for a Meeting:
1. Double-click the Meeting Event to open the Meeting Details dialog box. Then, 

click the Group Scheduling tab to display the group scheduling options.

You can open a Meeting by control-clicking it in any Calendar view, then 
selecting Details from the contextual menu that appears.

2. Click the Invite button. 

Click to open the Invite dialog box, 
where you can select who to invite

Indicates the time for which the 
Meeting has been scheduled

You can use these 
buttons to change the 
date of the Meeting

Click here to add an 
invitee by using the 
auto-type feature

Invitees will appear in 
this area
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The Invite dialog box appears.

3. To invite a user to the Meeting, do one of the following:

• For a user that is required to attend the Meeting, click that user’s name in 
Invite dialog box, then drag it into the invitees area on the Group Scheduling 
tab. 

• For a user whose attendance is optional, click the user’s name while pressing 
the Option key, then drag it into the invitees area on the Group Scheduling 
tab.

4. Click OK to return to the Group Scheduling tab. 

The invitees appear in the invitation list along with time grids representing their 
schedules. Empty cells in the time grid indicate periods when a user is 
available. A horizontal bar in the grid indicates a user’s busy time. The vertical 
bar spanning all invitees’ time grids shows the time range of the Meeting you’re 
scheduling.

5. Check the invitation list to see if this Meeting conflicts with any of your invitees’ 
scheduled Events. If necessary, you can drag the time range for the Meeting 

You can determine what is listed 
appear in this dialog box by 
clicking these buttons

Select the server that 
contains the users and 
Contacts you want to 
invite;or select the 
“All Servers” option

An icon of this type 
indicates another user 
on the network

This icon indicates the 
name of a Contact in 
your Address Book

Invitees’ names 
appear here, with 
required or optional 
status indicated

Bar indicates user’s blocked time

Vertical bar indicates 
the time for which 
Meeting is scheduled
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(displayed in black) to a time when more people or resources are available. Or, 
to have Eudora Planner find a better time for you, click Find Available to invoke 
the auto-schedule function, which searches for the first free block of time for all 
the people and resources in the invitation list, using the duration selected in the 
Duration list.

6. On the Meeting tab, change the duration of the meeting in the Duration box, if 
necessary.

7. Click Save.

The Meeting is immediately sent to the workgroup server so that the invitees 
receive their Meeting invitations.

Showing Your Time as Busy
When you use Eudora Planner for group scheduling, you can make particular 
Events block time in your schedule, letting other users know when you’re 
unavailable for meetings. Also, when you accept a meeting invitation, Eudora 
Planner automatically blocks the time for which the meeting is scheduled. 

You can have any type of Event show your time as busy. To do this, double-click the 
Event to open its Details dialog box, then click the Show Time as Busy checkbox. 
When another user tries to invite you to a Meeting that runs concurrently with the 
Event, the user will see that you are unavailable.

You can see the Events that occupy your time by creating a tab that shows only your 
busy time. For details, see “Creating Calendar Tabs” on page 105.

Understanding Eudora Planner’s Workgroup Security Features
Eudora Planner’s workgroup security features are designed to operate on three 
levels: that of the server, the user, and a particular Event or Contact. 

The permissions assigned at the server level are referred to in Eudora Planner as 
security permissions. Security permissions are granted to you by your Eudora 
Planner administrator and determine your general level of access to items on a 
workgroup server. The security permissions assigned to groups to which you belong 
also affect your access to a workgroup server. For more information on security 
permissions, see “Knowing Your Security Permissions for a Workgroup Server” on 
page 146.

Permissions assigned at the user level are referred to as privacy permissions. 
Privacy permissions are those permissions you grant to other users for your shared 
Events and Contacts. For information on privacy permissions, see “Setting Privacy 
Permissions” on page 149. 

Permissions assigned at the Event or Contact level are referred to as object 
permissions. Object permissions are those permissions you assign to other users 
for a specific shared Event or Contact that you’ve created. For information on object 
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permissions, see “Setting Object Permissions” on page 151. 

The three types of permissions affect you both as an individual user and as a 
member of a group. The following section explains how.

Users and Groups in Eudora Group Planner
Before you can log in to a particular workgroup server, your Eudora Planner 
administrator must create a user account for you on that server. This user account 
consists of your user name and login password, the groups to which you belong, 
and your security profile—that is, the permissions you have for accessing, altering, 
and creating information and resources on the server. You are prompted to enter 
your user name and password when you first log in to a Eudora Planner workgroup 
server, so you should obtain this information from your administrator before you 
attempt to connect. Once you’ve connected, you can view other information about 
your user account.

In addition to setting up users, your Eudora Planner administrator may also set up 
groups on the server in order to more easily manage users’ permissions. A group 
consists of a number of individual users on a server—usually a cluster of individuals 
who work in the same department or share the same level of managerial 
responsibility. Just as for a user, the Eudora Planner administrator also sets up a 
security profile for a group, granting it specific permissions for the server while 
denying it other permissions. The permissions for a group become part of the 
security profile of a user in that group, and in most cases take precedence over the 
individual user’s profile. For information on how a group membership affects a user’s 
security profile, see “Knowing Your Security Permissions for a Workgroup Server” on 
page 146.

To view the groups you belong to:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

This area lists names of 
users on the selected 
server

Select a server to see its 
user and group 
information
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2. From the Servers pop-up menu, select your home server.

3. In the Users (top) area, select your user name, then click the Edit button.

The Edit User dialog box appears.

4. Select the Groups tab.

The groups to which you belong are listed in the Member of area on this tab.

You cannot add yourself to or remove yourself from any groups on a workgroup 
server, unless the Eudora Planner administrator has granted you Manage Users 
and Groups permission. Consult your Eudora Planner administrator if you want to 
change your group memberships.

Knowing Your Security Permissions for a Workgroup Server
The security permissions granted to you by the Eudora Planner administrator 
determine your level of access to information stored on a workgroup server. These 
permissions govern your ability to do routine tasks, like creating, deleting, and 
modifying Events and Contacts, or more complex operations, like administering 
some aspects of the workgroup server’s user and groups configuration. The Eudora 
Planner administrator can grant or deny you any or all of six different types of 
security permissions.

Permission Type When selected, lets you...

Create/Edit 
Contacts and 
Events

Create and modify Contacts and Events on the server.

Delete 
Contacts and 
Events

Delete Contacts and Events on the server.

User is a member of 
the groups listed here
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Security permissions created on a Eudora Planner server affect only those Events, 
Contacts, and categories residing on that server. If you are connected to multiple 
workgroup servers in your organization, your access permissions may differ for each 
server. 

The Eudora Planner administrator can assign unique sets of security permissions to 
both users and groups, so there may be instances when permissions granted to you 
as a user seem to contradict those permissions denied to a group of which you are a 
member, or vice versa. In such instances, the explicit denial of a permission always 
overrides the granting of that permission elsewhere.

For example, imagine that you are assigned to a group called Sales. Because you 
are the manager of the sales department, you are granted all possible security 
permissions at the individual user level. However, because other users in the Sales 
group are not at your level, they are as a group denied permission to delete Events 
and Contacts from the server. In this case, because you belong to a group for which 
delete permission has been explicitly denied, you do not have delete permission on 
that server, even though you’ve been granted that permission as an individual user.

Conversely, if the Sales group has been granted delete permission, but you as an 
individual user have been denied that permission, then you do not have the ability to 
delete items on that server.

Only the Eudora Planner administrator can change your security permissions for a 

Edit Access 
for Contacts 
and Events

Change information contained in an object stored on the server. For 
example, a user with Edit Access permission can add a note to a public 
Contact or change the title of a public Event. However, Edit Access 
permission does not allow a user to delete an object.

Create/Edit 
Categories 
and Custom 
Fields

Create and modify categories and custom fields on the server. This 
permission does not enable you to delete categories and custom fields.

Delete 
categories 
and custom 
fields

Delete categories and custom fields on the server.

Manage 
Servers

Connect to and disconnect from Eudora Planner workgroup servers.

Manage 
users and 
groups

Add users and groups to the server, as well as alter the attributes of 
existing users and groups, including their server permissions.

Take 
ownership of 
Contacts and 
Events

Gain ownership of another user’s public Contacts and Events, so that 
Eudora Planner recognizes that the items belong to you and not to the 
original owner. When you take ownership of public Contacts and Events, 
you have full permissions for them, as if you had created them.

Permission Type When selected, lets you...
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workgroup server, but you can see which permissions have been granted to you. 
Consult your Eudora Planner administrator about any changes to your permissions.

To see your security permissions:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

2. Click the Server pop-up menu to display the list of servers to which you are 
connected, then select the server for which you want to see your permissions.

3. In the Users (top) area, select your user name, then click the Edit button.

The Edit User dialog box appears.

4. Select the Rights tab.

This tab displays your permissions with regards to creating and modifying 
Contacts, Events, categories, and custom fields on this server. This dialog box 
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also indicates which Administration rights, if any, you have for this server.

5. Click Done to close the Edit User dialog box.

Setting Privacy Permissions
Just as your Eudora Planner administrator determines your permissions for viewing 
or modifying information on a workgroup server, you too can administer other users’ 
permissions for the shared Events and Contacts that you create. By granting or 
denying another user privacy permissions, you can determine the level of access 
that user has for your shared items. For example, you may want to give your 
manager and your assistant the ability to read, modify, and delete your Events and 
Contacts, whereas you give co-workers permission only to read those items.

Even if you’ve given a user particular privacy permissions for the Events and 
Contacts you create, you can deny that user those permissions for particular shared 
items. For information, see “Setting Object Permissions” on page 151.

Although Eudora Planner gives you the flexibility to grant a particular user a specific 
set of permissions for your shared Events and Contacts, you cannot grant any 
permissions that Eudora Planner administrator has explicitly denied to that user for 
the server. So, if the administrator has denied Howard Greene delete permission for 
Events and Contacts on the server, you cannot grant Howard Greene delete 
permission for your own shared Events and Contacts.

You cannot change other users’ permissions for your shared Events and Contacts if 
your Eudora Planner administrator has not granted you Change Privacy permission. 
See “Knowing Your Security Permissions for a Workgroup Server” on page 146 for 
instructions on how to tell whether you have Change Privacy permission.

You can grant other Eudora Planner users five different types of privacy permissions 
Using Eudora Group Planner 149



for shared Events and Contacts you create. 

To set privacy permissions for your Events and Contacts:
1. From the Define menu, select Users and Groups.

The Users and Groups dialog box appears.

2. Click the Servers pop-up menu to display the list of servers to which you are 
connected, then select the workgroup server on which you want to change 
permissions.

3. In the Users (top) area, select your user name, then click the Edit button.

The Edit User dialog box appears.

4. Select the Privacy tab. 

This tab displays the name of every user or group that has permissions for your 
Events and Contacts and the particular permissions granted to each user.

5. Select a user or group for which you want to change permissions, then click the 
Edit button. 

Permission Type When granted, lets other users...

Read View this Event or Contact (the default).

Edit Add or modify information—such as titles, notes, and attachments—
contained in this Event or Contact.

Delete Delete this Event or Contact.

Edit Access Change the permissions for this Event or Contact. For example, if 
you assigned someone else Modify Access permission for this 
Event or Contact, they could in turn change the access permissions 
of this Event or Contact in regard to other users.

Take Ownership Take possession of this Event or Contact, if necessary.
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The Permissions dialog box appears. 

6. Choose the permissions that you want to grant the user or group. Select Yes to 
grant a permission or No to deny it. If you leave the option at Not Set, then the 
user will retain the default permissions set by the server administrator for items 
on that server.

7. Click OK to close the Permissions dialog box. Then, click Done to close the Edit 
User dialog box.

The changes you’ve made are sent to the workgroup server during the next 
update. The user or group now has the permissions you’ve specified and can 
work accordingly with your public Events and Contacts.

These new privacy permissions apply only to Events and Contacts you create after 
changing these settings. Events and Contacts you created before changing these 
settings retain the privacy permissions that were in effect when you created them. 
To change the privacy permissions for existing Events and Contacts, you must do so 
individually as described in the following section.

Setting Object Permissions
You may occasionally create Events and Contacts that you need to restrict to all but 
one or a few users. For such items, Eudora Planner lets you set object 
permissions—a set of user permissions specific to one Event or Contact. The 
permissions you give a user for a particular Event or Contact override the privacy 
permissions you’ve given to that user. For example, you may have granted your co-
worker, Wendy Chin, every available privacy permission for your shared Events and 
Contacts. However, since you don’t want her to know about the surprise birthday 
party the office has planned for her, you deny her read permission for the particular 
Event denoting that occasion. 

To set permissions for an individual Event or Contact:
1. For an Event, in one of the Calendar Views, select the Event for which you want 

to set permissions. For a Contact, in the List View, select the appropriate 
Contact.

2. From the Edit menu, select Security. 
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The Security dialog box appears, listing the names of users and groups that 
have permissions for this item and what particular permissions have been 
granted.

3. To give another user permissions for this Event or Contact, click the Add 
button.

The Permissions dialog box appears.

4. Select a user or group in the list, then set that user’s permissions for the Event 
or Contact by selecting the appropriate buttons. To grant the user a permission, 
select the Yes option for that permission; to deny a permission, select the No 
option. If you leave a setting at Not Set, the user retains the status granted by 
the server administrator.

5. Click OK to close the Permissions dialog box.

You are returned to the Security dialog box, which shows the user’s name and 
the permissions you’ve granted to that user.

6. Click OK.

The changes you’ve made are sent to the workgroup server the next time you 
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receive an update from the server. Once the users affected by the changes 
receive their subsequent server updates, they will obtain the permissions you’ve 
granted, and then can work accordingly with the Event or Contact.
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Glossary

Address Book—How Eudora Planner displays Contact information. The 
Eudora Planner Address Book can be viewed using the List View or Detail 
View.

Auto-Caps—An Address Book feature that automatically capitalizes the first 
letter of any word typed into a Contact Detail field. Auto-Caps functions in 
the Name, Company, City, State, Country, and Salutation fields.

Auto-Complete—An Address Book feature that automatically finishes what 
you are typing into a Contact Detail field. Auto-Complete functions in the 
Name, Company, and City fields.

Auto-Fill—An Address Book feature that automatically adds a work address 
to a Contact’s record after you enter a company name already associated 
with an address elsewhere in your database.

Auto-Pick—A group scheduling feature that searches for a free period of 
time common to a group of meeting invitees, then automatically schedules a 
meeting for that time.

Banner—An Event type that appears in any Calendar view as a floating 
object containing a line of text. Banners can indicate a plan or activity that 
spans a number of days or weeks, such as a 3-day business trip.

busy time—Concerning Eudora Planner’s group scheduling feature, a 
period of time that is occupied by an Event for which you’ve selected the 
Show Time as Busy option or that you’ve designated as unavailable time in 
the Availability preferences. Other Eudora Planner users can see your 
blocked time when they invite you to a meeting.

blocked time—See busy time.

Calendar Event—See Event.

Calendar—How Eudora Planner displays Event information. Calendar 
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information is displayed in four different Calendar views—Month, Week, Day 
and Multi-Day.

Category—A method for classifying Events and Contacts that are related to 
each other. You can create a Category called “Work” and assign Events and 
Contacts that are work-related to that Category. Categories provide a way to 
separate and filter your Event and Contact information (see Tab).

cell—A box that represents a day in the Month and Week views or an 
increment of time in the Day and Multi-Day views.

Contact—A single entry in the Address Book that contains name, company, 
address, phone and other essential information on a person and/or 
company.

Contact heading—The area at the top of the Contact Details dialog box that 
contains the Contact’s primary name and phone number.

Contact Detail—A dialog box that contains information for a particular 
Contact, including name, company name, addresses, phone numbers, 
email addresses, notes, attached documents, and related Events. 

database—The file in which Eudora Planner stores Event and Contact 
information as well as and supporting information such as Categories, Tabs, 
graphics, preferences settings, etc.

complete—A term denoting the status of a To-Do or Call. A To-Do or Call is 
by default marked as Incomplete, but is marked as Complete when the task 
it represents has been completed.

duration—The difference between an Event’s start and stop times, or simply, 
how long the Event lasts.

Event—An entry in your Calendar that represents a Meeting, Call, To-Do, 
Holiday, Special Event, Banner, or Sticky Note. The word Event is used in 
general to refer to any activity you schedule in your Calendar.

Event Detail—A dialog box containing controls for changing Event 
attributes, including the title, description, attached Contact data or 
documents, start time, stop time, Category, Priority, and duration. You can 
also use this dialog box to specify whether or not an Event will have a 
Reminder alert attached to it. There is a specific Detail dialog box for each 
type of Event.

export—A function that copies Event or Contact data and saves it to an 
external file for use in another program.

filter—See To-Do and Call Filter.

footer—User-definable text that appears at the bottom of printed output; you 
can create a custom footer by clicking Header/Footer in the Print dialog box.

graphic—A bitmap (BMP file) that is assigned to an Event or used as a 
background in a Calendar View. Graphics can give special significance to 
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individual Events or add visual appeal to your Calendar.

header—User-definable text that appears at the top of printed output; you 
can create a custom header or footer by clicking “Header/Footer...” in the 
Print dialog box.

heading—1) The top section of the current Calendar View; for example, in 
the Month View, the area that shows the month and year is the heading. 2) 
In the Address Book’s List View, the area at the top of each column, 
indicating what data the column displays, that you can click to sort each 
column and drag to arrange the columns’ order.

hidden—Describes an Event that you have made invisible by choosing the 
Hide command from the Event’s right-click menu.

Holiday—An Event type that spans an entire day, rather than being attached 
to a specific time on that day.

import—A function that translates Calendar or Address Book information 
saved in a text file into Event or Contact information that is copied into your 
Eudora Planner database.

Link fields—In the Contact Details dialog box, the five changeable fields that 
contain phone numbers, email addresses, and Web site addresses. You can 
click on the icon next to a Link field to create a Call Event for a Contact, send 
an email message, or launch your Internet browser to open a Web page.

Messaging Application Programming Interface (MAPI)—The standard 
interface that allows email clients to pass information to an email messaging 
service. An email package must be MAPI-compliant in order to work with 
Eudora Planner’s email features.

merge document—A document (either a letter or fax) that is intended to be 
sent to more than one Contact. A merge document usually contains merge 
fields, which allow the document to contain personalized information for 
each recipient. See merge field.

merge field—A placeholder that you can insert in a text document that is 
replaced by actual Contact data when the document is printed or faxed.

overdue —A term referring to a dated To-Do or Call that has not been 
completed by its due date. You can view overdue To-Dos and Calls in the To-
Do List by selecting the Overdue option in the To-Do and Call Filter.

personal Contact—A Contact that appears only in your Address Book. 
Personal Contacts are assigned only private Categories, and therefore 
cannot be view by other users over the network (compare with workgroup 
Contact).

personal Event—An Event that appears in your Calendar only. Personal 
Events are assigned only Private Categories, and therefore cannot be 
viewed by other users over the network (compare with workgroup Event).
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plugin—A small, specialized application designed to enhance and work 
within the framework of a larger application. You can access Eudora Planner 
plugins from the shortcuts pane.

preferences—A set of user-definable criteria allowing you to specify how 
certain functions of Eudora Planner will work and determine the appearance 
of the Address Book and Calendar.

priority—A level of importance that you can assign to a To-Do or Call. 
Eudora Planner allows you to define up to ten priorities and assign them 
freely to individual Events.

private Category—A Category that is stored in your personal, local 
database and is not shared over the network or visible to other users 
(compare with public Category).

proxy—a user who is selected by another user to act on his or her behalf in 
scheduling meetings and accepting or declining invitations to meetings.

public Category—A shared Category that is stored on a workgroup server, 
and that contains public Events or Contacts. Public Categories, and the 
public Events they contain, are available to all users on the network 
(compare with private Category).

QuickAccess—A suite of three small, background applications that allow 
you to view and add to your Calendar and Address Book information without 
having to open Eudora Planner. See QuickContact, QuickDay, and 
QuickPad.

QuickContact—A small, background application that gives you access to 
information in your Address Book without having to open Eudora Planner. 
QuickContact lets you view all your Contacts or search for specific ones, dial 
and send email messages, and create new Contacts and Events. You can 
open QuickContact from the Windows taskbar.

QuickDay—A small, background application that gives you access to 
information in your Calendar without having to open Eudora Planner. 
QuickDay lets you view any day’s activities and create new Events and 
Contacts. You can open QuickDay from the Windows taskbar.

QuickNet—A Eudora Planner feature that uses the search capabilities of the 
World Wide Web to find information about a Contact, such as Zip+4, email 
addresses, white pages listing, and a street map to the Contact’s address.

QuickPad—A pop-up menu located on the Windows taskbar that allows you 
to create new Events and Contacts without having to open Eudora Planner.

reminder—An alert of an upcoming Event in the form of an Alert Dialog, a 
flashing Event title in the menu bar, or a sound. You can set a Reminder for 
any Event in your Calendar, including Public Events.

repeating Event—One of a series of Events that you have configured to 
repeat at a specified interval and for a specified number of occurrences.
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server—See workgroup server.

shortcut—In Eudora Planner, a program icon that points to another 
application or document or to a Web site. When you double-click the icon, 
the application or document is opened or, in the case of a Web site, your 
browser is launched and opens the appropriate site.

shortcuts pane—An area in the Eudora Planner window that contains 
shortcuts to other applications and documents, as well as plugins. The 
shortcuts pane can be moved or hidden from view.

sort—A function available in the Address Book List View allowing you to 
define the order in which Contacts are listed.

Special Event—An Event type that spans an entire day, rather than being 
attached to a specific time on that day.

Sticky Note—An Event type that appears as a movable object in the Month 
View. Sticky Notes can be used to display short lists or important notices.

style—1) A set of criteria for defining the appearance of your Calendar and 
Address Book views. You can create multiple styles and assign them to 
different Tabs, so that each Tab has a distinctive appearance. 2) Font and 
color settings applied to specific Categories, to give the Events and 
Contacts belonging to those Categories a distinctive appearance.

Tab—A method for organizing and displaying Calendar and Address Book 
Categories that are related to each other or contain similar information.

Telephony Application Programming Interface (TAPI)—A standard interface 
that allows an application to send commands to telephone hardware. Your 
modem or dialing device must be TAPI-compliant in order for you to use 
Eudora Planner’s dialing feature.

template—1) For printing in Eudora Planner, a predefined set of formatting 
specifications that determines the appearance of printed output. A print 
template specifies the page size, margins, text formatting and other aspects 
of your output. 2) A predefined set of Contact or Event information that you 
can use to create multiple Events or Contacts that use similar information. 
Event and Contact templates are defined and used from the Insert menu.

To-Do—An Event type that represents a task to be completed. A To-Do can 
optionally have Start and Due dates, but is undated by default. An undated 
To-Do is carried forward to subsequent days until marked as completed. A 
dated To-Do also is carried forward until marked completed, but is visible 
only on the range of days from its Start and Due dates.

To-Do and Call Filter—A Calendar feature that lets you determine which To-
Dos and Calls appear in the To-Do List. You can filter To-Dos and Calls 
based on a variety of criteria, including due date, completion status, and 
overdue status. To use this feature, right-click in the area above the To-Do 
List or in any empty cell in the To-Do List.
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To-Do List—An area of the Calendar in which you can view, track, and 
create To-Dos and Calls. You can use the To-List to sort To-Dos and Calls 
by title, Category, priority, due date, and completion date.

view—A graphic environment provided by Eudora Planner within which you 
can view, modify, and create Events and Contacts. For example, the Month 
View is one of the available Calendar Views. The List View is one of two 
available Address Book Views.

workgroup Contact—A Contact that has been assigned a public Category, 
and thereby made available to other users on the network (compare with 
personal Contact).

workgroup Event—An Event that has been assigned a public Category, and 
thereby made available for viewing to all users on the network (compare 
with personal Event).

workgroup server—A program that runs on a network file server, which 
stores and maintains public Categories, allowing users to share Event and 
Contact information.

Web Publisher—A Eudora Planner plugin that lets you export Event and 
Contact information to HTML, enabling you to automatically publish Web 
pages based on the contents and look of your Calendar and Address Book.
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	2. Click the Attach New Note button in the button bar.
	3. In the Title box, type a title for the note.
	4. Type your comments into the note.
	5. Click Save.
	Deleting Items from the Contact History

	To delete an Event or note from a Contact’s History:
	1. Double-click the Contact to open its Details dialog box.
	2. Open the History section.
	3. Select the item you want to delete, then press the Delete key.


	Attaching Files to a Contact
	To attach a file or file alias to a Contact:
	1. Double-click the Contact to which you want to attach the document.
	2. From the Tools menu, select Attach. Then, from the submenu that appears, select either File or...
	3. Click OK.


	Attaching Another Contact to a Contact
	To attach a another Contact to a Contact:
	1. Double-click the Contact to which you want to attach another Contact.
	2. Click the Attach Contacts button in the button bar.
	3. From the pop-up menu, select Found Contacts, All Contacts, or Quick Contacts.
	4. If you selected either the All Contacts or Quick Contacts options, go to step 5. If you select...
	5. In the Matching Contacts area, select the check boxes of any Contacts that you want to attach,...
	6. Click Save.


	Deleting Items from the Attachments Area
	To delete an item from the Attachments area:
	1. Double-click the Contact containing the attached document, document alias, or Contact you want...
	2. Click the triangle to open the Attachments area, if necessary.
	3. Select the item you want to delete, then press the Delete key.


	Selecting Primary Fields
	To select primary listing and address fields:
	1. Double-click the Contact for which you want to select primary fields.
	2. Click the title of the Listing field you want to select (either Name or Company).
	3. In the Address area, select either Work or Home, depending on which address field you intend t...
	4. Click Street.
	5. Click Save.

	To select a primary connection field:
	1. Double-click the Contact for which you want to select the primary connection field.
	2. Click the pop-up menu next to the uppermost connection field.
	3. From the pop-up menu, select the connection field you want to designate as primary.
	4. Click Save.


	Assigning Categories to Contacts

	Using Contact Templates
	Creating a Contact Template
	To create a Contact template:
	1. From the Insert menu, select Contact from Template, then select Edit Templates from the submen...
	2. Click New.
	3. Enter a name for the template, then click OK.
	4. Enter information into the template, just as you would into a Contact. You can also add notes ...
	5. Click Save.


	Creating a Contact from a Template
	To create a Contact based on a template:
	1. From the Insert menu, select Contact from Template, then select a template name from the subme...
	2. Add new information to the Contact or modify the information from the template, if necessary.
	3. Click Save.



	Finding Contacts
	Using the Find Feature
	To use the Find feature to find a Contact:
	1. From the Edit menu, select Find.
	2. In the Find box, enter a keyword to search for.
	3. Click Find.
	4. Eudora Planner advances to the first Contact in the foremost tab that contains the keyword, th...
	5. To find another Contact containing the keyword, from the Edit menu, select Find Next.


	Using the Find All Feature
	To use the Find All feature to find Contacts:
	1. From the Edit menu, select Find All.
	2. In the Find box, enter a keyword to search for.
	3. Select a Search option.
	4. Click the triangle at the bottom left corner of the dialog box.
	5. In the Fields to Search area, select the fields to be included in the search.
	6. Select one of the following Comparison options:
	7. Click Find.


	Finding Contacts by Category
	To find Contacts by category:
	1. From the Edit menu, select Quick Find.
	2. In the Categories list, select the check box next to each category that you want to find.
	3. Click Find.
	Saving Your Find Results

	To save the Find Results tab as a new tab:
	1. Click the icon next to the tab’s name.
	2. Enter a name for the tab in the Name box.
	3. Click New Category to use the Category dialog box to create a new category (for details about ...
	4. Select the check boxes of the categories you want to assign to the Contacts in this tab.
	5. Click the Assign category to any new Contacts created in this tab pop-up menu to select the de...
	6. Click the Tab Color pop-up menu to select a background color for this tab.
	7. Click OK.


	Finding, Viewing, and Deleting Duplicate Contacts
	To find, view, and delete duplicate Contacts:
	1. From the Define menu, select Show Duplicates.
	2. Select a Search option.
	3. In the Fields to Match area, select the fields to be searched for duplicate information.
	4. Click Find.
	5. To delete a duplicate Contact, select it, then press the Delete key.



	Dialing Contacts
	Setting the Dialing Preferences
	To set up the dialing preferences:
	1. From the Define menu, select Preferences.
	2. Click the Address button to display the Address Book preferences, then select the Dialing tab ...
	3. From the Dial via pop-up menu, select a dialing method.
	4. In the Local area code box, enter your area code. Select the Omit local area code option to ha...
	5. Select the appropriate options from the Dial Tone, Prefix, and Suffix pop-up menus.
	6. In the When dialing field, enter the word or abbreviation you use to indicate a phone extensio...
	7. Click OK.
	Configuring Modem Dialing
	Configuring Speaker Dialing


	Dialing a Contact
	To dial a Contact by modem:
	1. In the Contact Details dialog box or in the Address Book List View, click the phone icon next ...
	2. Click the Dial Phone button.
	3. When the other party answers, pick up your phone’s handset.
	4. If necessary, you can change the title of the Call in the Title field, and type notes in the D...
	5. Click Save to close the Call.

	To dial a Contact by speaker:
	1. In the Contact Details dialog box or in the Address Book List View, click the phone icon next ...
	2. Pick up the phone’s handset and hold phone as close as possible to your Macintosh’s speaker.
	3. Click the Dial Phone button.
	4. If necessary, you can change the title of the Call in the Title field, and type notes in the D...
	5. Click Save to close the Call.



	Using the Internet Features
	Selecting Your Preferred E-mailer and Browser
	To choose your preferred e-mail and browser applications:
	1. From the Define menu, select Preferences.
	2. Click General to display Eudora Planner’s general preferences.
	3. In the Internet Setup area, click the Mailer pop-up menu, then select an e-mail application fr...
	4. To have a note automatically logged into a Contact’s History each time you send an e-mail, sel...
	5. Click OK.

	Sending E-mail to Contacts
	To send an e-mail message to a Contact:
	1. Double-click the Contact to whom you want to send the e-mail message.
	2. Locate the appropriate e-mail address in either a connection field or custom field, then click...
	3. Type the body of your message, then send it as you would any other message.


	Opening Web Sites from within Contacts
	To open a Web site from within a Contact:
	1. Double-click the Contact for which you want to view the attached Web site.
	2. Locate the Web site address in either a connection field or a custom field, then click the glo...


	Using QuickNet
	To use QuickNet:
	1. Select a Contact in the Address Book List View.
	2. From the Tools menu, select QuickNet. Then, from the resulting submenu, choose one of the foll...
	3. If necessary, enter the found information into the Contact record.


	Setting Preferences for Internet Config
	1. From the Define menu, select Preferences to open the Preferences dialog box. Then, select Gene...
	2. To use Internet Config to point to a Web browser or e-mail program, click either the Browser o...
	3. Click Open Internet Config to open the Internet Preferences dialog box. Then, click Helpers.
	4. To choose your preferred Web browser, select the http option. To choose your preferred e-mail ...
	5. Click Choose Helper. In the resulting Open dialog box, navigate to find the browser or e-maile...
	6. Click OK to close the Add Helper dialog box. Then, click Add to close the Helpers dialog box.
	7. From the File menu, select Quit.

	Using Mail Merge
	Creating a Merge Template
	To create a Word 6 merge template for use with Eudora Planner:
	1. In Word, create or open the document you want to use as a merge template. If you’re creating a...
	2. Select Mail Merge from Word’s Tools menu and, in the Mail Merge Helper dialog box that appears...
	3. Click the Active Window button to specify that the open document will be used to make your tem...
	4. Click the Get Data button on the Mail Merge Helper dialog box, then select Open Data Source fr...
	5. In the directory dialog box, select All Files from the List Files of Type drop- down menu. Nav...
	6. Click the Edit button under Main Document in the Mail Merge Helper dialog box.
	7. Insert merge fields into the template by placing the cursor where you want a field to be, clic...

	To create a Word 5.x merge template for use with Eudora Planner:
	1. Create or open the Word document you want to use as a mail merge template. If you’re creating ...
	2. From Word’s View menu, select Print Merge Helper.
	3. In the directory dialog box, navigate to Eudora Planner Folder:EP Support:QuickMerge Templates...
	4. Delete the data field that Word added to the top of the document.
	5. Insert merge fields into your document by placing the cursor where you want a field to be, cli...

	To create a WordPerfect 3.5.x merge template for use with Eudora Planner:
	1. Create or open the WordPerfect document you want to use as a mail merge template. If you’re cr...
	2. Click the Merge button at the top of the document window to display the Merge bar.
	3. Click the Field button on the Merge bar.
	4. Select the Field Name option, then click Get Field Names.
	5. Navigate to Eudora Planner Folder:EP Support:QuickMerge Templates:WordPerfect. Select and open...
	6. Click OK.
	7. Insert merge fields in your document by placing the cursor where you want a field to be, click...
	Merging Contact Data with a Merge Template

	To merge Contact data with a merge template:
	1. In the List View, select the Contacts you want to merge with the merge template. If you intend...
	2. From the Tools menu, select Mail Merge.
	3. From the Merge Using pop-up menu, select the type of word processor your are using.
	4. Select the merge template you want to use for the merge, then click Open.
	5. Click Save to save the data source document. This document contains the Contact data to be mer...
	6. From Word’s View menu, select Print Merge Helper.
	7. Select the data source document you saved in step 5, then click Open.
	8. Click the Merge into New Document icon on the Print Merge toolbar.



	Editing Contacts in the List View
	Duplicating Contacts
	Deleting Contacts
	Sorting Contacts in the List View
	To sort Contacts:
	1. Click any column heading to select a column.
	2. To sort in ascending order, click the sort icon.
	3. To define additional sort columns, hold down the Shift key and click the column headings.



	Setting Preferences for the Address Book
	Data Entry Preferences
	Copy Contact Preferences
	Dialing Preferences
	Miscellaneous Preferences
	Chapter 4
	Organizing Eudora Planner

	About Categories and Tabs
	Using Categories
	Creating Categories
	To create a category:
	1. From the Define menu, select Categories.
	2. Click the Server arrow to select the server to which you want to add the category.
	3. Click New.
	4. In the Name box, type a name for the category.
	5. To give the category a distinctive appearance, click the Font field to select a font. Specify ...
	6. Click OK.


	Assigning Categories to Events and Contacts
	To assign categories to Events and Contacts:
	1. Double-click the Event or Contact.
	2. Click Categories.
	3. In the Available Categories list, click the categories you want to assign.
	4. Click OK.

	To remove a category from an Event or Contact:
	1. Double-click the Event or Contact.
	2. Click Categories.
	3. In the Available Categories list, click the categories you want to remove.
	4. Click OK.

	To assign or remove a category to or from multiple Contacts:
	1. In the List View, select the Contacts to which you want to assign the category.
	2. From the Edit menu, select Change Categories.
	3. To add a category, select its check box. To remove a category, clear its check box.
	4. Click OK.


	Changing the Primary Category
	To change a primary category:
	1. Double-click the Event or Contact.
	2. Click Categories.
	3. Scroll through Primary Category list until you find the category you want to use.
	4. Click OK.


	Editing and Deleting Categories
	To edit categories:
	1. From the Define menu, select Categories.
	2. Click a category in the list, then click Edit.
	3. Click OK.

	To delete categories:
	1. From the Define menu, select Categories.
	2. Click a category in the list, then click Delete.
	3. Click Yes to delete the category.



	Using Tabs
	Creating Tabs
	Creating Calendar Tabs
	To create a Calendar tab:
	1. Display the Calendar. Then, from the Tabs menu, select New Tab.
	2. In the Name box, type a name for the tab.
	3. Click the Style field to select a style or, if desired, create and assign a new style.
	4. In the Display events with these categories list, select the Event categories you want to appe...
	5. Select an Event category from the Category for new events list.
	6. Click OK.

	To create a Calendar tab that shows only your busy time:
	1. In the Calendar, from the Tabs menu, select New Tab.
	2. In the Name box, type a name for the tab.
	3. From the Style Name list, select a style, or create and assign a new style, if desired.
	4. Check the Display events that block time box.
	5. Click OK.
	Creating Address Book Tabs

	To create an Address Book tab:
	1. In the Address Book, from the Tabs Menu, select Add New Tab.
	2. In the Name box, type a name for the tab.
	3. In the Display contacts with these categories list, select the categories you want to appear o...
	4. In the Category for new contacts list, select a category.
	5. From the Style Name list, select a style, or create and assign a new style, if desired.
	6. Click OK.


	Creating Calendar Tab Styles
	To define a new Calendar tab style:
	1. In the Calendar, from the Define Menu, select Tab Styles.
	2. Click New. Then, in the New Style dialog box, type a name for the new style and click OK.
	3. Click a button to display the style options for a particular Calendar view.
	4. Select the element of the view for which you want to set preferences.
	5. Repeat steps 3 and 4 until you have specified all styles.
	6. Click Close.


	Assigning Tab Styles
	To assign styles to tabs:
	1. Click the label of the Calendar tab to bring it to the front.
	2. From the Tabs menu, select Edit Tab.
	3. From the Style Names list, select a new style.
	4. Click OK.
	Chapter 5
	Printing in Eudora Planner



	Selecting Print Settings
	Printing from the Eudora Planner Calendar
	To print a Calendar:
	1. From the File menu, select Print to open the Print dialog box. Then, click either the Day, Wee...
	2. Click the Style pop-up menu to select the format of the printout; your selection appears in th...
	3. Select the Content tab to do the following:
	4. On the Style Options tab, select options to change text styles, if necessary.
	5. Select the Paper Options tab to do the following:
	6. Select the Miscellaneous tab to add a header and footer to the calendar pages.
	7. Click Print.

	Printing from the Address Book
	Printing for an Organizer
	To print a paper address book:
	1. From the File menu, select Print.
	2. Click the Style pop-up menu to select an address book format.
	3. Click the Paper pop-up menu to select the type of paper to which you want to print.
	4. Select the desired options in the Content, Style Options, Paper Options, and Miscellaneous tabs.
	5. If you want to save these settings as a template for future printouts, click Save Template As ...
	6. Click Print.
	Printing Envelopes

	To print an envelope:
	1. From the File menu, select Print to open the Print dialog box. Then, click the Envelope button.
	2. Click the Style pop-up menu to select an envelope format. The selection you make here determin...
	3. Click the Paper pop-up menu to select the type of envelope to which you want to print.
	4. Select the Content tab, then choose one of the following options to determine the range of Con...
	5. Select the Style Options tab, then select settings to determine the font characteristics of th...
	6. If you want to save these settings as a template for future printouts, click Save Template As ...
	7. Click Print.
	Printing Mailing Labels

	To print mailing labels:
	1. From the File menu, select Print to open the Print dialog box. Then, click the Labels button.
	2. Click the Style pop-up menu to select a label format. This setting determines how the Contact ...
	3. Click the Paper pop-up menu to select the type of labels to print.
	4. Select the Content tab. Then, in the Contacts to Print area, select one of the following to de...
	5. In the Copies of each label box, enter the number of label copies you want to print. Then, in ...
	6. Select the Style Options tab, then select settings to determine the font characteristics of in...
	7. If you want to save the settings you’ve made for future printouts, click Save Template As to c...



	Previewing Your Printouts
	To see a preview of a printout:
	1. In the Print dialog box, select Preview.
	2. If the printout has multiple pages, you can advance or backtrack through the pages by clicking...
	3. To print the information displayed, select Print. To cancel the print operation, click Cancel.


	Using Print Templates
	Creating Print Templates
	To save a print template:
	1. Once you’ve specified your desired print options in the Print dialog box, click Save Template As.
	2. Type a name for the template.
	3. Click Save.


	Printing from a Print Template
	To print from a template:
	1. From the File menu, choose Print.
	2. Click the Template pop-up menu to select a print template.
	3. Click Print.



	Printing What Appears on the Screen
	Chapter 6
	Importing and Exporting

	Importing from Now Up-to-Date and Contact
	To import from Up-to-Date and Contact:
	1. From the File menu, select Import. Then, from the resulting submenu, select either Now Up-to-D...
	2. Navigate to find the Now Up-to-Date or Now Contact database you want to import, then select it.
	3. Click Open.

	To import public data from Public Event and Public Contact Server databases:
	1. From the File menu, select Import. Then, from the resulting submenu, select either Public Even...
	2. Navigate to find the Up-to-Date or Contact server database that you want to import, then selec...
	3. Click Open.


	Importing Events and Contacts from Text Files
	To import Events or Contacts from text files:
	1. From the File menu, select Import. Then, from the resulting submenu, select either Events from...
	2. In the File Preview area, select the check boxes for those fields in the text file that you wa...
	3. To map the fields in the text file to the appropriate fields in Eudora Planner, drag the field...
	4. In both the Record and Field areas, click the Separator pop-up menu to select the types of del...
	5. Select the Skip first record and Imported field values are quoted check boxes as desired.
	6. Click Import.


	Exporting from Eudora Planner
	To export your Events and Contacts as text:
	1. From the File menu, select Export. Then, from the resulting submenu, select Events as Text to ...
	2. Click the Export pop-up menu and select one of the following options:
	3. To choose a field for export, select it in the Available Fields area, then click Add to move i...
	4. To determine how the text file is delimited (that is, how fields and records are separated fro...
	5. Select the Export field titles as first record and Quote Fields check boxes as desired.
	6. Click Export.
	7. Enter a name for the text file, select its location, then click Save.
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	Using the QuickMenus
	The QuickDay Menu
	The QuickContact Menu

	Using QuickDay
	Viewing Events with QuickDay
	To view Events with QuickDay:
	1. Click the QuickDay calendar icon located in the menu bar, then select Open QuickDay from the r...
	2. To see details for an Event, double-click it in the window.
	3. Once you’ve viewed the Event’s details, click Done or Cancel to return to the QuickDay dialog ...
	4. Use QuickDay’s right and left arrow buttons to move backward or forward through your Calendar ...
	5. Click the Pick a date to view button to see Events scheduled for a particular date.
	6. To close the QuickDay window, click Done.


	Creating Events with QuickDay
	To create an Event with QuickDay:
	1. Click the QuickDay menu bar icon, then select Open QuickDay.
	2. Use the navigation buttons to select the date on which you want to schedule the Event, if nece...
	3. On the button bar at the top of the QuickDay window, click the button for the type of Event th...
	4. Enter details for this Event. For information on creating Events, see “Adding Events to the Ca...
	5. Click Save to close the Event Details dialog box.


	Modifying an Existing Event with QuickDay
	To modify an existing Event with QuickDay:
	1. In the QuickDay window, double-click the Event you want to modify.
	2. Make any necessary changes to the Event. For example, you may want to change the starting time...
	3. Click OK.


	Creating Contacts with QuickDay
	To create a Contact in QuickDay:
	1. In the QuickDay window, click the New Contact button.
	2. In the Contact Details dialog box, enter any information appropriate for the Contact.
	3. Click OK.


	Setting Preferences for QuickDay
	To set preferences for QuickDay:
	1. In Eudora Planner, from the Define menu, select Preferences.
	2. Click the Calendar button to display the Calendar preferences. Then, click the QuickDay tab.
	3. In the Display Events with these Categories area, select the Event categories that you want to...
	4. To set the default category for Events that you create in QuickDay, click the Assign Category ...
	5. If you are using Eudora Planner for group scheduling, select the Display Events that block my ...
	6. To determine which types of To-Dos and Calls appear in QuickDay, do the following:
	7. Click OK.


	QuickDay is configured to display the Categories and Event types that you’ve selected.

	Using QuickContact
	Setting a Contact as a Quick Contact
	To designate a Contact as a Quick Contact:
	1. In the Address Book or QuickContact window, double-click the Contact you want to set as a Quic...
	2. Select the Quick Contact check box.
	3. Click Save to close the Contact.


	Finding Contacts in QuickContact
	To find Contacts in QuickContact:
	1. From the QuickContact menu, select Open QuickContact.
	2. From the Show pop-up menu, select Found Contacts.
	3. In the Find field, enter the name you want to search on. You can also enter just a letter.
	4. Choose a search method:
	5. Click Find.


	Creating Contacts with QuickContact
	To create a Contact with QuickContact:
	1. Click the Create a new contact button in the QuickContact window.
	2. In the Contact Details dialog box, enter any information appropriate for the Contact.
	3. Click OK.


	Dialing Contacts in QuickContact
	To dial a Contact from QuickContact:
	1. In the QuickContact window, select the Contact you want to call.
	2. Click the Dial button in QuickContact’s button bar.
	3. Click Dial Phone.
	4. Pick up your phone’s receiver, then click Talk to wait for the party you’ve dialed to answer.


	E-mailing Contacts in QuickContact
	To email a Contact from QuickContact:
	1. In the QuickContact window, select the Contact you want to email.
	2. Click the Send e-mail to selected Contacts button.


	Creating Events with QuickContact
	To create an Event with QuickContact:
	1. In the button bar at the top of the QuickContact window, click the button for the Event type y...
	2. Add the appropriate information to this Event.
	3. Click OK.

	To create an Event that attaches automatically to a Contact:
	1. In the QuickContact window, select the Contact to which you want to attach the Event.
	2. In the QuickContact button bar, click the button for the type of Event you want to attach.
	3. An Event Details dialog box for the type of Event you’ve selected appears.
	4. Enter the appropriate information for the Event. For details on how to create Events, see “Add...
	5. Once you’ve entered the information, click OK.
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	Using Eudora Planner in a Workgroup
	The Eudora Group Planner Administrator

	Logging in to a Workgroup Server
	To log in to a workgroup server:
	1. From the Define menu, select Servers.
	2. In the Edit Servers dialog box, click Add Server.
	3. Type the IP address of the server into the Internet (IP) Address field.
	4. If necessary, change the value in the Update Interval field.
	5. Click OK.
	6. If necessary, click the button adjacent to the Name field to select your user name, then enter...
	7. Click Yes or No, depending on whether you want this to be your home server.

	Selecting a Home Server
	To change your home server:
	1. From the Define menu, select Servers.
	2. Select the server that you want to be your home server.
	3. Click Home Server.
	4. Click Done.


	Receiving Updates from the Server
	To set the server update interval:
	1. From the Define menu, select Servers.
	2. Select the server for which you wish to change the update frequency, then click Change.
	3. In the Update Interval box, enter the desired interval, in minutes, between updates from the s...
	4. Click OK.

	To force an immediate update from the server:
	1. From the Define menu, select Servers.
	2. Select the server from which you want to receive
	3. Click Update Now.



	Sharing Eudora Planner Information with Others
	Viewing and Creating Shared Events and Contacts
	To create a tab on which you can view and create shared Events and Contacts:
	1. In either the Calendar or Address Book, select New Tab from the Tabs menu.
	2. In the Name field, enter a name for the tab.
	3. In the Display Events with these Categories area, select the public categories that you want t...
	4. Select a default category from the Category for new Events/Contacts pop-up menu.
	5. If this is a Calendar tab, select Display Events that block my time to have this tab show any ...
	6. Click OK.
	Sharing Existing Events and Contacts

	To share an existing Event or Contact:
	1. Double-click the Event or Contact to open its Details dialog box.
	2. Select the Shared check box.
	3. Click the Categories button.
	4. Select the public categories you want to assign to this Event or Contact. If necessary, select...
	5. Click Save.


	Creating Categories for a Workgroup Server
	To create a category for a workgroup server:
	1. From the Define menu, select Categories.
	2. Select a server in the Available Categories area.
	3. Click the New button.
	4. Type a name for the category in the Name box.
	5. Select the font settings and background color for the category, if necessary.
	6. Click OK.


	Creating Custom Fields for a Workgroup Server
	To create a custom field for a workgroup server:
	1. From the Define menu, select Custom Fields.
	2. Click the Servers pop-up menu to select the workgroup server on which to store this custom field.
	3. Click the New button.
	4. Type a name for the custom field in the Name box.
	5. Click the Type pop-up menu to select a field type for the custom field. For more information a...
	6. Click OK to close the Custom Field dialog box, then click OK to close the Custom Fields dialog...



	Using Group Scheduling
	Scheduling Users, Rooms, and Resources for Meetings
	To schedule users, rooms, and resources for a Meeting:
	1. Double-click the Meeting Event to open the Meeting Details dialog box. Then, click the Group S...
	2. Click the Invite button.
	3. To invite a user to the Meeting, do one of the following:
	4. Click OK to return to the Group Scheduling tab.
	5. Check the invitation list to see if this Meeting conflicts with any of your invitees’ schedule...
	6. On the Meeting tab, change the duration of the meeting in the Duration box, if necessary.
	7. Click Save.


	Showing Your Time as Busy

	Understanding Eudora Planner’s Workgroup Security Features
	Users and Groups in Eudora Group Planner
	To view the groups you belong to:
	1. From the Define menu, select Users and Groups.
	2. From the Servers pop-up menu, select your home server.
	3. In the Users (top) area, select your user name, then click the Edit button.
	4. Select the Groups tab.


	Knowing Your Security Permissions for a Workgroup Server
	To see your security permissions:
	1. From the Define menu, select Users and Groups.
	2. Click the Server pop-up menu to display the list of servers to which you are connected, then s...
	3. In the Users (top) area, select your user name, then click the Edit button.
	4. Select the Rights tab.
	5. Click Done to close the Edit User dialog box.


	Setting Privacy Permissions
	To set privacy permissions for your Events and Contacts:
	1. From the Define menu, select Users and Groups.
	2. Click the Servers pop-up menu to display the list of servers to which you are connected, then ...
	3. In the Users (top) area, select your user name, then click the Edit button.
	4. Select the Privacy tab.
	5. Select a user or group for which you want to change permissions, then click the Edit button.
	6. Choose the permissions that you want to grant the user or group. Select Yes to grant a permiss...
	7. Click OK to close the Permissions dialog box. Then, click Done to close the Edit User dialog box.


	Setting Object Permissions
	To set permissions for an individual Event or Contact:
	1. For an Event, in one of the Calendar Views, select the Event for which you want to set permiss...
	2. From the Edit menu, select Security.
	3. To give another user permissions for this Event or Contact, click the Add button.
	4. Select a user or group in the list, then set that user’s permissions for the Event or Contact ...
	5. Click OK to close the Permissions dialog box.
	6. Click OK.
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